
 
 

 
 
 
 
 

 
USER’S MANUAL 

 

 

 

 

 

 

 

 

 

Copyright (c) 2013-2023 Jens Wallauer 

Exclusively distributed by 

 

 rhd instruments GmbH & Co. KG, Otto-Hesse-Straße 19 / T3, 64293 Darmstadt 

 Tel.: +49 6151 8707187, E-Mail: info@rhd-instruments.de  



 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Revision 1.28, 21.06.2023 

updated for RelaxIS 3.0.21 

Visit http://www.rhd-instruments.com 

for most up-to-date documents!  

http://www.rhd-instruments.com/


 
 

PREFACE 

Thank you for using RelaxIS! 

RelaxIS is a rich software suite that combines many tools used for the 

evaluation of spectra measured in Impedance Spectroscopy experiments. In 

RelaxIS, you can organize and evaluate your measurement results using 

powerful fitting algorithms with models of your choice. Furthermore, RelaxIS 

also offers advanced tools that allow further evaluation of the results, as well 

as exporting and reporting functionalities to allow the presentation of your 

findings. 

This manual first shows the installation of RelaxIS. It then continues with an 

explanation of the main user interface and the basic data structure.  

The manual then details aspects of the presentation layer, investigation of data 

quality, main fitting routines you can use to model your data and how you can 

investigate the quality of the results. 

Afterwards, advanced tools for the further evaluation, presentation of data 

and automation of the evaluations are introduced. 

 

We wish you a good time working with RelaxIS! 
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1 INSTALLATION OF RELAXIS 

1.1 INSTALLATION OF RELAXIS WITH THE INSTALLER 

RelaxIS 3 requires the .NET Framework 4.7.2 or later and can therefore only be 

used on Microsoft Windows 7 SP1 (or newer). 

 Please note 

As of December 31st, 2021 support for Windows 7, 8 and 8.1 has ceased. 

While RelaxIS may still function, it is not supported and can’t be guaranteed. 

We recommend updating to Windows 10 to continue using new versions. 

 

Please open the installer by double-clicking the RelaxIS_3_0_xx_xxInstall.exe. 

The location of the installer on your system depends on your chosen 

distribution system. If you have received a CD or flash-drive, the installer can 

also be started by using the Autostart feature of Microsoft Windows. 

To use RelaxIS, you need to have the Microsoft .NET Framework 4.7.2 or later 

installed on your system. The installer checks if the framework is installed on 

your system. If it is not installed properly you will be prompted to download 

the installer from the web. If you have received a flash-drive or CD, you can 

also find the .NET Framework installer in the folder 

CD-Drive:\.NET Framework\ 

If you received your copy of RelaxIS without the .NET Framework Installer 

please visit 

https://dotnet.microsoft.com/download/dotnet-framework/net48 

and download the .NET Framework Runtime installer. Run it and follow the 

instructions to install the .NET Framework. 

After the .NET Framework is installed, please perform the following steps in 

the RelaxIS installer: 

1. Accept the RelaxIS program license 

2. Select an installation path on your hard disk.  

https://dotnet.microsoft.com/download/dotnet-framework/net48
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3. Choose if shortcuts for RelaxIS should be created. 

4. Choose if you want to associate .EIS3 files (RelaxIS 3 project files) with 

RelaxIS. This allows you to open .EIS3 files with RelaxIS by double-

clicking on them. 

5. Begin the installation process 

While installing RelaxIS, you will be prompted with the CodeMeter Runtime 

installer. This runtime is required for the hardware Dongle you received with 

RelaxIS to function properly. You can find further information in section 1.5. 

Please follow the installer’s instructions, using the default settings to install 

the runtime. Once finished, the RelaxIS installation will continue. 

Finally, you can either directly launch RelaxIS from the installer or use the 

shortcuts created in the Start Menu or on the Desktop. 

1.2 RELAXIS WITH ONLINE ACCESS 

If you have received account information for using RelaxIS with an online 

license (e.g. a Trial Version), please make sure that “Setup for Online Account” 

is selected in the feature selection during the installation. 

If you have not received a link to download the installer, please contact rhd 

instruments. 

After the installation, please launch RelaxIS from the installer or use the 

shortcuts created in the Start Menu or on the Desktop. 

During start-up, you will be prompted for your account details. Please enter 

them exactly as received and click on the Connect button. This will start a 

client software, that will connect to the rhd instruments license server to 

validate and access the license. 

RelaxIS should now start automatically. If the connection is successful, but 

RelaxIS does not start, please click Retry.  

If you cannot start RelaxIS, please check 

https://www.rhd-instruments.de/relaxis-online-guide 

for further information and trouble-shooting instructions. 

https://www.rhd-instruments.de/relaxis-online-guide


Installation of RelaxIS 

 

3 
 

Here, note especially to run the tests provided by the trial client software. Find 

the trial client in the notification area (systray) and double-click the icon to 

show the window. Click Advanced → Run Tests. Please provide the test log to 

rhd instruments. 

 Please note 

If RelaxIS is very slow to start-up, or it takes a long time for functions to 

work, it may be caused by high latency or slow speed of your network. 

RelaxIS needs to communicate with its license server multiple times, leading 

to delays. 

For high latency, RelaxIS may take several minutes to start up. 

We understand, that this is not really usable. If you experience poor 

performance, please contact rhd instruments. We may be able to provide you 

with a hardware dongle or custom solution, which allows you to use RelaxIS 

locally. This applies to both the full version as well as the trial version! 

 

1.3 PORTABLE VERSION OF RELAXIS 

In many restricted environments, a normal installation of RelaxIS is hardly 

possible. For this reason, a portable version of RelaxIS is also provided.  

 Please note 

The portable version of RelaxIS is discontinued after version 3.0.15. 

 

This version differs from the normal version in some ways: 

• No installer is provided. The files need to be extracted from a .ZIP-

archive to the desired program location by hand. 

• You cannot update the program via the implemented update 

mechanism. 

o You can check online for a new version 

o You then need to contact the rhd instruments for more 

information on how to obtain the new version. 
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• All required user files are created directly in the directory that RelaxIS 

was extracted to. Therefore, permanent read/write access to the install 

directory must be provided (e.g. don’t place the folder in the Programs 

directory, but in a directory like C:\RelaxIS\Portable) 

• All settings are shared between all users of the particular installation. In 

order to use multiple settings, you need to copy RelaxIS Portable into 

multiple directories. 

• Online access, as described in 1.2, should work. If you experience any 

problems, please contact rhd instruments. 

To install the portable version please follow these steps: 

1. Open the installation medium in the Windows Explorer and locate the 

“RelaxIS Portable” directory. 

2. Find the .ZIP file in this folder. 

3. Use an extraction method of your choice, such as the one integrated into 

the Windows Explorer to extract the contents of the archive to a location 

of your choice. 

4. Navigate to the extraction destination. 

5. Start RelaxIS Portable by double-clicking “RelaxIS.exe”. 

6. Optional: Create a Desktop-shortcut by right-clicking “RelaxIS.exe” and 

choosing “Send to→Desktop (create shortcut)”. 

1.4 POSSIBLE ISSUES 

• Administrator privileges are required for the installation. You may 

need to contact your system administrator if you do not have the 

necessary privileges on your user account. 

• You can also try to use the portable version of RelaxIS. You can find this 

version on the installation medium provided to you. 
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 Please note 

If you experience any problems please check the following steps: 

• Are any files or directories marked as read-only? 

o If so, unmark the read-only attribute. 

o Do you have unlimited access to the folder you copied RelaxIS 

to? If not, please move RelaxIS Portable to another location. 

• Is it possible to read/write to the Windows registry (Current user)? 

o If not, please contact your system administrator for help. 

• Are you using RelaxIS from a shared network folder? 

o It is possible to use a network-wide implementation of the 

Dongle. 

o Please contact rhd instruments for further details. 

 

1.5 THE CODEMETER DONGLE 

In order to use RelaxIS you need to connect the CodeMeter Dongle that was 

provided by rhd instruments to a free USB-Port on your computer. The 

CodeMeter Dongle is a product of the Wibu Systems AG and is used as a 

licensing tool for RelaxIS. In order for the Dongle to work, the CodeMeter 

Runtime must be running on your computer. The RelaxIS installer 

automatically installs this necessary, lightweight software. In case of the 

Portable version additional steps may be necessary (please see below in section 

1.5.3). You can find further information about the CodeMeter system at 

http://www.wibu.com. You can also download additional software that allows 

more control and management services for your Dongle. 

On every program start RelaxIS checks if the correct Dongle is connected to 

the computer, or via the online access. If the Dongle was not found, you will 

not be able to run RelaxIS or the Circuit Simulator.  

http://www.wibu.com/
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 Please note 

If the Dongle is not accessible, RelaxIS ceases to function. Usually it is 

possible to resume the session by reconnecting the Dongle and clicking Retry 

in the warning dialog. 

In some cases, e.g. after resuming Windows from Standby, or Hibernation it 

may take up to a minute for the warning dialog to appear, especially when 

an online license is used. Please be patient. 

In rare cases you may experience problems, which cause RelaxIS to freeze 

permanently. Please make sure to save your work frequently to avoid data 

loss. 

 

1.5.1 UPGRADING THE RELAXIS LICENSE 

In order to upgrade your RelaxIS license from, for example, the trial version to 

the full version, it is not necessary to physically alter the Dongle you are 

already using. Usually rhd instruments will provide you with an update file 

that can be used by the rhd instruments License Manager to upgrade your 

Dongle. 

The License Manager can be started from the Windows Start menu. 

If you have already received the upgrade file (.WibuCmRaU) please perform the 

following steps to upgrade your Dongle: 

1. Make sure the CodeMeter Dongle is correctly plugged into your 

computer. 

2. Save the upgrade file you received on your computer’s hard drive. 

3. Open the rhd instruments License Manager. 

4. Under the heading “Activate a new license” click the “…”-button and 

select the upgrade file. 

5. Click the “Activate”-button. 

The upgrade included in the upgrade file is then performed on your Dongle 

and you will be able to use the newly activated features immediately. 
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1.5.2 REQUESTING A LICENSE UPGRADE 

In some cases, rhd instruments will ask you for a so-called Context File before 

an upgrade can be provided for your Dongle. This Context File (.WibuCmRaC) 

contains information needed to create the upgrade file. The Context File can 

be easily created using the rhd instruments License Manager. 

The License Manager can be started from the Windows Start menu. 

To create a context file please perform the following steps: 

1. Make sure the CodeMeter Dongle is correctly plugged into your 

computer. 

2. Open the rhd instruments License Manager. 

3. Under the heading “Create a license request” click the “…”-button and 

select the path where you wish to create the Context File. 

4. Click the “Create”-button. 

5. You will find a new file at the specified location, called 

“CmDongleUpdate20140423_0001.WibuCmRaC” or similar. 

6. Send this file to rhd instruments to receive your Dongle upgrade file. 

To upgrade your license afterwards please follow the steps explained above in 

chapter 1.5.1. 

 

1.5.3 SPECIAL NOTES FOR THE PORTABLE VERSION 

In order for the portable version of RelaxIS to function properly the CodeMeter 

service needs to run on your system. Usually, this service is installed as a 

Windows service together with RelaxIS. However, since the portable version 

does not require an installer this is not the case here. The service should 

nevertheless be automatically started each time you launch RelaxIS. In some 

cases, this fails and RelaxIS will prohibit the use of the software because it 

can’t properly communicate with the hardware Dongle. In this case it is 

necessary to start the service manually. This can be done by manually 

launching the file “CodeMeter.exe” in the RelaxIS Portable directory. The 
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CodeMeter Runtime runs silently in the background and RelaxIS should start 

afterwards. 

In order to avoid the manual launch of “CodeMeter.exe” after every reboot you 

can add a shortcut to the Windows Autostart folder. To do so please follow 

these steps: 

1. Open the RelaxIS Portable directory in the Windows Explorer. 

2. Right-click on the “CodeMeter.exe” and select “Create shortcut” 

3. Right-click on the newly created shortcut and select “Copy” 

4. Press WindowsKey+R or select “Run…” from the Start menu. 

5. Type in %AppData% and press OK. 

6. In the folder that is opened navigate to Microsoft\Windows\Start 

Menu\Programs\Startup (note that this folder may be called differently 

depending on your Windows localization) 

7. Right-click in the explorer window and select “Paste” 

Now the CodeMeter Runtime will be started automatically each time you start 

Windows.  
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2 IMPORTANT NOTES FOR USERS OF RELAXIS 2.X 

RelaxIS 3 contains practically all functions of RelaxIS 2.x, sometimes however 

in slightly modified form. Some functions have changed as well. 

Most importantly, the file format that RelaxIS data is saved in has changed. 

Older .EIS files can not directly be loaded in RelaxIS. They can however be 

easily converted to the new .EIS3 format. In RelaxIS 3 open the File menu in 

the top-left corner and select Convert .EIS (2.0) files. In the dialog click the 

Select… button and choose any .EIS files you wish to convert. Click the 

Convert button. RelaxIS will convert the files and place new .EIS3 files in the 

same directory as the source .EIS file. 

Further important changes or redesigns in regard to RelaxIS 2.x are: 

• Arrhenius/VFT-Fits are incorporated in the Further Result Evaluations 

functionality (see section 12.7). 

• The Circuit Element Designer is replaced with plugins created using the 

RelaxIS SDK (see section 22). Existing user-created elements need to be 

redone in the new format. 

• The RC- and Cole-Cole-wizards are currently not included but will be 

added in further patches (wizards can now also be created by yourself 

using the RelaxIS SDK). 

• Area and Thickness parameters are now saved individually per 

spectrum and are used more extensively. 

• The definitions (formulas) for the Warburg Open (Wo) and Warburg 

Short (Ws) circuit elements have changed. You can find the updated 

formulas in the appendices. The changes mean that you cannot directly 

compare parameter values for Wo- and Ws-elements between RelaxIS 2 

and RelaxIS 3. 
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3 BEHAVIOR IN CASE OF PROGRAM CRASHES 

On rare occasions RelaxIS might encounter a problem that necessitates a 

program restart. These problems are called unhandled exceptions because they 

occur at a point in the program and in a way, that was not anticipated during 

development.  

After such a failure RelaxIS is in an undefined state because the program did 

not continue to run to a defined point and could have left program memory in 

an intermediary state which effects other parts of RelaxIS. Therefore, the 

correct functioning of other functions or calculations in future actions can not 

be foreseen. Hence, continuing using RelaxIS from such an undefined state can 

lead to a variety of obvious or hidden problems from wrong calculation results 

to data corruption when the current data is written back into the EIS3 database. 

Up to version 3.0.7 the policy of RelaxIS when an unhandled exception 

occured was therefore to 

1. Try to create a backup save of the current data in the 

UserData\Recoveries folder 

2. Allow the user to send a bug report 

3. Force an immediate shutdown of RelaxIS 

From version 3.0.7 onwards this behavior is being changed to 

1. Create a backup save of the current data in the UserData\Recoveries 

folder 

2. Allow the user to send a bug report 

3. Give the user the option to either shutdown RelaxIS immediate or 

continue using the program at own risk 
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When an unhandled exception occurs a dialog pops up that informs you of the 

type of error encountered and the path of the recovery save. 

 

Sending a bug report is highly recommended because it allows us to know of 

the bug and fix it. If you like to receive feedback from us about the problem 

you have encountered or allow us to ask about further information please 

enter your mail address into the field. You are also asked if you would like to 

include todays log file, which may contain helpful details for us. 

You can also enter additional information into the message field. Helpful 

information includes for instance a description under which circumstances 

you encountered the error (e.g. which component of RelaxIS you were using). 

The more details, the better. Thank you! 

 

 

 

After sending (or not sending) the bug report, you will be asked if you would 

like to continue on from this point or if you want to close RelaxIS down now. 
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We highly recommend that even if you continue running RelaxIS you just 

use the time to save your work and then restart RelaxIS as soon as possible. 

 

When you try to save data from an undefined state into the same project folder 

you will see a warning asking you if you want to continue. This is to avoid you 

overwriting “good” data with possibly corrupt data. Saving from an undefined 

state does not neccesarily lead to corrupt data, but the possibility can’t be 

excluded either. 

A better option is to save the data as a new project folder under a different 

name and after restarting RelaxIS carefully checking if the data has been saved 

correctly. 
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4 THE MAIN USER INTERFACE 

When you start RelaxIS you will be greeted by the Welcome Dialog. Here you 

can quickly create a new project folder, open an existing one or access the 

manual. If you don’t want to see this dialog every time RelaxIS is opened, 

please mark the “Don’t show this dialog again” box at the bottom right, and 

close the dialog. You can re-enable the Welcome Dialog using the “General 

Options” tab of the Settings dialog. 

The main user interface of RelaxIS is – by default – divided into four parts. 

 

1. The Ribbon Bar 

Grants access to all functions of RelaxIS through the various tabs. Not 

all functions are accessible at any time. This depends on loaded data, 

assigned models and so on. Unavailable items are grayed out. 

Some buttons are divided into a top and bottom half, where the bottom 

half usually grants quick access to default behaviors of the function. 

2. The Parameter Explorer 

In this window, you manage parameter values of assigned models and 

can inspect fit results. It is also used for some helper functions. 

3. The Data Explorer 

This is the main graph window that displays loaded data and fit curves. 

It is also used for advanced features like some initial parameter helpers 

or modification of the active frequency range. 
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4. The Spectra Explorer 

In this window, you manage the data of the current project. At the top, 

you can access a dropdown menu that lists all currently present models 

in the project, while the bottom table shows all spectra that are currently 

assigned to the active model. From this table, you select the currently 

active spectrum you want to work with. 

You can also add data by drag & dropping files onto the table. 

 

You can rearrange the windows by clicking and dragging their title bars. You 

can leave the windows as floating windows, or dock them to other parts of the 

GUI. By clicking the needle icon in the title bar of the windows, it is also 

possible to retract the window into side bar. You can then show the window 

again by moving the mouse onto the flag at that side that represents the 

retracted window. 

If you close one of the windows, you can reopen them using the button on the 

Windows tab of the main ribbon bar. 

If any of the windows were moved into unreachable positions or are 

completely invisible you can reset the window settings by clicking the Reset 

Window Positions button on the Windows tab of the main ribbon bar. 

This tab also allows you to enable the Multi-Monitor Mode. This button simply 

stretches the RelaxIS window automatically over all currently connected 

screens. 
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5 RELAXIS DATA STRUCTURE 

Data is stored and worked on as single spectra in RelaxIS. The general data 

structure can be visualized using a tree structure. 

 

5.1 SPECTRA 

Spectra contain information like raw impedance data as well as metadata. 

Metadata consists of secondary variables like temperature or DC bias that can 

be assigned in RelaxIS or read directly from the data source.  

5.2 MODELS 

Spectra are assigned to models. This allows working with more than one model 

at a time. Spectra can be moved between models or duplicated in order to try 

fitting the spectra with different models. 

5.3 PROJECTS 

The models are themselves organized into projects. The projects may for 

example represent different dates, test series or similar. Projects also contain 

a Result Library, see section 15. 

5.4 PROJECT FOLDERS 

The projects are then stored in a project folder, which represents a physical 

file on your hard drive. These files are SQLite databases - a type of relational 

databases. SQLite is an open database format. It has the advantage of requiring 

no further configuration on the machine, while at the same time offering fast 

and reliable data storage capabilities. Project folders have the file ending .EIS3.  

Spectra

Models

Projects

Project folder SQLite database
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6 DATA MANAGEMENT 

6.1 MANAGING PROJECTS 

 

Use the buttons in the main ribbon bar’s Main tab to create a New project 

folder, to Open an existing one or to Save the current project folder. 

You can furthermore access the project management interface that allows you 

to add projects to your project folder, remove existing ones or switch between 

them by using the Manage projects button. 

 

 Please note 

Before you can access the Project Management dialog, you have to save the 

project folder first. Only the currently active folder is held in memory, while 

the inactive ones are stored in the database. Therefore, you can’t have more 

than one unsaved project opened at a time. 
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Use the + and − buttons to add or remove projects from the project folder. 

Select a project and click on Switch project to change the currently active 

project. 

You can also edit the project names and comments through the respective 

interfaces. 

 Please note (IMPORTANT) 

The SQLite databases do not support concurrent access from multiple 

clients! You should strictly avoid accessing the same database from 

multiple instances of RelaxIS, or even from multiple computers using 

shared network-resources. Doing this can lead to data loss, since altered data 

in a project is stored in the computer’s memory and not directly in the 

database. Saving the project again will overwrite changes made and saved 

by another client. 

When a database is opened in RelaxIS, it will be flagged as opened and other 

users will receive a warning. If RelaxIS is not closed properly these flags may 

persist even after the database is not in use anymore. Therefore, the locks 

may be ignored, but please do so only after making sure no one else uses the 

database. 

 

6.2 ADDING DATA TO A PROJECT 

Most data management like adding, changing or removing data is performed 

using the buttons in the Data and Quality tab of the main ribbon bar.  

 

You can add impedance spectra to RelaxIS by clicking the Add button from 

the Data and Quality tab, by copying text-based data into the Windows 

clipboard and selecting Load from clipboard after copying the data. You can 

also Drag & Drop files from the Windows Explorer or Outlook attachments 

onto the Spectra Explorer window. 
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 Please note 

When data is imported, from any source, RelaxIS checks if each datapoint is 

composed of valid numbers. The numbers can’t be infinite or invalid, and 

must not be larger than a limit set under Main->Settings->Data and Import. 

In addition, frequencies must be larger than 1/limit (i.e. 1e-50 if the limit is 

1e50). This is to avoid methods failing to perform suitable analysis of spectra 

with large numbers. 

 

6.2.1 KNOWN DATA FILE FORMATS 

RelaxIS supports several different data file formats, that can be read directly, 

sometimes including metadata. You can define additional formats using the 

RelaxIS SDK. 

The supported formats are: 

• Nova RelaxIS Export (Metrohm Autolab) 

• .EPS (Novocontrol WinDETA binary data file) 3rd party 

• .DCD (Novocontrol DETAchem binary data file) 3rd party 

• Novocontrol WinDETA ASCII export file 3rd party 

• .ISM (Zahner Zennium binary data file) 3rd party 

• .MPR (BioLogic EC-Lab binary data file) 3rd party 

• BioLogic EC-Lab© ASCII export file 3rd party 

• hcDLL result files (rhd instruments GmbH & Co. KG) 

• .NOX (Metrohm Autolab Nova) 3rd party, see note [1] 

• .Z (Scribner ZView ASCII data file, Modulab ZView Export) 3rd party 

• .DTA (Gamry instruments data file) 3rd party 

• Digatron .CSV export files 3rd party 

• .IDF, .IDS (Iviumstat) 3rd party 

• .SPEC (Sciospec) 3rd party 

• Solartron Versastudio ASCII export (Freq|Zre|-Zim or Zre|-Zim|Freq) 3rd party 

• .psession (PalmSense data files) 3rd party 

[1] Reading of NOX files can be improved by installing the Metrohm Nova 

software on the same PC as RelaxIS. 
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 Please note 

Not all file formats are officially specified by the respective manufacturer. 

Therefore, no guarantee can be given for the correct reading of all data files 

in every circumstance. Please check the imported data carefully. The 

formats are also subject to change when the manufacturer’s software is 

updated, thus breaking the support. Please notify rhd instruments when you 

encounter any problems and check the imported data carefully. 

 

6.2.2 UNKNOWN DATA FILE FORMATS 

If you try to load an unknown data file you will be presented with the Unknown 

File Dialog. This dialog allows you to load arbitrary, column-based data files. 

 

The dialog is built as a wizard, with 3 steps: Data format setup, column role 

selection and confirmation. 

6.2.2.1 DATA FORMAT SETUP 

The first page shows the input data as a text file and highlights special 

characters (orange) as well as numbers (purple) in it. RelaxIS automatically 

tries to determine the data settings but you may need to supply the correct 

format options on the left: 



Data Management 

 

20 
 

• Select the text characters that separate columns. These can be for 

example tabs, commas or whitespace (“space” characters). Custom 

characters can also be supplied 

• Designate the number of header lines, i.e. lines that are skipped before 

the data import starts. The header lines are shown in blue, and the last 

header line is shown in green.  

• You can skip specific lines in the import by typing the line numbers in 

to the Skipped Lines input box. Add commas between numbers. You can 

also enter ranges, example: 2, 3-9, 12 

• The “Columns Repeat after” field is used in cases, where a file contains 

multiple spectra in repeated sets of columns. For example, the file 

contains the columns: Freq 1, ZR1 ZI1, Freq2, ZR2, ZI2, … then the 

Columns repeat after field would be 3. 

• Number format allows you to select which format the numbers have for 

the import, e.g. decimal separated with dot or comma. 

• Selected formats can be saved in the confirmation step. If you have 

previously saved a format, you can select it from the list of existing 

formats and apply it directly. This restores both format settings as well 

as selected column roles (next step).  

Once the format is selected, click Next to move to the Role Selection step: 
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Here you need to select which role the individual columns serve. Not every 

column needs to be designated, but enough data needs to exist to calculate the 

impedance. 

RelaxIS tries to automatically assign roles based on the values in the last 

(green) header line. This header line will be split alongside the data and the 

column values are then checked against certain keywords. 

 Please note 

Always check the automatic selection. The algorithm uses simple word 

matching and may not identify the columns correctly. 

 

Next to impedance data, you can also select metadata. The values from these 

columns will be split with the rest of the data and then averaged per spectrum. 

The dialog also allows you to enter additional static metadata values, that will 

be applied to each imported spectrum. 

Last, you can choose between different splitting options. Automatic splitting 

uses the frequencies to find boundaries between spectra and splits the spectra 

on these boundaries. Select Don’t Split to keep the data together in one 

spectrum. Or supply the number of datapoints per spectrum if automatic 

splitting fails. Last, it is possible to define a column index that that is used for 

splitting the data. Whenever the value in the specified column changes, a new 

spectrum is started. 

Once you have made all settings, click Next to move to the Confirmation step. 

 

Here, you can select if this format should be used for all files in the current 

import. Otherwise, the dialog will be shown again for the next file, which is 

helpful if you import files with different formats in the same go. 
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You also have the option to enter a name for the file format settings. Simply 

enter a text into the box (or select one from the dropdown), and once you click 

Finish, the format is saved and can then be used in subsequent imports. 

6.2.3 MODIFYING THE DATASOURCE FORMAT 

By default, the path of the file that contained the spectrum is displayed as the 

Datasource property of each spectrum. If a file contained more than one 

spectrum, a running index is added to the filename. You can change the format 

of the filename using the Settings dialog, available from using the Settings 

button on the Main tab. 

In the Settings dialog select Value formats and edit the Filename Datasource 

Format section. You can enter a format string using various tags, that are 

always lead by a # character. The possible tags are (as an example the file 

C:\Test1\Test2\test.txt, containing multiple spectra is used): 

 

Tag Meaning 

#F The full folder, e.g. C:\Test1\Test2 

#1 The last folder in the path, e.g. Test2 

#2 The second to last folder in the path, e.g. Test1 

#3 The third to last folder in the path, e.g. C: 

#N The filename without extension, e.g. test 

#E The file extension, e.g. .txt 

#P The running index of the extracted spectra, e.g. 1, 2, … 

 

You can combine these tags with arbitrary text to produce the format of your 

liking. Some examples are: 

Datasource format string Result 

#F\#N#E_#P C:\Test1\Test2\test.txt_1 

\#1\#N#E (#P) \Test2\test.txt (1) 

#N from folder #F of type #E 

(Spectrum no. #P) 

test from folder C:\Test1\Test2 of 

type .txt (Spectrum no. 1) 
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6.2.4 BEHAVIOR OF DATA FILES AFTER BEING ADDED TO RELAXIS 

Once data files from your disk were added to RelaxIS, the data in RelaxIS holds 

no tie to the actual files on your drive. The active project is held in memory, 

while inactive projects in the project folder are stored in their respective 

SQLite database. This means that you are free to move, delete or rename the 

files on your drive, without any data being altered in your RelaxIS project. The 

same is true for the opposite direction. No source file on your drive is altered 

by adding it to RelaxIS, even if the actual data in RelaxIS is modified. The data 

files are opened as read-only and are never modified. 

6.2.5 EXTRACTING METADATA FROM FILENAMES 

RelaxIS offers a method to automatically extract metadata values from the 

source file names when importing new files. Values are selected in the filename 

by means of a user-defined Regular Expression (RegEx).  

 Please note 

Explaining the full syntax of regular expressions is beyond the scope of this 

manual. However, given that they are a very common concept in computer 

languages, abundant resources can be found online. For example: 

Quick reference: 

https://docs.microsoft.com/en-us/dotnet/standard/base-types/regular-

expression-language-quick-reference 

Regex Tester: 

https://regex101.com/ 

 

Regular expressions define a contents of a text in a more abstract way. For 

example the text “Test12345” could be seen as “Some upper- or lowercase 

letters followed by some numbers”. A regular expression is a way to express 

such abstractions as a universal expression, in this example the corresponding 

regex would be “[A-Za-z]+[0-9]+”. Once defined, software can check of an input 

string matches the regular expression. For example, the text “12345Test” 

would not match, because it is not letters followed by numbers. 

https://docs.microsoft.com/en-us/dotnet/standard/base-types/regular-expression-language-quick-reference
https://docs.microsoft.com/en-us/dotnet/standard/base-types/regular-expression-language-quick-reference
https://regex101.com/
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Further, regular expressions can define so-called capture groups, which are 

usually introduced by brackets, e.g. “[A-Za-z]+([0-9]+)”. Here, the numbers after 

the letters would be captured in a group and therefore extracted by the 

software. The groups can be given a name by adding ?’Name’ to the beginning 

of the group, e.g.: “[A-Za-z]+(?’MyName’[0-9]+)”. 

In RelaxIS, such named capture groups are used to define which values should 

be extracted for which metadata field. The group names should correspond to 

the common metadata abbreviations like T or FV. If the values of the captured 

groups are numerical then RelaxIS can parse them and assign the values to the 

respective field. In addition to the metadata abbreviations, a group named 

“DATASOURCE” can be used to assign a part of the input to the data source 

field. 

To define the regular expressions used for parsing filenames, open the settings 

dialog from Main -> Settings and then Data & Import. Here find the “Metadata 

from Filename” panel. The regular expression is entered into the Regular 

Expression field. If the Match full path box is activated, the input to the  regex 

contains the full path instead of just the filename. This is useful if relevant 

information is contained in the path. Please note though, that your regular 

expression must parse the full path in this case! 

The Datasource prefix input allows you to add a fixed text in front of the 

potentially captured data source field. 

To make designing the regular expression easier, you can click on the … button 

next to the input field to show a designer window. 

The designer allows you to enter the regular expression as well as a test string. 

The test string is automatically populated with the path to the source file of 

the first spectrum in the current project, if there is one.  
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You can change the test string however you like. While you enter the test string 

or the regular expression, RelaxIS will automatically try if the regex matches. 

If it does, all captured groups will be evaluated, and the results placed into the 

fields table. If the regex doesn’t match the test string, or if no groups are 

captured a warning is displayed next to the input field. 

If the groups are captured, but the name wasn’t recognized, a question mark 

will be placed next to the name. 

You can also check the Value (Number) column to check if the value is correctly 

parsed to a number. 

6.3 AUTO SAVES 

If enabled in the Settings dialog under Main→Settings→General the currently 

loaded project folder can be automatically saved as a copy every n minutes. 

The data can either be saved into the user data folder (commonly in the My 

Documents folder), or alongside the already saved source file. Auto saves do 

not alter the manually saved project folder!  If the data is saved in the user 
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folder an individual file per running instance of RelaxIS is created. The names 

of these files are chosen as follows: 

1. The saving instance of RelaxIS (RxS) gets a list of all running RelaxIS 

processes.  

2. This list is sorted by the start time of the process. 

3. RxS determines its position in this list. 

4. The auto save file is named “Autosave Instance X.eis3”, where X is the 

position determined in step 3.  

This method ensures that all currently actively used data files are auto saved 

and the different instances of RelaxIS don’t overwrite each other. At the same 

time, the number of created files stays at a minimum. 

6.4 THE SPECTRA EXPLORER 

The loaded spectra are listed in the Spectra Explorer window together in their 

respective models.  

 

The list shows all metadata associated with each spectrum. You can switch 

between models (once created) by clicking the model designation and selecting 

another model from the dropdown menu. 

The “x columns hidden” button allows hiding metadata columns, for which 

no spectrum in the list has a value. 

You can move spectra in the list by using the up/down buttons in the top-right 

corner. 

The Fitted? column displays whether or not the spectrum has an up-to-date 

fit, white the Lower and Upper frequency limit columns display the active 
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frequency limit in which fits are performed. This will be further explained in 

section 10.5. 

RelaxIS distinguishes between the Active Spectrum (or Current Spectrum), 

which is displayed at all times in the Data Explorer plot, selected Spectra, 

which you can select from the list of spectra using the CTRL, SHIFT (while 

selecting files with the mouse) or CTRL+A keys, and non-selected spectra. 

6.4.1 COPY & PASTING SPECTRA 

Spectra can be copied to the clipboard and pasted into the same or other 

Spectra Explorer windows. This can be in another open instance of RelaxIS, or 

you can e.g. switch the active project of the current project folder after copying 

spectra and paste them into the other project.  

To copy spectra, select them in the Spectra Explorer window (select multiple 

by holder CTRL), then right-click and select “Copy spectra to clipboard” from 

the context menu. 

To paste the spectra, navigate to the target Spectra Explorer, right-click in it 

and select “Paste spectra from clipboard”. An exact copy will be created in the 

target Spectra Explorer. 

6.5 SELECTING MULTIPLE SPECTRA: THE SPECTRA SELECTION DIALOG 

Many features of RelaxIS can be applied to multiple spectra at a time. 

RelaxIS contains two modes of operation in this regard: a) Use of the currently 

selected spectra in the Spectra Explorer list, called “direct selection mode”, or 

b) the Spectra Selection dialog, called “dialog selection mode”. 

To switch between the two modes, use the “Always use selected spectra for 

data-related functions” setting from the General section in the Main → Setup 

dialog. 

In mode a), first select the spectra you wish to apply a function on, and then 

execute the function by i.e. clicking the respective ribbon button. Note that 

some function will still use the spectra selection dialog shown below if 
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required, usually if the currently active spectrum is important. One example is 

the “Spread Spectrum Data” function. 

In mode b) you will often encounter the Spectra Selection dialog. The dialog 

allows you to define a specific selection of spectra and is split into three pages, 

where pages 2 and 3 are optional. At any point, you can preview the current 

selection using the Preview selection button from the toolbar. You can save 

and load settings as well by using the corresponding buttons. For small, 

temporary changes you can quicksave and quickload a configuration by using 

the MS/MR buttons in the top-right corner of the window. 

 

The first page (or tab) designates the overall selection scheme. Not all 

operations allow the selection of All spectra, since they can only work if the 

spectra are assigned to the same model. Under and Over current spectrum 

refer to the Active Spectrum and select all spectra in the current model into 

the chosen direction, including the Active Spectrum.  



Data Management 

 

29 
 

 

The second page allows a refinement of the selection by using the metadata 

available for the spectra. You can enter selection rules by three steps:  

1. Select a metadata category like temperature or dc voltage. 

2. Select a Boolean operator like “equals” or “greater than”. 

3. Enter a value to compare the metadata with. 

You can also choose if spectra are selected only when they match all rules 

(meaning an AND concatenation of the rules) or if they should be selected if 

they match any one of the rules (OR concatenation). 

 

The third page allows sorting of the selected spectra. The spectra can be sorted 

by various properties and in either ascending or descending order for each 

selected property. The sorting steps are performed from top to bottom in the 

list. In the example image above all spectra are first sorted ascending by 
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temperature. Spectra with the same temperature are afterwards sorted 

descending by Area. You can remove steps from the list using the green button 

in the middle. 

6.6 REMOVING DATA FROM THE PROJECT 

Spectra can be removed from the project permanently by selecting the spectra 

in the Spectra Explorer list and either clicking Remove from the Data and 

Quality tab or by pressing the Delete key. 

 Please note 

Deleting spectra from your project CANNOT be undone! All fits or metadata 

is permanently lost and you need to add the original data file to RelaxIS again 

and redo the changes made to it yourself. 

 

6.7 REMOVING DUPLICATE SPECTRA 

You can search for and remove duplicate spectra in the project by clicking the 

Search Duplicates button on the Data and Quality tab of the main ribbon. 

In the dialog, you can select the basis on which duplicates are identified. Two 

spectra must match perfectly in the selected attributes like data or metadata 

in order to be classified as duplicates. Click Start to begin the search. 

If duplicates are found they are listed under the heading of the first found 

spectrum of each set of duplicates. To remove duplicates, uncheck the box in 

front of the name. By default, only the first found spectrum of each set is kept. 

After you made your selection, please click OK to remove all unselected 

spectra from the project. 

6.8 MODIFYING METADATA 

You can modify metadata associated to spectra using the Change metadata 

and Spread parameters buttons in the Change spectra section of the Data and 

quality tab. These functions are also available from the context menu in the 

Spectra Explorer window (right-click a spectrum to open it). 
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Furthermore, you can enter the metadata values directly in the Spectra 

Explorer window by double-clicking the respective value or clicking the cell 

and just start typing. By default, RelaxIS hides metadata columns that contain 

no data. To enter values for these, first unhide the columns by clicking the 

blue button in the top right of the Spectra Explorer list. After entering the data, 

you can safely hide the remaining empty columns again. 

The Change metadata dialog allows you to set or change metadata for one or 

more spectra using different methods. 

 

To change metadata, please perform the following steps: 

1. Select the parameter you want to change with the combobox at the top. 

2. Select a modification method using the second dropdown menu. 

a. Setpoint sets the variable to a specific value. 

b. Additive adds a specific value to the current value of the 

parameter. If the parameter is currently unavailable for a 

spectrum, it is set to the selected value instead. 

c. Multiply multiplies the current value with the selected value. If 

the parameter is currently unavailable for a spectrum, the 

spectrum is ignored. 

d. Ramp starts with the first entered value for the first selected 

spectrum and then continuously adds the dV value to create a 

ramp of values.  
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e. Rounding allows you to round the metadata value to a given 

number of (significant) decimal places. 

f. By Formula lets you enter a mathematical formula to calculate the 

metadata value for a spectrum. 

g. From List lets you enter, or more likely, paste a list of values that 

are assigned from top to bottom to the selected spectra. 

h. You can Remove a Metadata value from the spectrum entirely. 

Click Select targets button to be led to the Spectra Selection dialog (if dialog 

selection is enabled), or the change will be executed on the selected spectra. In 

case of the Ramp and From List methods, keep the sorting order of the selected 

spectra in mind. 

 

The Spread parameters dialog in turn allows you to spread spectrum 

parameters like frequency limits or fixed fit parameters to other spectra in the 

same model.  

 

To do this, please perform the following steps: 

1. Select the source spectrum in the Spectra Explorer as the active 

spectrum. 

2. Click the Spread parameters button. 

3. Select one or more parameter types to spread. 
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4. For parameter values and limits you can choose, if spreading should be 

done for all parameters, or for fixed/non-fixed parameters only. 

5. Click the Select targets button to be led to the Spectra Selection dialog 

and choose the spectra the parameters will be spread to. Direct selection 

mode is not supported. 

The Frequency Range and Parameter Limits options further let you select if 

you want to spread the lower, upper or both limits. Simply mark the settings 

you want to spread with a checkmark. 

6.9 DIELECTRIC DATA 

Normal spectra in RelaxIS use non-normalized transfer functions, based on the 

Impedance. Without further knowledge of the data, the data can be 

recalculated into the other transfer functions (admittance, complex 

capacitance, elastance).  

In order to use typical dielectric transfer function (permittivity 𝜀, modulus), a 

geometric factor, e.g. based on the sample area, and thickness, needs to be 

known. While for many techniques, this factor is known, some dielectric 

techniques, especially in the high frequency domain, only provide e.g. the 

permittivity as the measurement result. 

To accommodate such spectra, the spectrum can be marked as an 𝜺-only 

spectrum. To enable this functionality, select Main → Settings → General → 

Enable Dielectrics Functions from the main menu. 𝜀-only spectra are marked 

in a corresponding tab in the Spectra Explorer list 

In the background, the data of 𝜀-only spectra is treated the same as other data, 

since in the mathematical sense e.g. the permittivity behaves exactly like the 

complex capacitance. However, all display elements in RelaxIS, like axis titles 

on graphs, now display the correct names for the normalized transfer 

functions. 

Transfer Function 

Non-normalized 

Mathematical equivalent transfer 

function, normalized 

Impedance Area Impedance 
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Admittance Complex Conductivity 

Complex Capacitance Permittivity 

Elastance Modulus 

 

Not all transfer functions can be used without restriction! The permittivity 

can be consistently recalculated to the modulus, and the conductivity. 

However, since for the impedance not the specific impedance is chosen as the 

normalized function, but the area impedance, the Impedance transfer 

functions produces invalid values when used with 𝜀-only spectra. 

If area and thickness metadata for a spectrum is known, it can be transformed 

into an 𝜀-only spectrum. To do this, click the Dielectrics → Convert to 𝜺-only 

spectrum button from the main menu. The Dielectrics tab is only visible, if the 

dielectrics functions are enabled in the settings. In the dialog, you can choose 

to override the individual area and thickness metadata of the spectra, and you 

have to select the correct unit for the area and thickess. The function then 

recalculates the impedance values stored for the spectrum, such that the 

complex capacitance values are now permittivity values. It will also mark the 

new spectra as 𝜀-only spectra. 

The dielectrics menu also allows the conversion of 𝜀-only spectra to normal 

spectra, if the cell parameters are known. The conversion works just as 

described above for the opposite direction. 

You can use the Data and Quality → Change Metadata dialog, to mark spectra 

in the Spectra Explorer list as 𝜀-only. 

A typical workflow could be 

1. Import regular dielectric data (with cell geometries) 

2. Import e.g. a waveguide measurement. A textfile contains columns 

Freq|eps’|eps’’ 

a. Use the Unknown File Dialog, mark the Eps columns as C’ and C’’ 

respectively 

b. Select the imported spectrum in the Spectra Explorer list 
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c. Select Data and Quality → Change Metadata → Metadata type: 

Spectrum Type → 𝜀-only 

d. Note, that the Data Explorer graph now shows e.g. 𝜀 instead of C 

3. Select the regular dielectric spectrum, convert it into an 𝜀-only spectrum 

by using Dielectrics → Convert to 𝜀-only spectrum 

4. Select both 𝜀-only spectra and merge the data by clicking Data and 

Quality → Merge Spectra (see 6.10.3). 

This will create a combined 𝜀-only spectrum of your regular and waveguide 

data. 

6.10 MODIFYING RAW DATA 

RelaxIS allows you to change the raw data of a spectrum in various ways, once 

it is loaded in a project. Please note, that the source files on your hard drive 

are entirely unaffected by these changes, and you can restore the original data 

by reimporting the data file into the project. The changes to the raw data of 

the loaded spectra is however mostly irreversible, so please take care and 

critically evaluate any changes in regard to the integrity of the spectra. 

6.10.1 RAW DATA EDIT 

The Raw Data Edit dialog can be accessed using the Edit raw spectrum data 

button in the Data and Quality tab. It allows you to directly manipulate or 

recalculate the data stored for the spectrum. 
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You can use the table to change the value of each data point by simply 

selecting the corresponding cell and entering a new value. 

Jump or select data points by clicking on them in the graph. Hold CTRL while 

clicking to select multiple points at once. 

You can delete data points by clicking on the respective row header (or on the 

data points) and pressing the Delete key on your keyboard. This, for example, 

allows the elimination of outliers, such as a 50 Hz artifact. 

Furthermore, it is possible to recalculate whole columns using an arbitrary 

formula that you can enter in the textbox in the top-middle. 

The formula can contain numbers, mathematical functions like sin(), cos() or 

exp() or various variables. A list of functions can be found in the appendices. 

Aside from some special occasions the variable V usually corresponds to the 

source value, in this case either to the frequency, Z’ or Z’’, depending on the 

selected radio button below the textbox.  

Other variables include the active spectrums metadata and can be found by 

clicking the ? button next to the textbox. 
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 Please note 

All variables are case sensitive and need to be entered exactly as noted in 

the help text. 

 

Some examples are: 

Formula Result, Use Case 

V*-1 Invert the selecting value, e.g. for negating the imaginary 

part 

V/A Divide the value by the spectrum’s area, e.g. for reverting 

an area normalization in the source data 

 

You can reset the changes done in the CURRENT SESSION of the data edit, by 

clicking the Undo button. 

 Please note 

Once you accept the changes using the OK button, the changes cannot be 

undone! You need to reimport the data from the original source file to get 

the original state back. 

 

6.10.2 MODEL SUBTRACTION 

RelaxIS allows you to subtract the calculated impedance values of a model 

from the data of your spectra. This sometimes allows the elimination of 

influences of unwanted processes from the spectrum and can probably allow 

the evaluation of underlying processes. You can access this feature using the 

Subtract a Model button in the Data and Quality tab. 
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Click the button at the top-right to select a model to subtract. Please refer to 

chapter 8 for details on how to design a model. 

Afterwards enter the parameter values for the model or copy & paste values 

from the Parameter Explorer. In addition to entering raw parameter values you 

can also enter formulas for the parameters directly into the respective fields. 

Formulas allow you to refer to element values indirectly, which is especially 

useful when subtracting model values from multiple spectra in one step. Click 

the information button for a list of variable names that may be used in the 

formulas. 

Finally, you need to select if you want to subtract the model in serial or parallel. 

In case of subtracting in serial the impedance will be subtracted as  

 ( ) ( ) ( )ˆ ˆ ˆ
new old modelZ Z Z  = − .   

In case of subtracting in parallel the impedance will be subtracted as 

 
( ) ( ) ( )

1 1 1

ˆ ˆ ˆ
new old modelZ Z Z  

= −  .  

This allows you to subtract elements depending on how you define their 

influence on the data. 



Data Management 

 

39 
 

Often you need to subtract parts of a model one after another in multiple steps 

in order to achieve your goal. You can’t just subtract any single element from 

any model! 

Some examples are: 

Assumed data model Desired data model Required operations 

  

Subtract Resistor 1 in 

series 

 

 

Subtract Resistor 1 in 

series, afterwards 

subtract Capacit. 1 in 

parallel 

  

Impossible! You could 

only subtract Resistor 1 

and Warburg 1 together. 

 

6.10.3 MERGING SPECTRA 

RelaxIS allows you to merge multiple spectra into one. In order to do this, 

select Merge spectra from the Data and Quality tab of the main menu. The 

option dialog allows you to choose,  

• If only active data should be included in the new spectrum. 

• If equal frequencies in the spectra should be merged into one by either 

averaging their Z’ and Z’’ values or summing them. 

• If the originating spectra should be removed from the project. 

Afterwards, use the Spectra Selection dialog to select the spectra you want to 

merge if dialog selection is enabled, otherwise the currently selected spectra 

are merged. If you choose not to average the same frequencies, the merged 

spectrum will contain multiple data points with the same frequency. 
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7 DATA QUALITY ASSESSMENT 

7.1 THE LINEAR KRAMERS-KRONIG TEST 

7.1.1 INTRODUCTION 

The KRAMERS-KRONIG relations under certain conditions allow the calculation of 

the real part of the impedance from the frequency and the imaginary part, or 

of the imaginary part from the frequency and the real part. 

For this to be possible, the data needs to fulfill certain rules: 

• Causality: The system response may only be caused be the sinusoidal 

excitation. 

• Linearity: The excitation must be mild enough that the system response 

is linear only. 

• Stability: The system response must not change with time while the 

excitation is applied. 

The derivation of the common formulas for most models, and equivalent 

circuits in particular, are all based around the idea that these rules are valid. 

If a system does not follow these rules an evaluation using such models is 

usually not suitable. 

KRAMERS-KRONIG-tests are based around this idea. One tries to transform the 

real- into the imaginary part or vice versa and compares the result with the 

actual spectrum. If they match, then the measurement is trustworthy and can 

be evaluated. If not, the measurement parameters should be critically 

reviewed. 

Problems arise from the formulation of the relations. For the calculation, 

integrals from zero to infinity over the frequency must be solved. This 

frequency range is obviously not accessible in the measurement. Therefore, 

the data needs to be extrapolated in some way. This extrapolation step is the 

main reason why different implementations of the KRAMERS-KRONIG-test 

usually lead to different results, especially since details about the 

implementation are often not fully disclosed. 



Data Quality Assessment 

 

41 
 

The KRAMERS-KRONIG-Test in RelaxIS is based on two methods described by 

BOUKAMP et al. (J. Electrochem. Soc. 1995, 142, 1885-1894). In this method, the 

data is first modelled by a long series of (R)(C) elements. You can use as many 

of these elements as there are data points. Since a chain of (R)(C) elements 

follows the rules above one may derive the fact that if the data can be 

described by the chain it also follows the rules. The method furthermore 

linearizes the problem by introducing a fixed set of relaxation times R C =   

for the elements. This simplifies the procedure because the problem can be 

broken down to a linear fit. 

 

 

RelaxIS implements two methods: A Complex Fit that fits both real and 

imaginary parts simulatenously and can contain a series capacitor and 

inductor in addition to the (R)(C) chain, and a Partial Fit, that fits either the 

real or imaginary parts separately. 

In the Partial Fit, RelaxIS first performs the linear fit on either the real or the 

imaginary part of the spectrum. The linear fit describes this part perfectly, if 

the number of time constants is equal to the number of datapoints, and yields 

a set of resistances for the (R)(C)-elements. This set is used to calculate the 

other part directly. The calculated part is then compared with the measured 

data. 

The Complex Fit is more like a normal EIS fit, in that it fits a model to both the 

real and imaginary parts simultaneously. However, it does so by also using the 

pre-defined set of time-constants which simplifies to fit to a linear system. 

From the results of the linear fit, both real and imaginary parts can be 

calculated and compared with the data. 

The times-constants are chosen logarithmically in the frequency range of the 

measurement. It is often favorable to use less time constants to lessen the 
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impact of random noise on the simulation, also called overfitting. The 

number of time constants and therefore of (R)(C)-elements can be chosen 

freely up to a maximum equal to the number of datapoints. 

To minimize the effects of overfitting, RelaxIS implements an automatic 

determination of the optimal number of time constants, using a method by 

SCHÖNLEBER et al. (Electrochim. Acta 2014, 131, 20-27). Overfitting is often 

apparent in the appearance of negatice resistances in the (R)(C) elements and 

can be quantified by the 𝜇-statistic. The nearer 𝜇 is to 1, the less overfitting 

occurs. With increasing number of time constants, 𝜇 drops sigmoidally to zero. 

The number of time constants where 𝜇 passes through 0.5 is chosen as the 

optimal number. 

 Please note 

We suggest that you use the Complex Fit with included capacitor and 

inductor and automatic determination of the number of time constants. 

 

7.1.2 USING THE LINEAR KRAMERS-KRONIG-TEST 

After selecting a spectrum use the Kramers-Kronig Test button on the Data 

and Quality tab of the main ribbon bar.  
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After opening the dialog, a KRAMERS-KRONIG-Test is automatically performed 

once with default settings. If you alter any settings you need to manually click 

the Update simulation button for the settings to take effect. 

On the left side of the dialog you can alter several settings: 

• Select the type of plot to show in the graph. 

• Select the Algorithm to use: Complex Fit or Partial Fit 

• For Complex Fit: Under Calculation options choose to include a series 

capacitor and/or inductor in the fit. 

• For Partial Fit: Calculation mode allows you to choose if you want to 

calculate Z’ from Z’’ or vice versa.  

• Number of time constants allows you to decide how many (R)(C) 

elements should be used for the linear fit. Select Automatic to perform 

the automatic determination based on 𝜇. You can calculate a 𝜇 vs. 

number-of-𝜏 plot by clicking the 𝜇 number in the status bar. 

• Amount of data to use allows you to use only a certain percentage of 

the data points for the fit and to limit the frequency range to the limits 

set for the spectrum. 

When the Complex Fit is used, the option is given to perform the simulation 

in the admittance instead. In that case, the input data is converted into the 

admittance, which in effect causes the simulation to fit parallel connected 

series RC elements, e.g. (RC)(RC)…, where each RC element has a preselected 

time constant. This option is useful in cases where the impedance data reaches 

into e.g. the 2nd complex quadrant (negative real parts). To fit this, negative 

time-constants would be required in the impedance case, while the admittance 

case still fits with only positive time constants. Details are described in 

Boukamps paper cited above. 

In the “Amount of data to use” box, you can furthermore change the current 

frequency limits of the spectrum by clicking on one of the four left/right 

buttons. The two buttons on the left change the lower frequency limit while 

the two rightmost buttons change the upper frequency limit. The left-arrow 

changes the respective limit to lower frequencies, while the right-arrow button 

changes it to higher frequencies. 
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Use the residual, histogram or CDF plots to evaluate how well the simulated 

data matches the measured data. The latter two plots are calculated for the 

absolute residuals. 

You can calculate Shapiro-Wilk-Normality tests for all residuals by clicking 

the Shapiro-Wilk-field in the status bar at the bottom of the window. 

You can work with the results in multiple ways: 

• Export the result data via the typical export dialog 

• Store the result in the Result Library of the current project folder 

• Create a new spectrum from the simulation and add it to the current 

project. You can use this new spectrum like any other spectrum, e.g. fit 

it with a model. 

 Please note 

The Kramers-Kronig-Test can only be performed on the impedance!  

Don’t immediately dismiss data if it shows deviations from the simulated 

data! The linear method has limitations just like other extrapolation modes. 

If no series capacitance is included in the fit, electrode polarization effects 

or Warburg behavior may skewer the results, since they rise to infinity at 

very low frequencies. The same is true for inductivities.  

Hence why we suggest that you use the Complex Fit because it can describe 

such effects as well.  

Only some parts of spectra may be invalid. The KK-Test may find such 

problematic frequency ranges. Avoid using too many time constants to avoid 

overfitting artifacts in the data! 

 

7.1.3 KRAMERS-KRONIG VIEW 

A Kramers-Kronig test can be permanently shown in the RelaxIS user interface 

by means of the Kramers-Kronig View. To show it, select Plotting → Create 

new spectrum view → Kramers-Kronig View from the main menu. 

The view by default uses the following settings: 

• Algorithm: Complex Fit incl. series capacitor & inductor 
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• Automatic number of time constants 

These settings can be adjusted using the Settings button in the left menu 

(extend with the arrow button). 

The simulation only uses the active spectrum data. 

The result of the Kramers-Kronig simulation is shown as a red line (in case of 

default plot styles) on top of the impedance data. The plot uses the same plot 

settings as the Data Explorer and can be changed likewise. 

Using the menu to the left (extend with the arrow button) you can show results 

of a Shapiro-Wilk normality test of the simulation’s rediduals. This also 

displays the maximum relative residuals. 

7.2 DRT: DISTRIBUTION OF RELAXATION TIMES 

The relaxation time of an (R)(C) circuit is given by 𝜏 = 𝑅𝐶. If an impedance 

spectrum is modelled by an infinite sum of (R)(C) elements and the time 

constants for each is analysed statistically, the distribution of relaxation times 

is found. That means, that for some time constants a lot of many (R)(C) 

elements are present, while some time constants are not found at all. 

         

This is a layman’s explanation of the DRT theory. For more thorough 

explanations the reader is referred to scientific literature, e.g. DOI: 

10.1016/j.electacta.2015.09.097. 
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If the distribution function can be found for an arbitrary impedance spectrum, 

it will show peaks at time-constants that are physically present in the 

spectrum. This can allow a finer separation of processes and can give answers 

to the question, if certain semicircles should be described by one or more than 

one (R)(C) elements.  

Optimal data for DRT has little noise and has a constant low-frequency limit. 

If the data shows, e.g. diffusion of polarization (a constant rise in Z’/Z’’), the 

DRT can often include nonsensical additional peaks (often at high time-

constants). 

 Caution 

Due to the multitude of different calculation parameters, the DRT method 

can be prone to misinterpretation of the results. We strongly recommend, 

that you first use simulated spectra (e.g. created in the Circuit Simulator, see 

chapter 17) with a known result, like an (R)(C)-(R)(C) circuit with two time-

constants to become intimately familiar with the method. 

 

7.2.1 CALCULATING A DRT 

Open the DRT dialog using Data and Quality → DRT.  

First, select the spectra that you wish to calculate DRTs for and click Next. 

On the Settings page, you can adjust calculation options. 

Data settings allow you to include/exclude real and imaginary parts of the 

impedance. You can also choose to interpolate the data to a given number of 

points. This can improve the resolution of the calculated DRT. 

 Please note 

Interpolation creates data based on the assumption of continuity of the 

points. Especially if the data is noisy or discontinuous, this can lead to 

insensible results. Please use the interpolation option with care! 

 



Data Quality Assessment 

 

47 
 

You can also enable the subtraction of low-frequency polarization data. This 

is done in multiple steps: 

1. A continuous increase of -Z’’ is detected and a suitable number of points 

for analysis is selected 

2. An R-CPE model is fitted to the points 

3. Values for a CPE with the fitted results are subtracted from each 

datapoint in the spectrum 

4. (optional) a number of most affected datapoints may be removed from 

completely from DRT calculation 

This process may reduce of remove pronounced peaks in the DRT at high time-

constants caused by the polarization. 

Calculation settings are the most important settings. The data is discretized 

by a radial basis function, of which you can choose one or more at a time. 

Gaussian discretization is often a very good choice. You can select multiple 

functions and compare the results later. 

 Advice 

For every selected spectrum, the DRT for every selected basis function is 

calculated. 

This can quickly amount to a very large number of DRT calculation, which 

can take a long time. It often makes sense to limit the selected basis 

functions to one or two, instead of selecting all of them. 

 

The Lambda factor is the so-called discretization factor. Lower values lead to 

narrower peaks, thus allowing a better separation of peaks. However, it also 

increases oscillations and can lead to satellite peaks around a process’ peak. 

The noisier the data, the higher Lambda should be chosen. For a known 

distribution function, of e.g. an (R)(P) circuit the effect of Lambda can be 

visualized. 
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Plotted is the deviation of the calculated DRT from the true DRT as a function 

of Lambda and of normal-distributed noise added to the simulated spectrum. 

It can be seen, that Lambda has a minimum at intermediate values. The 

minimum shifts towards higher values the noisier the data is. A value of 10-5 

often shows promising results. 

The RBF Derivative and shape factor also determine the peak shape and 

resolution. 

If the data has an inductive part at high frequencies, this part can be included 

in the calculations by checking the respective box. 

Output settings determine, how many datapoints are calculated of the DRT 

function, and what range is used (Extrapolation factor). 

𝜏𝑚𝑖𝑛 =
1

𝑓𝑚𝑎𝑥
∙

1

𝐸𝑥𝑡𝑟𝑎𝑝𝑜𝑙𝑎𝑡𝑖𝑜𝑛 𝐹𝑎𝑐𝑡𝑜𝑟
 

𝜏𝑚𝑎𝑥 =
1

𝑓𝑚𝑖𝑛
∙ 𝐸𝑥𝑡𝑟𝑎𝑝𝑜𝑙𝑎𝑡𝑖𝑜𝑛 𝐹𝑎𝑐𝑡𝑜𝑟 

You can always click the Preview button. This will allow you to select a 

spectrum and calculate the DRT for it. The first selected basis function will be 

used for the calculation. 
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7.2.2 SPECTRUM REPRODUCTION AND LAMBDA PLOT 

From the DRT, and the fitted series resistance and inductance (found during 

calculation of the DRT) it is possible to calculate an impedance spectrum by 

what RelaxIS termed Zarc-integration. Integrating the DRT of e.g. the spectrum 

of an (R)(C) element over ln (𝜏) the result is the resistance of the (R)(C) element: 

𝑅 = ∫ 𝛾(ln(𝜏))𝑑ln(𝜏) 

RelaxIS calculates a discrete number of time constants of the DRT. To calculate 

back to the spectrum, the DRT is split into a series of Zarc elements with one 

element for each calculated DRT datapoint (minus 1). 

The nth Zarc element has the parameters (for a sorted list of 𝜏): 

𝜏𝑛 =
𝜏𝑛 + 𝜏𝑛−1

2
 

𝑅𝑛 = 𝐴𝑏𝑠(𝑙𝑛(𝜏𝑛) − 𝑙𝑛(𝜏𝑛−1)) ∙
𝛾𝑛 + 𝛾𝑛−1

2
 

𝛼 = 1 

The impedance at frequency f is then given by 

𝑍(𝑓) = 𝑅𝑠𝑒𝑟 + 𝑖𝜔𝐿𝑠𝑒𝑟 + ∑ 𝑍𝑎𝑟𝑐(𝑓, 𝑅𝑛, 𝜏𝑛, 𝛼 = 1)

𝑛

 

By calculating the impedance from the sum for each of the initial input 

frequencies of the spectrum, the spectrum reproduction is found. 

As mentioned above, the influence of the Lambda parameter can be estimated 

by comparing the calculated DRT with the analytical DRT of e.g. an (R)(P) 

element. For a real spectrum however, the analytical DRT is unknown. An 

alternative is to reproduce the initial spectrum with the given method and 

compare the reproduction with the source spectrum. This can be done by 

calculating the sum of squared residuals, SSR, between the two spectra. 

RelaxIS offers the Lambda Plot function, that calculates this SSR for a series 

of values for the lambda parameter. This lets you inspect the influence of the 

quality of the reproduction as a function of lambda. 
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Usually you will find that the SSR first decreases with decreasing lambda until 

it reaches a point where the improvement is no longer significant. This is in 

contrast to the comparison of the calculated DRT with the analytical DRT 

above, where the quality started to decrease again at lower lambda values, due 

to increased osciallations and ghost peaks, which apparently do not actually 

lead to a decrease in quality of the reproduction. 

 Please note 

While the lambda plot usually shows a sigmoidal or exponential decrease it 

should be noted that this method here is purely empirical. You may be able 

to find a more reproducible way of selecting lambda from the plot, but this 

selection is not immediately based on a physical understanding! 

 

What that effectively means is that the same spectrum can be described by 

multiple DRTs, which is similar to the often-established problem of equivalent 

circuits, where multiple different models can fit the same spectrum. 

To create the Lambda Plot, click the Lambda Plot button on the settings page. 

This lets you select a spectrum to perform the calculation for and then shows 

the Lambda Plot dialog. 

 

Here, first select the basis function to perform the calculation with. The other 

calculation parameters are taken from the settings page. 
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The you can define the range of lambda values to use. The dialog takes the 

values in logarithmic spacing, and hence lets you select the base-10 exponents 

of the minimum and maximum values of lambda, as well as the step width. 

Please note, that a DRT has to be calculated for each point, so you should keep 

the number of points at a reasonable amount. 

After the selection, use the Calculate button to create the lambda plot. 

The data may be exported by using the graph’s raw data export function, 

accessible through the right-click menu on the graph. 

7.2.3 DRT ANALYSIS 

Once you are satisfied with your selected options on the Settings page, click 

the Next button to start the calculations. 

The Results page displays the calculated DRTs for a single spectrum, and can 

overlay all calculated basis function. Select the spectrum to display from the 

dropdown menu at the top-left. 

You can select the value displayed on the X-axis by selecting it from the box 

above the result graph. The available X-axis values are time constant (tau), 

frequency and angular frequency. 

To create a result overlay for multiple spectra, click the ”Show DRT result 

overlay plot” button. Here, you can select which spectra to include in the plot 

by activating or deactivating the check mark next to it. You may also include 

the picked peaks in the plot. Use the X-axis box to select the x-axis value in 

use, as explained above. 
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To close the dialog, click the red X button, or the Back button. 

You can perform further analysis of the DRT, such as peak picking or 

integration. First select active basis functions from the respective dropdown. 

Only active basis functions are included in the evaluations. 

For analysis, you can Pick Peaks by selecting a lower limit for peak height. Use 

the mouse to drag the green bar in the result plot to change the minimum peak 

height, or enter a value into the respective box. Note: The minimum peak 

height is set individual per analyzed spectrum, which means that peak 

picking on the results for different discretization functions will use the same 

minimum height. De-/Activate results for individual discretization functions 

from the drop-down menu to use individual minimum heights, since peaks are 

picked only on active functions (e.g. activate a single result, change min. 

height, pick peaks, then deactivate this one and select another function and 

repeat the process). Peak picking will not find saddle points! A maximum of 

50 peaks per discretization function applies. You can disable the green min. 

height line by using the Hide checkbox (e.g. for the graph image export). 

Refine Peak Positions will take the found peak point, and its two neighbors 

and fit a second-degree polynomial to these points. The polynom’s extreme 

value is then used as the refined maximum. Please note: In some cases, e.g. 
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when two peaks lie very close together with just one point in between, this can 

lead to an outlier. 

You can limit the peak picking to areas in the graph chosen for integration (see 

below). Peaks that are not within a yellow integration area are discarded. 

You can integrate peaks, but defining areas in the chart. 

• Each spectrum has individual areas, that need to be defined separately. 

• For one spectrum, areas are shared between all basis functions. 

To define an area, click New Area. A new yellow area appears on the graph. 

The new area is created in the middle of the current X-Axis scale of the graph. 

Drag the blue arrows on the chart to move and resize the area. 

By clicking the Assign current areas to all spectra button, the areas of the 

currently selected spectrum are applied to all spectra in the calculation results. 

This will overwrite all areas you may have already assigned to other spectra! 

Once you have defined all evaluation options to your liking, click the Next 

button to get a tabular list of all further evaluations. 

In contrast to the previous page, the Evaluations page combines the results 

for all spectra but for a single basis function into one set. Select the basis 

function from the dropdown at the top-left. 

The Peaks list shows the peaks picked on each of the spectra, sorted by time 

constant. Empty cells may appear if some spectra have less peaks than others. 

The Integrals list shows the middle tau of each area and it’s integral for each 

spectrum, sorted by middle time-constant. Empty cells may appear if some 

spectra contain less areas than others. 

The peak time-constants show at which time constant a corresponding (R)(C) 

element would have its maximum frequency. The peak integral is a measure 

for the resistance of this (R)(C) element. This can be very well tested by 

calculating a spectrum of one or multiple (R)(C) elements using, e.g., the Circuit 

Simulator (chapter 17) and comparing the values. 
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From the Evaluations page, you can export either the tables, but also raw data 

for the DRT plots. Click the Export button to on the Evaluation page to start. 

Next, select which spectra and basis functions should be contained in the 

export, as well as if the exported columns are grouped by spectrum or basis 

function. After clicking Ok, you can further define the contents of the export 

in the Export contents dialog. Note, that per default both the spectrum data, 

the DRT data as well as the reproduced spectrum data are exported. 

7.2.4 THE DRT VIEW 

A DRT test can be permanently shown in the RelaxIS user interface by means 

of the DRT View. To show it, select Plotting → Create new spectrum view → 

DRT View from the main menu. 

The DRT is calculated for the currently selected spectrum and plotted in the 

view. 

Using the Settings button in the menu on the left (extend using the arrow 

button) you can show a dialog that allows you to select the calculation settings 

of the DRT. Please refer to the descriptions above to learn more about the 

meaning of the available settings. 

7.3 ZHIT 

The ZHIT algorithm is similar to the Kramers-Kronig transformation in that it 

allows you to calculate the modulus of the impedance from its phase-angle. It 

has the great advantage over KKT in that the calculation doesn’t need to 

integrate over the full frequency range from 0 → ∞, so an extrapolation is not 

required.  

In practice, the algorithm is performed in four steps: 

1. The phase-angle data is smoothed over the (natural) log(f) 

2. The smoothed data is spline-interpolated 

3. |Z| is calculated at each original frequency point by a combination of 

integration and differentiation to and at the original frequency 

4. A |Z| offset is determined by a linear fit 
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For further details regarding the mathematical background, you can refer to 

original literature: 

• C. A. Schiller, F. Richter, E. Gülzow, N. Wagner, Phys. Chem. Chem. Phys. 

2001, 3, p. 374–378. 

• W. Ehm, R. Kaus, C. A. Schiller, W. Strunz in F. Mansfeld, F. Huet, O. R. 

Mattos: “New Trends in Electrochemical Impedance Spectroscopy and 

Electrochemical Noise Analysis”, Electrochemical Society Inc., 

Pennington, NJ, 2001, vol. 2000-24, p. 1–10. 

Step 4 is performed, because the result will have an arbitrary offset in |Z|. This 

is corrected by a linear fit so the offset between simulation and data is 

minimal. This linear fit may be weighted, if the respective option is enabled. In 

most cases, not much difference should be noticeable. 

7.3.1 SMOOTHING 

RelaxIS offers three different algorithms for smoothing of the input data: 

LOWESS, LOESS and Savitzky-Golay. Each of the algorithms has a “Smoothing 

factor”, g, as its input, that determines the amount the data is smoothed. For 

a dataset of n points, the smoothing factor defines how many points, z, are 

selected for smoothing around a given datapoint, with 𝑧 = 𝑛 ∙ 𝑔. The algortihms 

typically calculate a linear or polynomial fit through this data and interpolate 

to the point-to-smooth. The Savitzky-Golay algorithm expects evenly spaced 

points to function correctly. If your data is not evenly spaced in log-frequency 

space, deviations may occur. 

We recommend the LOESS algorithm 

7.3.2 INTERPOLATION 

The smoothed data is interpolated using a spline. Various types of splines are 

available. As can be seen in the image below, you can note that different splines 

react differently at points of sudden changes.  
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We recommend using Akima splines, as they typically follow the “intended” 

curve quite nicely in the case of impedance data. 

7.3.3 CALCULATING THE RESULTS 

After selecting the desired options, click the “Update simulation” button to 

recalculate the result. Both the simulation in a Bode plot as well as the 

residuals in |Z| are displayed. The Bode plot contains the original data, the 

smoothed and interpolated Phase Angle plots, and the simulation result. 

You can work with the results in multiple ways: 

• Create a new spectrum from the results and add it to the current project. 

This spectrum can be used like any other, e.g. fitted. 

• Export the results using the normal export dialog 

• Store the results in the Result Library 

• Use the currently selected options to calculate the ZHIT result for 

multiple spectra. This creates a spectrum from each simulation and 

adds it to the current project.  
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7.3.4 ZHIT VIEW 

A ZHIT simulation can be permanently shown in the RelaxIS user interface by 

means of the ZHIT View. To show it, select Plotting → Create new spectrum 

view → ZHIT View from the main menu. 

The view by default uses the following settings: 

• Smoothing: LOESS (smoothing factor 0.1) 

• Interpolation: Akima 

• Enable offset weighting 

These settings can be adjusted using the Settings button in the left menu 

(extend with the arrow button). 

The result of the ZHIT simulation is shown as a red line (in case of default plot 

styles) on top of the impedance data. The plot uses the same plot settings as 

the Data Explorer and can be changed likewise. 

Using the menu to the left you can show results of a Shapiro-Wilk normality 

test of the simulation’s rediduals. 

This also displays the maximum relative residual in the data. 
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8 PLOTTING DATA 

The Data Explorer window always shows the currently selected spectrum. By 

default, the Nyquist Plot of the Impedance is shown here. The plot contains 

the data points of the spectrum, as well as an always up-to-date plot of the 

spectrum’s current fit (meaning a plot of the spectrum’s model, using the 

spectrum’s current parameter values). Whenever you change a parameter 

value, the plot is updated to reflect the changes. 

You can open additional plot and information windows from the Plotting 

menu, as will be described further down. 

8.1 GENERAL GRAPH FUNCTIONS 

These points apply to all graphs you encounter in RelaxIS or its other 

components. 

8.1.1 THE CONTEXT MENU 

Right-clicking in the graph opens the context menu where you can select the 

actions performed by the left mouse-button and various other functions. 

1. There different modes for the left mouse-button: 

a. Zoom allows you to left-click and drag a box on the graph and 

zoom in onto this area. At all times, you can also use the mouse 

wheel to zoom in and out. 

b. Drag allows you to left-click and drag the currently shown part of 

the graph to a different area. 

c. Draw circle/line allows you to draw lines and circles onto the 

graph. This feature is only used for the Data Explorer graph for 

initializing fits and will be explained in chapter 10. 

d. Draw annotation allows drawing an arrow with a textbox into the 

graph. If the arrowhead is near data, information about these 

points can be automatically added to the textbox. 

e. Drawing objects allows adding shapes like lines and textboxes to 

the graph for illustrations. Right-click on the blue mouse handles 

to access styling options for each object. 
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f. In every mode, you can always use the middle-mouse button to 

drag the graph. 

2. Graph Layout Options allows customizing the graph’s appearance and 

will be further explained below. 

3. Set Axis Limits allows settings specific minima and maxima for the axes. 

4. Zoom out once takes back the last box zooming step. It does not affect 

the mouse-wheel zooming directly but removes any additional zoom 

between the current state and the last box zoom step. 

5. Reset zoom returns the view to the autoscaled values. 

6. Remove all objects removes all drawn lines and circles. 

7. Export graph image lets you export the current view of the graph into 

an image in the Windows clipboard or to a file. This will be explained in 

more detail in the next section. 

8. Export graph raw data allows exporting the raw X/Y data of all data 

curves currently displayed on the graph in the TSV format. 

Per default the graph’s legend is minimized. Move the mouse cursor over it to 

expand it. After a graph was selected by clicking on it, the hotkey Ctrl+L can 

be used to permanently show and hide the legend. 

8.1.2 GRAPH LAYOUT OPTIONS 

To customize the graph’s appearance, right click any graph and select Graph 

Layout Options. The options are organized on multiple tab pages. 

General Layout gives the following options: 

Scaling factor is the overall scaling of the graph. If set to e.g. 2, all elements 

are rendered twice as large. 

Show graph message allows hiding of the graph message. 

Scale X/Y1 axes proportional enables or disabled the proportional scaling of 

these two axes. Proportional scaling means, that the minima and maxima of 

the axes are scales, such that the value/pixel ratio of them is the same. 

Show inactive axes causes, if disabled, that axes without data are not drawn in 

black. 
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The Chart Area Layout tab gives the following options: 

Chart title allows you to set a title that is displayed at the top of the graph. 

Inner Chart Area Border allows increasing or descreasing the width of the 

borders around the inner chart area. 

The Legend tab gives the following options: 

Show legend allows hiding the legend altogether.  

If Keep legend open is enabled, the legend will not be minimized if the mouse 

leaves its area. 

Set legend title – if enabled – allows you to change the title text of the legend. 

It supports advanced formatting, as described below. 

Legend position allows you to change the position on the chart, where the 

legend is displayed. Click on one of the green squares to set the position. 

The Axis Layouts tab is itself divided into three identical pages for each of the 

three axes of the graph. On each page, you have the following options: 

Title allows overriding the title of the axis. The title supports advanced 

formatting as described below. 

Font size allows settings the font size of the title and of the tick labels. 

Ticks allows you to set the number of major (long, labeled) and minor (short, 

not labeled) ticks displayed on the axis. The number for minor ticks refers to 

the number of minor ticks between each two major ticks. 

Show gridlines allows enabling or disabling drawing of the gridlines for the 

axis. Show origin line does the same, but for the line at the zero-value (or one, 

if logarithmic) of the axis. 
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 Please note 

Since several characteristics of graphs are set by templates in RelaxIS, e.g. by 

the different plot preset plugins, the settings on the Graph Layout dialog 

may be volatile and be overridden at certain events. The settings are 

intended to e.g. customize the graph for exporting as an image. 

 

8.1.3 ADVANCED TEXT FORMATTING 

The axis titles and the text in the legend support advanced formatting. This 

means text can be printed bold, italic or underlined, as well as using the 

Symbol font, e.g. for greek letters. Text can also be defined as sub- or 

superscript text. Advanced formatting can be applied from the Graph Layout 

Settings dialog, or during the export of the graph as an image. 

The formatting is applied by using several format tags. Each tag starts with a 

backslash \ character, followed by a single-letter identifier and a set of 

brackets (). The text to apply the format to is put into the brackets. Tags can 

also be nested to apply multiple formattings. 

The available tags are: 

Tag Meaning Example Example Result 

\b() Bold \b(Test) Test 

\i() Italic \i(Test) Test 

\u() Underline \u(Test) Test 

\x() Strike-Through \x(Test) Test 

\+() Superscript Just a \+(Test) Just a Test 

\-() Subscript Just a \-(Test) Just a Test 

\g() Symbol It’s sigma: \g(s) It’s sigma: 𝜎 

 

In addition to using the tags directly, an interface is provided: 
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E.g. in the Graph Layout Settings dialog click the “…” buttons to show the text 

input dialog. Enter the text in the textbox in the center. At the bottom, you will 

see a preview of what you entered. You can use the various buttons to insert a 

tag fo the respective style. If you select text and the click a button, the tag will 

be inserted surrounding the selected text. To enter symbols, you can use the 

“Special Character” button to show a list of special characters. Double click a 

symbol to place it in the list of symbols to insert. Click “Insert” to place the 

selected symbols at the current cursor position in the text input dialog. 

8.1.4 EXPORTING THE GRAPH AS AN IMAGE 

When you select to export the graph as an image from the context menu you 

will be presented with the Graph Export dialog. 

To customize the export, you have the following options: 

1. Select a size for the image.  

a. You can use pre-defined sizes or enter your desired size by 

selecting the corresponding radiobutton and entering the values 

for width and height. 

b. If you select the checkbox to apply the size to the inner chart area 

the size defines the size of the inner rectangle of the graph and 

the overall image will be larger.  

Please note: The box size may vary by a few pixels due to scaling 

details. 

2. If larger sizes than the current graph size is chosen, the graph’s scaling 

factor is changed to keep the graph elements in proportion. This can be 

disabled with the “Scale graph elements” option. By default, the 
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elements are also only scaled up. Alternatively, you can set a fixed 

scaling factor to keep the layout of the image independent of the source 

graph size. 

3. Enabling White background sets the graph background to white, making 

it more compatible and easy to print. 

4. You can override the titles displayed on the axes by enabling and 

entering text into the respective textboxes. 

5. You can force the graphs legend to be open on the exported image. 

6. You can adjust the titles of each series that is displayed in the legend. 

7. You can define if you want to export the image to the Windows 

clipboard, to a PNG file or to an SVG vector image file. 

Once you set the desired options, click Export to export the graph into the 

format of your choice. Afterwards click the Close button to close the export 

dialog. 

It is possible to export the image as an SVG vector graphic by selecting the 

respective format box. How vector graphics look is up to the viewing software, 

because a vector image is just a text-based description of the graphic’s 

contents (as compared to bitmap images, that tell the exact color of each 

point). While we strive to make the SVG image as identical to the source as 

possible, due to some incompatibilities in the creation of the SVG as well as in 

the reproduction of the image by your SVG viewing software some differences 

may occur.  

8.1.5 GRAPH RAW DATA EXPORT 

Every graph supports the export of the raw data that is currently displayed on 

it. You can select this function with the Raw Data Export button on the graph’s 

context menu. 

You can select the export target (clipboard or a textfile) and the contents of 

the export. 

An important setting is what happens with logarithmically plotted values, as 

for example in BODE-plots. In the Bode-plot, the frequency is plotted 

logarithmically by default. This means, that the plot’s raw data contains the 
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actual logarithms. For the main graph in the Data Explorer window RelaxIS 

offers the option (Main→Settings→General Options→Graph axis number 

format) to show the original number instead which changes the linear looking 

axis to the commonly known logarithmic style. This is illustrated in the 

following images: 

 

 

Whenever the latter is used, it may make sense in the Raw Data Export to also 

enable the export “As original number”. In this case the export will contain 10x 

instead of x for each value in the respective column. If the former number style 

is used from the Settings dialog, this export option will have no effect. 

 

8.2 SPECIAL OPTIONS FOR THE DATA EXPLORER GRAPH 

General plot display options can be selected in the Miscellaneous section of 

the Plotting tab of the main ribbon: 

• Show gridlines toggles the display of helper lines in the plot. 

• Equal axes scaling causes the X and primary Y axes to be scaled 

symmetrically. This means that the shown data ranges are adjusted such 

that the dValue/dPixel-quotient is equal. In Layman’s terms, data 

representing a circle will be shown as a circle and so on.  

 Please note 

Whenever you encounter weird looking plots, especially with 

logarithmically scaled axes, please check if this option is still enabled. 

 

• Only zoom to data causes the autoscaling function of the plot to only 

take the spectrum’s data points into account while ignoring the fit curve 

drawn alongside it. This is enabled by default, since – especially before 
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a fit is performed – the fitted curve often lies way off the interesting 

data and makes the graph confusing. 

8.3 AXIS VALUES 

The Data Explorer plot can be fully customized to show the information you 

prefer. What is shown on each axis is defined by selecting an axis value (that 

is calculated from each complex value of a data point). You can create different 

axis values using the RelaxIS SDK. The calculation process for data on the plot 

is visualized in the following diagram. 

 

 

 

The axis values provided by RelaxIS are: 

Value Explanation 

Real part The real part of the intermediary number 

Imaginary part The imaginary part of the intermediary number 

Negative imaginary 

part 

The imaginary part multiplied with minus one 

Magnitude The magnitude of the intermediary number 

Frequency The frequency of the data point 

Phase angle The phase angle (or argument) of the impedance 

Angular frequency The angular frequency 2 f =  of the data point 

Empty Shows no value on this axis 

 

8.4 CHANGING AXIS VALUES 

You can change the values shown on each axis in the Data Explorer window by 
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1. Clicking one of the 3 Axes display options buttons in the Plotting tab. 

2. Double-clicking one of the axes directly in the plot. 

You will be presented with a dialog listing all available axis values. Select a 

value and click OK. 

Furthermore, you can choose to plot the respective axis logarithmically by 

selecting the corresponding checkbox in the dialog. 

 

8.5 PLOT TEMPLATES 

Plot templates combine a set of axis values and additional graph options to 

produce commonly used plots like the Nyquist or Bode plot. Plot templates 

can be created using the RelaxIS SDK. They also take the currently selected 

transfer function into account. For example, the Nyquist plot uses the negative 

imaginary part for the impedance, but the non-negative imaginary part for the 

admittance.  

The three plot templates available in RelaxIS by default are: 

Plot name Description 

Nyquist • X-Axis: Real part 

• Y1-Axis: (Negative) imaginary part 

• Y2-Axis: Empty 

• Same axis scaling 

Bode • X-Axis: Frequency (logarithmic) 

• Y1-Axis: Real part (logarithmic) 

• Y2-Axis: Imaginary part (logarithmic) 

Bode Phase Angle • X-Axis: Frequency (logarithmic) 

• Y1-Axis: Magnitude (logarithmic) 

• Y2-Axis: Phase Angle 

 

You can change the Data Explorer graph to a template with the Change preset 

button in the Plotting tab. 
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8.6 CREATING AN OVERLAY OF MULTIPLE SPECTRA 

You can display multiple spectra at a time using the Combined Data Plot 

button on the Plotting tab. By default, the Combined Data Plot plots an overall 

of the currently selected spectra in the group.  

The selected spectra, presented in the same graph style as currently selected 

for the Data Explorer graph. That includes axis values and styling. 

The buttons on the left side allow you to switch between plotting the 

currently selected spectra and plotting spectra selected through the 

Spectra Selection dialog. If you disable plotting the currently selected 

spectra, use the now enabled button underneath to select the spectra 

you wish to plot. 

You may also pause automatic updating of the graph using the Pause 

button. 

The plot can be controlled using two configuration dialogs – one for general 

graph options (wrench symbol) and one for data normalization and 

recalculation (calculator symbol). 

In the general graph option dialog, you can select which type of 

graphs (data and or fits) should be included. Fits are always plotted 

as lines but you can choose between different plot types for the data. You can 

furthermore adjust symbol sizes and line width for the plots.  

Furthermore, you can define a format for the automatic legend entries. You 

can create a text containing various tags. All tags start with the # sign and are 

followed by one or more characters indicating the value to be inserted at this 

position in the string. 

The usable tags are: 

Tag Description 

#N The Datasource of the spectrum 

#AX The series’ axis given as “Y1” or “Y2” 
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#AL The series’ axis given as “Left” or 

“Right” 

#AT The current title of the series’ Y axis 

#XT The current title of the X axis 

#G The spectrum’s current model 

#Y The series’ type, being either “Data” 

or “Fit” 

#I The spectrum’s index 

#HASH The literal # (hash) character 

#P A list of available metadata, 

separated by a comma 

#T The temperature metadata 

#DC The DC Voltage metadata 

#AC The AC Voltage metadata 

#FV The Free Variable metadata 

#FV2 The Free Variable 2 metadata 

#A The Area metadata 

#d The Thickness metadata 

#H The Harmonic metadata 

#TM The Time metadata 

#C The Concentration metadata 

#J The Current metadata 

 

Combining these with an arbitrary string can produce the legend text you like. 

Some examples are: 

Legend text Result 

#N (#P) C:\Data\Data.txt (T=20, A=1, d=13.2) 

#N (T=#T°C) C:\Data\Data.txt (T=20°C) 

#T, #DC 20, --- 

#Y #HASH#I, #AT: (#P) #N Default legend format →  

Data #2, Z’ / Ohm: (T=20) C:\Data\Data.txt 
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Even though RelaxIS uses only geometry-dependent transfer functions, the 

Combined Data Plot allows you to plot the normalized transfer functions if 

you provide Area and Thickness values. 

To normalize the data, check the Normalize values checkbox in the 

recalculation settings dialog. If the spectra don’t contain Area and 

Thickness values in their metadata, you can check the override box and enter 

values manually. Please also select the correct units for the values. Metadata 

values are considered to be given in m and m²! 

The dialog furthermore gives you the option to recalculate the X and Y values 

for all datapoints. You can give separate formulas for Y1 and Y2 values. 

 

8.7 SHOWING ADDITIONAL PLOTS 

You can open additional plot windows that can show different plot presets 

alongside the main Data Explorer window. To open a new window select Create 

New Spectrum View→Plot View from the Plotting tab. The window can be 

docked in the main window and will always show the plot of the currently 

active spectrum. The menu on the left allows you to select either a plot preset, 

or individual axis values, just like the Data Explorer. You can also select, if 

gridlines should be shown, as well as scaling options. 

Clicking the Settings button in the menu on the left allows you to adjust 

advanced settings. You can set the window title, as well as the Transfer 

Function that is used for the plot. If you select Globally Selected, always the 

currently active transfer function is used to plot the data. 

Furthermore, you can enable normalization of the data with the geometric 

parameters Area and Thickness. All default transfer functions support 

normalization, but custom plugins may not. This enables you to display plots 

of e.g. conductivity or permittivity. This only works, if the Area and 

Thickness metadata is defined for a spectrum. If it is not, you can choose to 

use globally defined geometric parameters instead. Last, you need to define in 

which unit the Area and Thickness is given, to allow correct calculations. 
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8.8 FIT EXTRAPOLATION 

The Data Explorer and Plot View contain additional series that show the 

current model functions, as will be explained in the following sections. 

Selecting Fit Extrapolation from the Plotting menu, will open the Setup dialog 

on the Display tab, where you can use the Extrapolate checkbox to enable fit 

extrapolation. Instead of calculating the model curve only in the frequency 

range of the data RelaxIS will use the frequency limits set in the text boxes in 

the Setup dialog as the lower and upper limits for the model curves. 

This allows you to check, how the model behaves outside of the data’s 

frequency range, and read off, for example, where a low frequency semicircle 

drops back down to the real axis. 

8.9 3D GRAPHS 

RelaxIS allows you to view 3D graphs of your data. You can select axis values 

for an X, Y and Z axis and RelaxIS will create series for each selected spectrum. 

8.9.1 GENERAL SETUP 

To show the 3D graph, select Plotting → 3D Graph from the main menu. The 

graph with use the currently selected transfer function, so please select it 

beforehand. Use the spectra selection dialog to select which spectra you wish 

to include in the plot if enabled, or the currently selected spectra are used. 

The plot’s axes are arranged as depicted on the right. The 

figure shows the axes in their increasing direction. 

By default, the axis values are selected as follows: 

• X-Axis: Logarithmic frequency 

• Y-Axis: Negative imaginary part 

• Z-Axis: Real part 

This means, that you will see a mix of a Bode and Nyquist Plot, where the 

former is seen in the XY- and XZ-planes, while the latter is visible in the YX-

plane. 
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To set another axis arrangement, click the Settings button on the left. 

Here you can select which value is shown on which axis. Please note, that you 

can select the typical plot values, but in addition you can also select metadata. 

This allows you to e.g. set the temperature to the X-axis and get a staggered 

Nyquist plot with the spectra separated via the temperature. 

Use the checkboxes next to the axis values to select if a value is calculated 

logarithmically. Currently, the graph only supports displaying the actual 

logarithmic values instead of the source values on a logarithmic scale. 

You can also override the axis titles by enabling the respective checkbox and 

entering a title. 

Furthermore, you can influence the styling of the graph by setting point and 

line sizes/width. Setting either to 0 will disable the trace. 

8.9.2 EXPORTING 

You can export the graph as an image by clicking the “Export Screenshot” 

button. The screenshot can be set to the Windows clipboard or saved in a file. 

You can also export the raw data that is currently plotted by clicking the 

“Export” button. By default, three columns per spectrum are created. You can 

also enable the export of all series combined in one XYZ-column set. This is 

helpful if you want to use a different software to create e.g. a surface plot. 

8.9.3 SURFACE PLOTS 

While the implemented 3D graph in RelaxIS does not support displaying a 

surface plot directly, it is still possible to create one. The surface plot is shown 

in an External Browser, because it uses the Plotly.js javascript library to create 

the surface plot. 

First, setup the graph with the axis values you want to see. Please note, that 

for the surface plot datapoints from all series are combined into a single 

dataset, and the surface will be drawn over over it. You can think of the 

datapoints as points measured in a land survey. Scattered at various locations 

in the XZ-plane the height of the ground is measured (Y-values). From this data 
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a surface elevation map is reconstructed. This is then displayed as the 3D 

surface. 

To display the surface plot, click the “Surface Plot” button on the left. The plot 

is colored in a rainbow style, where red symbolizes the highest Y-values and 

blue the lowest. 

You can customize the plot using the Plotly Chart Studio, accessible via a 

button in the top right of the plot. 

 

 Please note 

Using the Chart Studio redirects you to an external site, that may or 

may not process your spectra data. Please use this site at your own 

discretion and review their data privacy policy at: 

https://plot.ly/privacy/ 

 

8.10 CUSTOMIZING THE GRAPH LAYOUT WITH STYLES 

8.10.1 MANAGING STYLE TEMPLATES 

All graphs in RelaxIS are styled according to a style template. The template 

defines the general appearance of the graph like its background color, and the 

appearance of the individual data series plotted on the graph. 

Style templates are managed by the Style Library, accessible via the main menu 

Plotting→Edit Graph Style. 

https://plot.ly/privacy/
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The currently active template is marked with a green background. 

RelaxIS differentiates between built-in default templates of which there are 

three and user-defined templates. The built-in templates are marked with a 

lock symbol because they can not be edited. 

You can create new templates either from scratch by clicking the New button, 

or you can duplicate an existing template by using the Duplicate button. 

User-defined templates can be deleted using the Delete button and edited 

using the Edit button. 

The Import and Export buttons allow easy sharing of style templates. The 

export button saves the style in an .XML file at a specified location, which can 

be shared with other users. They in turn can import the .XML file using the 

import button. 

The list can be refreshed with the Reload Styles button. 

You can apply a style to all graphs in RelaxIS by selecting the style from the 

list and clicking the Apply button. 

The Circuit Simulator 3 also uses the style selected in RelaxIS, but you can’t 

access the style library from CS3. Instead, change or select the style template 

inside of RelaxIS, and the, in CS3, click the Main→Style settings→Refresh 

Active Style button. 
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8.10.2 CUSTOMIZING STYLE TEMPLATES 

To change a user-defined style, select it from the list in the Style Library and 

click the Edit button. 

 

The Graph Style Editor allows you to change all aspects of the template, by 

selecting the option in the list and changing its value to the desired setting.  

The template is divided into different sections: Layouts for data series, layouts 

of axes, and layout of the general graph. 

Values can be numeric, text, colors, fonts or list items. Numeric and text values 

can be typed in directly. Colors can be defined in two ways: By known names, 

e.g. by selecting it from the dropdown accessible via the “V” button when the 

value is selected, or by typing in RGB values separated by a semicolon, e.g. 

13;242;77. The individual values can be 0-255. 
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Fonts can be defined from a font dialog by clicking the “…” button once the 

value is selected. 

List items can be selected from a dropdown, that is accessible wants you select 

the value, similar to the color dropdown. 

 

8.10.2.1 GENERAL SETTINGS 

Setting Meaning Typical value 

Name The name of the style New style 

Description A description of the style A new style 

Gradient bottom-right 

color 

The color in the bottom-right corner of 

the outer region of the graph 

GhostWhite 

Gradient top-left color The color in the top-left corner of the 

outer region of the graph 

LightSteelBlue 

Inner chart background The background color in the inner part 

of the graph 

White 

Axis thickness The thickness of the axis lines, that is 

applied to all axes 

2 

Legend font The font used for the legend  

Stack color list see below  

Cycle stacked plot styles If enabled, stacked plots cycle through 

the various available plot styles. 

 

 

8.10.2.2 AXIS STYLES 

Setting Meaning Typical value 

Axis line color The color of the axis Black 
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Axis title font The font used for drawing the axis 

title 

Tahoma; 20pt 

Title color The color used for drawing the axis 

title 

Black 

Tick label font The font used for drawing the tick 

labels on the axis 

Arial Narrow; 11pt 

Tick label color The color of the tick labels Black 

Gridlines enabled “True” for gridlines enabled, “False” 

for gridlines disabled 

True 

Gridline color The color of the gridlines Silver 

Gridline style The style of the gridlines Dash 

Gridline thickness The thickness the gridlines  1 

Origin line enabled “True” to enable the line through the 

axis origin, “False” to disable  

True 

Origin line color The color of the origin line Blue 

Origin line style The style of the origin line Dot 

Origin line thickness The thickness of the origin line 1 

 

8.10.2.3 CURVE STYLES 

Setting Meaning Typical value 

Series enabled “True” to show the curve of the given 

type in the graph, “False” to hide it 

True 

Series type The type of series: “Scatter” for 

individual symbols, “Line” for a line 

graph, “LineScatter” for a 

combination of the two, “Histogram” 

for a column graph 

Scatter 

Marker style The style of the marker, only applies 

to Scatter or LineScatter graphs 

Circle 

Marker size The size of the marker, only applies 

to Scatter or LineScatter graphs 

9 

Marker fill color The interior color of the markers, 

only applies to Scatter or 

LineScatter graphs 

MediumSlateBlue 

Marker border color The color of the border around the 

markers, only applies to Scatter or 

LineScatter graphs 

Black 
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Marker border width The width of the border around the 

markers, only applies to Scatter or 

LineScatter graphs 

1 

Line color The color of the graph’s line, only 

applies to Line or LineScatter graphs 

Orange 

Line style The style of the graph’s line, only 

applies to Line or LineScatter graphs 

Solid 

Line width The thickness of the graph’s line, 

only applies to Line or LineScatter 

graphs 

2 

 

8.10.2.4 CURVE STYLE ASSOCIATIONS 

The individual curve styles are applied to graph series by type. The main 

template contents are geared towards the main plot of RelaxIS with styles for 

the data and fit curves on each axis. Other graph styles often only require a 

single curve. Most of the time, the Data (Y1) style is used for these series, 

whereby certain details may be overridden, e.g. in the Significance Test, which 

is drawn as a Histogram graph. 

Curve style Applies to graph series 

Data Impedance source data in EIS plots, Parameter Significance 

Test (overridden to Histogram), Residual View (Series Type 

overridden), Result Evaluation plots (when only single result 

is plotted), Bootstrap Error Estimation (Series Type 

overridden)  

Interpolated 

Fit 

Impedance fit result curves in EIS plots, Normal distributions 

in Histograms or CDF plots, fit curves in Combined Data Plot 

(color overridden) 

Exact Fit Impedance fit results at exact source data frequencies in EIS 

plots 

Test Fit The test fit curve in EIS plots, test fit in Result Evaluation 

Inactive Data Inactive data points in EIS plots 
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Stacked Plots Colors are typically overridden, Combined Data Plot (EIS 

Data), Result Preview, Result Evaluation (overlay of results) 

Circuit Simulator 3 (series style overridden) 

Combined Fit 

Style 

Type fixed to LineScatter, Marker Settings from Exact Fit style, 

Line Settings from Interpolated Fit Style, Kramers-Kronig 

Simulation Result, Advanced Genetic Algorithm fits, Mott-

Schottky fit, Model Screening Stored Result display, Multi-

Spectra-Fit fit curves, Result Evaluation fits 

 

For stacked plots, the Stack color list setting is used. Click the “…” button 

after selecting the value to edit the list. 

 

You can move colors around by clicking the arrow buttons, add or remove 

colors and change the colors by selecting them in the list and change the value 

on the right. Colors are applied from top to bottom to stacks of plots like the 

Combined Data Plot and wrap around to the first color if the end of the list is 

reached. 
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9 EQUIVALENT CIRCUITS AND MODELS 

9.1 DEFINING MODELS 

Models are implemented as circuit elements in RelaxIS. Each circuit element 

has a specific impedance expression. The elements can be combined to more 

complex models by connection them in series or parallel. 

Series connection: 𝑍̂𝑡𝑜𝑡𝑎𝑙 = 𝑍̂1 + 𝑍̂2 

Parallel connection: 
1

𝑍̂𝑡𝑜𝑡𝑎𝑙

=
1

𝑍̂1

+
1

𝑍̂2

 

This means, that apart from equivalent circuits also models such as Havriliak-

Negami models with multiple terms and e.g. 𝐶𝑖𝑛𝑓 and conductivity terms can 

be created, by placing the respective elements in parallel, hence adding their 

complex capacitances. 

 Please note 

The terms “model” and “circuit” may be used interchangeably in this 

document, with both meaning a combination of one or more circuit 

elements. 

 

RelaxIS uses a text representation for equivalent circuits and other models. 

When moving or copying spectra to different models, or for various other 

functions in RelaxIS you will need to define a model by creating the text 

representation. 

This is in most cases done using the Model Builder dialog. 
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Enter the model expression in the textbox and click the OK button to accept 

the model. At any point, the Preview box will show a graphical representation 

of the currently entered expression, if it is valid. If the expression is invalid, 

the previous image will be crossed out. You can also check the validity using 

the expressions color, where green stands for a valid model and red for an 

invalid model. To the right of the textbox you will also see a green checkmark 

or a red cross. Hover your mouse over the red cross to see a description of the 

errors in your model expression. 

You will only rarely have to type anything into the textbox by hand though, 

due to the various helper functions provided by the dialog. Nevertheless, with 

some experience you will most likely find it quite easy to adjust the expression 

to your liking by hand quickly and efficiently. 

The syntax of the expressions can be summarized by the following rules: 

Rule Example Result 

Model elements are represented by letter 

combinations, always starting with a 

single capital letter, (sometimes) 

followed by lowercase letters. 

R 
 

Model library 

Model expression 

Single elements 

Partial circuits 

Model preview 
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Model elements are connected in series 

by writing them one after another. 

RC 
 

Model elements are connected in parallel 

by enclosing them in parentheses. 

(I)(R)(C) 

 

Separate serially connected parts from 

parallel connected parts by a hyphen. 

R-(R)(P)-(R)(P) 

 

You can nest subchains at will into other 

parts. 

(C)(R-(R)(C)) 

 

 

The helper functions provided by the dialog are: 

1. The Model Library provides a large selection of premade models. You 

can enter the corresponding expression for any model in the library into 

the expression textbox by left-clicking it. The models are sorted into 

various groups. The model library is described in more detail below. 

2. Click the Add elements buttons to add the respective circuit element at 

the current cursor location to the string. RelaxIS will try to insert the 

element with the correct concatenations based on the Serial and Parallel 

radio buttons.  

3. You can add certain partial circuits using the Add Partial Chain buttons. 

These are parts of commonly used chains, like parallel RC elements. It 

is automatically selected if they are added in parallel or in series.  

4. For Debye-Models, (e.g. Havriliak-Negami Models) you can use the 

Debye-Model-Wizard. Here you can select the number of terms, as well 

as additional terms and the model expression will be automatically 

created. 

5. Transmission-Line-Models can be found in the TLM-Wizard. Please see 

below for a detailed explaination. 

6. You can move the text cursor to certain elements in the expression 

textbox and right-click, to replace that element with another from the 

drop-down menu. 
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7. You can refer to the Quick Reference box to the right of the dialog for 

quick reminders about the used expressions. 

 

RelaxIS provides many pre-defined model elements. You can find a list, 

together with the implemented impedance expressions for each element and 

an explanation of their functions in the appendices. You can create user-

defined circuit elements by using the RelaxIS SDK. 

Additionally, you can assign a title to the model. This does not change the 

impedance function of the model in any way. It however allows you to add the 

same model multiple times to the same project, to further subgroup your data. 

The title is prepended to the model expression and enclosed in the brackets 

of a {}_ block. In the RelaxIS model builder you find an extra text field for the 

title and you do not need to enter {}_ manually. If you are using advanced 

features like RelaxIS Remote you may find it neccessary to specify the title in 

this manner though. A full model expression with title is for example: 

{Model Title}_R-(R)(P) 

9.1.1 THE MODEL LIBRARY 

At the top of the Model Builder dialog you can find the model library. It 

contains a selection of commonly used models, as well as further information 

about them. 

Click on any model in the library to set the model expression into the builder 

dialog input box. 

To add a model to the library, click the “Model Library” menu button and select 

Add model to library. The dialog is pre-filled with the current model and the 

currently selected group. You can freely change the model expression and 

group name. If the group does not already exist it will be created. You can 

enter a comment and additional resource (link or DOI) which will be associated 

with the model and be shown in e.g. the model screening dialog. 

You can edit existing user-created models by right-clicking the model in the 

list and clicking the Edit model button in the context menu. 
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You can remove existing user-created models either by right-clicking them and 

selecting Remove from the context menu, or by clicking the Remove models 

button in the Model Library menu. The latter will show a dialog with all existing 

user-created models. Click the checkmark next to the ones you want to remove 

and click OK. 

 Please note 

Only user-created models can be removed or edited. User-created models 

have a green border in the model library, while built-in models have a light-

blue border. 

 

You can list all existing models by clicking the List all models button in the 

menu bar of the library. 

 

In the dialog, you can switch through the exiting categories using the Category 

dropdown menu. When you click the Use model button, the model’s 

expression is set to the model builders model input box. When you click the 

Open Link button, the model’s resource is opened in your default browsers. 

In case of a DOI resource, the DOI lookup is started, while for Link resources, 

the link will be opened directly. 

9.1.2 THE TRANSMISSION-LINE-MODEL-WIZARD 

The Transmission-Line-Wizard is divided into two parts. The first part is a 

library of predefined TLMs, together with a visualization and a short 

description, similar to what you will find at the back of this manual: 
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. 

To select a TLM to insert into your model, select it from the list and click the 

OK button. The element will be inserted at the current location. 

The second part of the wizard is a designer for a user-defined TLM: 

. 

User-defined TLMs use the mathematical description for a fully populated TLM 

by Bisquert (Phys. Chem. Chem. Phys., 2000, 2, 4185-4192) consisting of the 

outer and inner boundary impedances, ZA and ZB, the electrolyte and 

electronic conducter side, X1 and X2, and the interfacial impedance Zeta.  
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You can then define the subcircuit that is used for each of these sub-

impedances. These can either be a normal sub-equivalent-model, or with the 

exception of Zeta can be set to open- or short-circuits. 

To set the subcircuits either enter their expression directly into the respective 

text box or click the “…” buttons to open another Model Editor dialog to design 

the sub-circuit. 

The User-Defined TLM has a special syntax, different from other circuit 

elements. The sub-circuits are listed in squared-brackets after the name, Tlmx, 

in a specific order: 

Tlmx[ZA,X1,Zeta,X2,ZB] 

For the parameters ZA, X1, Zeta, X2, ZB the individual sub-circuits are inserted.  

For short circuits, a zero, 0, is inserted, for an open circuit the abbreviation inf 

is inserted. 

If, for instance, the non-blocking extended TLM, Tlmenb, should be replicated, 

the User-Defined TLM would read: 

Tlmx[inf,R,(R)(P),R,inf] 

From the element description, RelaxIS infers the required list of parameters, 

so you can use it normally for fitting or simulation. 

 Please note 

Due to the scaling with the length of the pore, L, the units of each parameter 

need to be inferred individually for each parameter. Their scaling with L 

depends on where and how the parameters are placed in the model. Please 

refer to the list of pre-made TLMs in the back of this manual for examples. 

  

9.2 ASSIGNING SPECTRA TO MODELS 

You assign the spectra you have loaded in RelaxIS to specific models. 
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The Spectra Explorer shows all spectra in the currently selected model. To 

change the current model, click the combobox at the top of the Spectra 

Explorer window and select the model you like. 

 

To assign spectra to another model, select them and click the Move to Model, 

or Copy to Model buttons in the Data and Quality tab. Copying spectra 

duplicates the selected spectra and assigns the copies to the new model, while 

leaving the original spectra assigned to their current model. 

To summarize, to assign spectra to a model, perform the following steps: 

1. Optional: Select the spectra in the Spectra Explorer, if you want to treat 

specific spectra 

2. Click either the upper or lower half of the Move or Copy button 

a. The upper half of the button always asks for a model 

b. The lower half allows quickly assigning spectra to existing models 

by showing a dropdown menu containing all existing models 

3. If you clicked the upper half, the Model Builder is shown. Create and 

select the model you want to use. 

4. The Spectra Selection dialog is shown (if dialog selection is enabled). 

Select the spectra you want to move or copy to the defined model and 

click OK. 

9.3 FINDING A SUITABLE MODEL 

9.3.1 GENERAL GUIDELINES 

Given the vast number of different systems that are investigated by Impedance 

Spectroscopy in modern research it is nearly impossible to give a universally 
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valid way of finding a suitable model to evaluate the measured data. Some 

guidelines are: 

• Think about the physical processes and their interactions in the 

system. You might have double-layers that are being charged, 

electrochemical reactions taking place that need diffusion to provide the 

electroactive species and so on. Most of these processes have “default” 

elements in an equivalent circuit that describe them. A double layer is 

basically a capacitor, while a reaction requires energy and leads to 

resistive behavior. Diffusion is usually described by Warburg elements. 

Since the reaction and diffusion are coupled processes you connect 

them in series. But the reaction/diffusion is usually independent of 

double layer charging, so you connect the double layer capacitor in 

parallel to both (leading to the RANDLES-Circuit). Try to infer model 

elements from the processes you measure. 

• Find shapes in the spectra and think about model elements that can 

describe them. A semicircle in the Nyquist-representation (impedance) 

may be described with an (R)(C) element. A 45° line indicates Warburg 

behavior. Bring these together to form ideas for suitable models and 

then assign physical meaning to the elements. 

9.3.2 THE MODEL SCREENING TOOL 

As shown above, RelaxIS comes with a large library of premade models. It is 

possible to evaluate these mdoels for their suitability in describing a given 

impedance spectrum. This is done by employing a genetic algorithm (GA). A 

GA is a so-called metaheuristic algorithm to check a large search space for 

suitable solutions to a problem. In the RelaxIS case, the genetic algorithm tries 

to search a large range of parameter values to find suitable initial values for 

the fit for arbitrary models. This is done in a semi-random fashion. 

To perform a Model Screening, first load the spectrum in question and activate 

it using the Spectra Explorer window. Afterwards use the Model Screening 

button in the Data and Quality tab to open the Model Screening dialog. 
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The list at the top-left lets you select the models to include in the screening. 

You can use your own models by adding them to the model library in the Model 

Builder dialog as described in section 9.1. To speed up the process it is 

advisable to preselect models with a physical meaning for your data. 

Use the checkboxes to include or exclude models. You can in- or exclude all 

models using the buttons below the list. 

Clicking the Settings button allows you to change various options for the 

screening process and the operation of the GA. 

 

The Population, Crossover method and Selection method relate to the Genetic 

algorithm and affect how the GA searches for optimal parameters. The other 

Model 

Selection 
Result 

List 

Result 

Graph 

Result Description 
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options are tolerance criteria, that describe when RelaxIS will accept values for 

a model as the best for that model. 

• # Number of Generations: RelaxIS will only accept an individual if at 

least this many generations have passed. 

• Minimum Tolerance: While evolving the population RelaxIS 

continuously calculates a tolerance value from the current change rate 

of the best fitness. The lower this value, the more stable the best fitness 

needs to be from generation to generation. When the current tolerance 

value drops below the minimum tolerance, RelaxIS will accept the best 

individual. 

• Tolerance Generations: This selects how many previous generations 

RelaxIS will take into account for calculating the tolerance value. 

• Maximum # of unchanged generations: RelaxIS will accept the best 

individual once the best fitness has not changed for this many 

generations. This is usually overridden by the Tolerance criterium. 

The Parameter Penalty Factor is used to calculate the Weighted SSR, using the 

formula 

𝑊𝑒𝑖𝑔ℎ𝑡𝑒𝑑 𝑆𝑆𝑅 = 𝑆𝑆𝑅 ∙ 𝑛𝑃𝑎𝑟𝑎𝑚𝑠𝑃𝑒𝑛𝑎𝑙𝑡𝑦 

That means, that the more parameters and the higher the penalty factor, the 

larger the Weighted SSR. The higher the penalty factor, the more the impact of 

additional parameters in the model. 

Sensible values depend especially on the chosen Selection method. Best half 

usually requires less maximum generations and less tolerance generations 

than Tournament, but is slower. 

The selected settings dramatically alter both the speed and the reliability of 

the screening process. 

Once you have chosen the correct settings and the models you want to include 

in the screening, use the Start button to start the screening process. 

The process can take quite a lot of time! 



Equivalent Circuits and Models 

 

90 
 

While running, the already tested models are added to the Result list. Click the 

entries to see both a plot of the fit results and further information about the 

parameters found. Click the Column headers to sort the columns. 

The SSR column designates the minimum ESS found for the model. The 

Weighted SSR column weights the SSR by the number of parameters of the 

model. The more parameters the higher the Weighted SSR becomes. This 

favors simpler models over more complex ones. 

 

From the list, you can deduce suitable models, find similarities and thus find 

model elements you can use to find a physically sensible model to describe 

the data. 

 Please note 

The GA relies on random variables to search the very large parameter ranges. 

While it usually searches quite efficiently and reproducibly, the process is 

nevertheless not deterministic! This means it is not guaranteed to always 

find the same results, because by chance the best parameter set could not 

be found for a certain run. Please keep that in mind while evaluating the 

results of the screening! 
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10 FITTING 

A typical workflow for the evaluation of impedance spectra in RelaxIS is 

depicted in the following flowchart. 

 

This chapter focuses on initializing fit parameters and performing the actual 

fits. For loading data, please refer to chapter 6, and for assigning data to a 

model, please refer to chapter 8.  

10.1 ALGORITHM SETTINGS 

The RelaxIS Settings dialog allows you to modify the settings being used for 

the fit algorithms. By default, RelaxIS uses algorithm settings that combine a 

fast fitting speed with reasonably good convergence characteristics (see also 

appendices 23.2). This mode is called Automatic (Quick). You can select 

another mode, which is slower, but has tighter tolerances and allows for more 

iterations of the used algorithms which improves convergence. You can select 

this mode, called Automatic (Thorough), be opening the Settings dialog from 

the main menu, Main→Settings→Fitting. Select the radiobuttons called 

Automatic → Thorough, to switch to the other automatic mode. 

In the same settings dialog, you can also define your very own fitting 

procedure. Select the Custom radiobutton, and click the Edit… button to open 

the algorithm editor dialog. 
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You can chain multiple fitting steps. When you fit a spectrum, the first 

algorithm in the list is executed with the selected settings. The result of this 

fit is then used as initial parameters for the second step in the list, which can 

be the same or a different algorithm. This way you can combine the good 

properties of both available algorithms by creating a series of fits.  

You can add fitting steps by clicking the Add Step button. Delete fitting steps 

by clicking the X icon in the top-left corner of the step. You can rearrange 

steps by clicking and holding down the mouse on the move icon, and then 

dragging the step to another position in the list. 

Click Ok to accept the current list of algorithms. 

 

In the Settings dialog, you can select to Refine the fit n-times. This means that 

after a fit is complete is it restarted automatically for as many times you select. 

This may help in ambiguous situations with many local minima to “jump” out 

of a local minimum into a better one. 

Some steps of algorithms can run in parallel. The Multithreading options allow 

you to limit the number of threads that the algorithms will use. 
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10.2 INITIALIZING FIT PARAMETERS 

10.2.1 GENERAL INFORMATION 

As outlined in the appendices chapter 23.2, a non-linear curve fit needs 

suitable starting parameters to succeed. Due to the complexity of impedance 

data and the models, initializing the fit is not a trivial undertaking. RelaxIS 

offers tools to help you in the initialization process, or automates this process 

completely for some types of spectra with the help of the Fit Wizard, that is 

described further down in this chapter. 

Once you have assigned a spectrum to a model and activated it in the Spectra 

Explorer, you will see the fit parameters associated with that model appear in 

the Parameter Explorer window. 

 

When you select different parameters, their source element in the model will 

be highlighted in red. That way you can easily find the role of each parameter. 

Each parameter has the following properties associated with them 

1. Name: The default name describes the role of the parameter and are 

numbered in ascending order. 

2. Value: This is the active value, for example the resistance of a resistor 

in the circuit. This will be set to the fit result, after you perform a fit. 
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3. Error: These are not set or set to zero by default (depending on the 

corresponding Setup setting), until you have performed a fit. After that, 

the fields will contain the error calculated for the parameter on the last 

fit. Please note that the relative error is calculated on the fly, and can 

therefore change when you manually change the parameter value after 

a fit. 

4. Minimum and Maximum: These are the bounds of a parameter. The 

parameter’s value cannot lie outside of these bounds. You can set them 

manually and the fit will also respect these bounds. These values are 

also especially important for the Genetic Algorithm, as they describe the 

bounds of the search space. 

5. Fixed state: Represented by the checkbox in the first column, this 

property defines if the parameter will be changed by a fit, or taken as 

constant. This allows you to set certain properties of a model to pre-

defined values, you may have taken from complementary sources. When 

fixed, the error of the parameter is always set to zero by a fit. 

You can change the error display through the Settings dialog. Under “Value 

formats” you can find the “Parameter Error Format” section. Here you can 

enter a formatting string containing tags. All tags start with the # sign and are 

followed by one or more characters indicating the value to be inserted at this 

position in the string. The usable tags are: 

Tag Description 

#E The absolute error value 

#P The relative error value 

Combining these with an arbitrary string can produce the text you like. Some 

examples are: 

Error format Result 

#E (#P%) 234 (19%) 

#P 19 
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 Tip 

You can export the image of the circuit from the preview using the preview’s 

context menu (right-click).  

 

10.2.2 QUICK PARAMETER INFORMATION 

If you select parameters belonging to either to a) a single resistor or to b) a 

combination of a resistor and either a capacitor or constant phase element 

RelaxIS will display a status bar underneath the parameter list. In case a) the 

status bar will show the calculated conductivity for the resistance. If the active 

spectrum contains the Area and Thickness metadata fields the specific 

conductivity (𝜎) will be calculated. If not, the simple conductivity (G) will be 

given.  

For the combination or R and C/P both the time-constant and the effective 

capacitance (from Brug’s formula) will be calculated. 

You can copy either of the values into the windows clipboard by right-clicking 

the status bar and selecting the value from the context menu. 

10.2.3 MANUALLY CHANGING INITIAL VALUES 

You can manually enter initial values into the respective cells in the Parameter 

Explorer. Whenever you change a value, you can immediately see the changes 

to the fitted curve in the Data Explorer window. In many cases, this allows you 

to quickly find suitable parameters by deducing values from the spectrum or 

by trial-and-error. 

You can use a list of values that will be assigned to a specific fit parameter 

value of a selected list of spectra. Click the Set Parameter Values from List 

button in the Fitting tab in the section Parameter Helpers. Here, first select 

the spectra you wish to assign parameter values to. Now select the parameter 

you want to change and type or paste in values into the text area. 

The values will be assigned from top to bottom to the selected spectra in the 

order chosen from the Select Spectra dialog. 
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If you have less values in the text area than selected spectra, you can activate 

the Continue… checkbox at the bottom. After the text area values are all used 

up, this will take the last value in the text area and apply it to all further 

spectra. 

You can furthermore choose to fix all changes parameters. 

10.2.4 USING SHAPES TO FIND INITIAL VALUES 

10.2.4.1 STEP BY STEP INSTRUCTIONS 

RelaxIS offers the Circle Tool and the Line Tool to calculate initial values 

directly from a spectrum. The tools can be accessed through the Fitting tab in 

the section Parameter Helpers. To use the tools, perform the following steps: 

1. Assign the spectrum to a model that can represent all shapes in it. For 

example, it could contain an (R)(C) element for each semicircle in an 

Impedance Nyquist Plot. The Circle-/Line-Tools do not choose the 

correct model for you! 

2. Select either the Circle or Line Tool from the menu. 

3. With your mouse click and drag the mouse in the plot to add the 

respective shape. The exact position does not matter at first. 

 

 

4. Use the handles on the created shape to move and reshape it to 

represent the shape of the data in the spectrum. If the handles are 

invisible, move your mouse in the vincinity of the shapes to show them. 
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5. You can find a representation in the Parameter Explorer window for each 

drawn shape. You now have to assign the shape features to suitable 

parameter combinations of the model. Click on a shape and drag your 

mouse into the parameter list below.  

6. Depending on the currently selected transfer function and plot type, 

RelaxIS will choose suitable combinations of parameters that may 

represent the selected shape in the model. These are for example 

Resistor-Capacitor combinations for shapes in the Impedance Nyquist 

Plot. When you drag your mouse through the list, RelaxIS indicates the 

nearest parameter combo with green arrows. 

 

7. Release the mouse on the desired parameter combination. RelaxIS will 

then calculate suitable parameter values and assign these to the selected 

parameters. If the calculated parameters lie out of bounds for a 
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parameter, RelaxIS will ask if you want to change the bounds to 

accommodate for the calculated parameter value. 

8. The Offset shape describes the leftmost border of all drawn shapes. You 

can for example draw multiple circles and the offset can then describe 

the left border of the leftmost circle. This is useful to initialize a bulk 

resistance for example. 

 Please note 

In some cases, RelaxIS will calculate unsuitable parameter values. This can 

have multiple reasons: 

• The parameter combination does not really describe the selected 

shape. RelaxIS will select for example Resistance-Capacitance 

combinations, even if they are not really connected directly in an (R)(C) 

element that leads to a semicircle in the spectrum. Please check the 

selected combination carefully. 

• In Nyquist Plots the frequency information cannot be calculated 

exactly for each point in the graph! Calculating the capacitance of an 

(R)(C) element requires the knowledge of the frequency at the 

maximum of the drawn semicircle. RelaxIS will try its best to 

interpolate that frequency. In case of noise this interpolation may 

lead to wrong results. When you draw a circle to the left or right of the 

data RelaxIS even has to extrapolate the frequency which can lead to 

very strange results, given noise and data point density at the extreme 

frequencies. When you move your mouse over the Data Explorer you 

can see the calculated frequency for the mouse position in the status 

bar. Please check, if that frequency makes sense at the positions of 

your shapes, when you experience weird behavior. 
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The shape/parameter combinations for different transfer functions are as 

follows: 

Impedance 

Circle Resistor+Capacitor, 

Resistor+Constant Phase Element, 

Zarc Element 

Line Constant Phase Element, Warburg 

Element, Inductivity 

Offset Resistor 

 

Admittance 

Circle Resistor+Capacitor, 

Resistor+Constant Phase Element 

Line --- 

Offset Resistor 

 

Complex Capacitance 

Circle Resistor+Capacitor, 

Resistor+Constant Phase Element, 

Havriliak-Negami, Cole-Cole, Cole-

Davidson 

Line Sigma Element 

Offset Capacitor, Constant Phase Element 

 

10.2.4.2 CREATING SHAPES FROM SELECTED DATAPOINTS 

Instead of drawing the semi-circles and lines manually into the data, it is 

possible to select some points of the spectra and let RelaxIS fit a shape to it 

automatically. To do so first select a supported transfer function and plot type 

(Nyquist), add the spectrum to the model you wish to use and then select the 

Fitting -> Add Shape by Selection option from the main menu. 
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Note, that the Data Explorer plot shows an instruction message while the tool 

is active. 

Next, use the mouse to drag a selection box around the datapoints you wish 

to fit the shape to. Per default, a semi-circle is created. 

 

 

To create a line instead, hold down the Shift key while dragging the selection 

box. The shift key must be held down until after mouse-button is released. 

The created shapes can be used just as the manually created shapes. 

 

10.2.5 USING A GENETIC ALGORITHM TO FIND INITIAL VALUES 

As already explained in section 9.3.2 the genetic algorithm is a so-called 

metaheuristic algorithm to check a large search space for suitable solutions to 

a problem. In the RelaxIS case, the genetic algorithm tries to search a large 
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range of parameter values to find suitable initial values for the fit for arbitrary 

models. You can use this approach to search for suitable initial parameters for 

a spectrum with an already assigned model. 

The genetic algorithm is implemented either as an advanced search mode, or 

as the Auto Fit feature, that will be described in section 10.8. 

To use the advanced search mode, please open the Custom Autofit dialog from 

the Fitting tab by pressing the lower part of the Auto Fit button and selecting 

Custom Auto Fit. You do not have to initialize any model parameters after 

assigning the model. 

 

In the top-left you can extend the algorithm settings panel to change settings 

related to the function of the genetic algorithm.  

You can also perform the evaluations using different weighting modes. Please 

refer to section 10.3 for further description of weighting modes.  

An important setting is the range for each parameter. You can thereby limit 

the search space of each parameter. The search space is automatically 

determined for most parameters based on the spectrum. 
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You can change the limits in the table on the left. By limiting the search space, 

you can dramatically improve the speed of finding suitable parameters. If the 

range covers multiple orders of magnitude you should enable logarithmic 

scaling of the search space by using the dropdown menu in the last column. 

That way, small values are equally likely to be chosen than very large values.  

Once you have set the options, click the Start button to start the algorithm. 

You can see the development of the results in the graphs to the right. The chart 

shows the data and the resulting fit curve in red. Below you find a graph that 

displays the development of both the best and the median fitness over the 

various generations.  

 Please note 

The best fitness may not change for a great number of generations and then 

suddenly drop again. This is due to the nondeterministic nature of the 

genetic algorithm and its reliance on random numbers, as mentioned in 

section 9.3.2. 

 

Once you are satisfied with the found results, you can stop the algorithm using 

the Stop button. Afterwards you can accept the values (and the chosen 

weighting mode) by clicking the Accept button. That way the current best 

parameters are set as initial values for the selected spectrum and the weighting 

mode is changed to the selected mode. Also, a single fit is automatically 

performed. 

The main Settings dialog in the Fitting tab allows you to select, how the 

parameter limits are treated after the genetic algorithm completes. You can 

disallow the GA to change the limits, but this may prevent the best fit to be 

applied to the actual spectrum. By default, the limits are only widened but 

never shrunk, which is a useful way of handling the limits. 

10.3 WEIGHTING MODES 

The fitting procedure minimizes the weighted sum of squared residuals. That 

means that a weighting factor is assigned to each real- and imaginary part of 
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a data point. This gives certain data points more or less influence on the fit 

result. Weighting the data can improve fits of spectra that span multiple orders 

of magnitude in their values. If unweighted, improvements in the fit of few 

large points are much more important than improving the fit for many small 

data points. An example is given in the following figure. 

 

 

RelaxIS supports multiple different weighting modes, that influence the fit in 

different ways. 

 

Weighting Mode Description 

No weighting All weights are set to unity. Each data point adds 

its absolute deviation from the fit. 

Proportional weighting 

(recommended) 

Each data point is weighted by the inverse square 

of its value. That practically transforms the fit to 

sum up the relative instead of the absolute errors. 

Log102(Frequency) This weighs the data points by the squared base-

10 logarithm of the frequency. This favors low and 

high frequencies. 

Favor low frequencies This also uses the base-10 logarithm, but only 

favors low frequencies. 

Favor high frequencies This also uses the base-10 logarithm, but only 

favors high frequencies. 
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Low freq. modulus This uses the proportional weighting, but 

additionally favors low frequencies. 

High freq. modulus This uses the proportional weighting, but 

additionally favors high frequencies. 

  

For most fitting procedures, the proportional weighting mode provides the 

best results. On some occasions, you may want to try other modes in order to 

fit certain features better than others. 

You can develop your own weighting modes with the RelaxIS SDK. 

10.4 TRANSFER FUNCTIONS 

RelaxIS allows you to use multiple different transfer functions to fit the data. 

You can by default convert the data from the impedance into the admittance, 

the complex capacitance and the elastance. RelaxIS only uses geometry 

dependent transfer functions instead of the often-common geometry 

independent transfer functions specific impedance, complex conductivity, 

permittivity and complex modulus.  

Certain function like the Plot View or the Combined Data Plot allow 

normalization, if geometric metadata is available. The actual analysis, 

however, is still performed only with non-normalized transfer functions. You 

can also recalculate analysis result values during the export, if required. 

You can change the current transfer function using the Change Transfer 

Function button in the Fitting tab of the main ribbon interface. The data 

displayed in the Data Explorer and other features are changed accordingly. 

You can implement your own transfer functions with the RelaxIS SDK. 

10.5 CHANGING THE ACTIVE FREQUENCY RANGE 

RelaxIS allows you to only fit a certain frequency range of a spectrum. You can 

change this range using two different methods. Inactive data points are shown 

in gray in the spectrum and are ignored in every fit and in other functions of 
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RelaxIS. You can spread the selected frequency range to other spectra using 

the Parameter Spreading functionality as explained in section 6.8. 

10.5.1 SELECT FREQUENCY RANGE 

The Set Frequency Range feature allows you to directly select the upper and 

lower frequency limit by either clicking data points or by entering the 

respective frequency. Click the Select Frequency Range button in the Fitting 

tab to show the respective dialog. 

 

Now do one of the following: 

• Click on a data point in the spectrum to set it as the first limiting point. 

• Click the Highest- or Lowest Frequency buttons to select either the 

highest or lowest frequency of the current spectrum. 

• Enter a desired frequency in the box and click the Set button. 

Afterwards you need to do one these steps again to select the second limiting 

point. You can abort the procedure by clicking the Abort button.  

10.5.2 CHANGE FREQUENCY RANGE 

The Change Frequency Range feature allows you to select a frequency range 

by moving various sliders over the spectrum in question. From the points in 

the inner rectangle formed by the sliders the highest and lowest frequency are 

selected and set as the active frequency range. 
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After moving the sliders to the desired positions, click the Apply button to 

accept the selected range. 

If the plotted data in the Data Explorer has the frequency, or angular 

frequency, on the X-Axis, only two sliders are displayed, because the frequency 

range can be selected unambiguously in this case. 

10.6 TESTING THE FIT 

RelaxIS can show the results of a fit with the current settings, without actually 

changing any of the initial parameters you entered. The test fit is shown as a 

light green curve in the Data Explorer window. The testing is performed in two 

different ways in RelaxIS. 

• Clicking the Test Fit button in the Fitting tab. 

• Enabling the Live Test feature in the Fitting tab (it is also enabled by 

default). This automatically performs a test fit in the background 

whenever a significant variable like an initial parameter, the transfer 

function or the weighting mode is changed. That way you always have 

the current fit result in view. 
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You can remove the test curve by clicking the Remove button next to the Test 

Fit button on the Fitting tab. 

10.7 PERFORMING A FIT 

After initializing the parameters, you can perform the actual fit by pressing 

the Single Fit button on the Fitting tab. 

If direct selection mode is enabled, the button is called “Fit selected” and will 

perform a single fit on all currently selected spectra. 

That will perform the fit and enter the resulting parameters and errors into 

the Parameter Explorer table. 

10.8 AUTO FIT 

The Auto Fit feature uses the Genetic Algorithm to automatically determine 

suitable initial parameters and perform the fit. 

In many situations, the Auto Fit is enough to successfully fit a spectrum, 

without the need to manually adjust any initial parameters. 

The Auto Fit can be performed in two different modes: Quick and Thorough. 

Quick uses a setup with a smaller population and maximum number of 

generations, to find initial parameters more quickly. Using the Thorough 

search, allows for a more extensive search for initial parameters, using more 
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generations and a larger population. This gives a larger probability to find 

good initial values at the cost of reduced speed. 

You can perform a Quick Auto Fit by clicking the upper part of the Auto Fit 

button in the Fitting tab of the main Ribbon. Clicking the lower part opens a 

dropdown menu that allows you to access the Thorough Auto Fit and the GA 

Search Mode, described in section 10.2.5.  

You can also perform an Auto Fit on more than one file at a time, by a) selection 

spectra before clicking the Auto Fit button in direct selection mode, or b) 

selecting the (Multi) Auto Fit modes in the dropdown menu in dialog selection 

mode. The Multi Auto Fit uses the Settings→Fitting→Multi Threading: Lists 

option to process multiple spectra simultaneously. 

Please note the settings for parameter limits in the main Settings dialog in the 

Fitting tab, as already explained in section 10.2.5. 

The Auto Fit procedure can be more finely controlled using the Custom Auto 

Fit dialog, that can be accessed by clicking the Custom Auto Fit button in the 

Auto Fit dropdown. The dialog is introduced in section 10.2.5. 

By default, after an Auto Fit is performed, a reordering of the time constants 

of the parameters is performed automatically. See the next paragraph for 

details on this procedure. This improves comparisons of multiple spectra 

fitted with the Auto Fit, as parameters have a better chance of correlating with 

each other. This functionality can be disabled from the Main→Setup dialog, in 

the Fitting tab. 

10.8.1 REORDERING TIME CONSTANTS 

Consider the model (R)(C)-(R)(C)-(R)(C). The three (R)(C)-elements each have a 

time constant. From the mathematical standpoint, it is irrelevant in which 

order these appear in the parameter list, so you can interchange e.g. Resistance 

1/Capacitance 1 with Resistance 3/Capacitance 3 and you calculate the exact 

same impedance values from the model. Now consider you have measured a 

series of spectra and use the Multi Auto Fit to fit all of them. Due to the 

random nature of the algorithm, the order in which the time constants appear 

in the results is random. If you export the results to plot and analyze them, 
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this will get very confusing, because corresponding parameter values appear 

in different columns for each spectrum. 

To alleviate this problem, RelaxIS contains the Reorder Elements by Tau 

plugin, in the Plugins tab. The plugin will analyze the model and find series 

(R)(C) and (R)(P) parts, or Co/Cd/Hv parts. For these it calculates the time 

constants and reshuffles the parameter values, such that the lowest time 

constants appear before the larger ones in the list.  

Please note: This will only work for simple serial chains of (R)(C)/(R)(P), or 

parallel chains of Co/Cd/Hv elements! If the elements are nested in subchains, 

the definition of time-constants are not easily deduced from the model and 

the parameters cannot be reshuffled unambiguously. 

After clicking the plugin button, use the selection dialog to select which 

spectra to change. After clicking OK, the plugin will analyze the model of the 

selected spectra and order the parameter values if possible. 

10.9 BATCH FITTING 

Often you measure a whole series of spectra, that gradually change, for 

example with time or with temperature. In this case, you can drastically speed 

up the fitting process by using the Batch Fit function from the Fitting tab. 

A batch fit starts with the current spectrum, fits it, and moves to the next 

spectrum in the list of spectra. It then uses the results from the last fit as the 

initial parameters for the fit of this next spectrum. When parameters gradually 

change, this procedure will allow you to quickly fit all spectra at once.  

To perform a Batch Fit, please perform the following steps: 

1. Initialize the fit for the starting spectrum manually. It is advisable to use 

a spectrum that represents sort of a middle ground for all spectra to fit. 

2. Click the Batch Fit button on the Fitting tab to open the Batch Fitting 

Dialog. 
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3. Select the direction you wish to process the spectra list. You can move 

both upwards from the current spectrum, as well as downwards (or do 

both). 

4. Choose where you wish the algorithm to stop. 

a. The spectra list can be processed to the end (the first or last 

spectrum in the Spectra Explorer, depending on the direction). 

b. The algorithm can be instructed to stop, when the value of one or 

multiple metadata variables change. This is handy, if you have 

groups of spectra, e.g. with the same temperature. 

5. Click OK to start the Batch Fit. 

While the Batch Fit is running, you will see a status window, that will close, 

once the process is complete, and also allows you to stop the process after the 

next fit. 

To speed up the process you can also quickly run the batch fit by clicking on 

the bottom part of the Batch Fitting button. This opens a dropdown menu. 

From this you can quickly run a batch fit upwards or downwards (or both) to 

the end of the list. 
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 Please note 

The “instant batch fit” function changes behavior depending on the used 

selection mode. 

For direct selection mode, select the spectra to batch fit first. “Instant 

downward” then starts at the first selected spectrum and moves downwards 

through the selected spectra. “Instant upwards” starts at the last selected 

spectrum and moves upwards through the selected spectra. “Instant up and 

down” ignores the current selection, and instead starts at the active 

spectrum and moves through the full list. 

In dialog selection mode, all functions start at the active spectrum and move 

through the full list of spectra. 

 

The dropdown menu also provides access to a legacy interface for the Batch 

Fit (prior to version 3.0.1.13), that allows for a finer selection of the spectra to 

fit.  

To perform a Batch Fit with the legacy interface, please perform the following 

steps: 

1. Initialize the fit for the first spectrum in your desired list manually. 

2. Click the lower part of the Batch Fit button on the Fitting tab and select 

Legacy Batch Fit. This opens the Spectra Selection dialog. 

3. Select the list of spectra to perform the Batch Fit on. 

4. The Batch Options dialog is shown 
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a. The option Start with Current Spectrum means that in every case 

the currently active spectrum is moved to the top of the batch list. 

b. The Direction settings specify if you want to move through the 

batch list from first to last or from last to first.  

c. Lastly you can select the Batch Fitting mode. Either you can 

initialize the next spectrum from the previous, or you can 

initialize all fits from the very first one. The Extrapolation option 

is currently not implemented. 

10.10 REFINEMENT FITTING 

The Refinement function available through the Fitting tab, allows you to 

perform the fit again for every spectrum selected through the Spectra Selection 

dialog, shown after accessing the function. 

This is often helpful when you have changed parameters like the frequency 

range or fixed parameters through the Parameter Spreading function to 

reapply a valid fit to all files at once. 

 Please note 

The refinement fitting function is only available in dialog selection mode. In 

direct selection mode is equivalent to the “Fit selected” function. 

 

10.11 AUTOMATIC LOCAL MINIMUM IMPROVEMENT 

In the Main→Settings dialog, in the Fitting tab, you can enable Automatic local 

minimum improvement. This function is run each time a fit has finished and 

tries to jump out of a local minimum. For this, a number of additional fits with 

slightly changed initial parameters (taken from the result of the just finished 

fit) is run. E.g. some parameters are increased in value while others are 

decreased. The resulting fits are compared, and the best is used as the eventual 

fit result. 
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10.12 THE FIT WIZARD 

The Fit Wizard is a method to automatically evaluate certain common spectra 

and problems. The evaluation includes the selection of a suitable model, 

finding initial values and performing the fit. It may also include the calculation 

of further information from the fit result and assignment of these to metadata 

of the spectrum. Currently two different Wizards are included in RelaxIS – a 

wizard to evaluate conductivity measurements and a wizard to evaluate typical 

spectra of batteries. 

To perform a Wizard Fit, please perform the following steps: 

1. Open the Wizard dialog using the Wizard button on the Fitting tab. 

2. Select the Wizard suitable for the spectrum you have selected. You can 

find a typical image of the spectrum as well as a description on the 

Wizard page.  

3. Click the Next button. 

4. Depending on the selected Wizard, you now need to set some basic 

options for the wizard. A detailed description for options of the 

included wizards can be found below. 

5. After setting the options, click the Next button. 

6. You see a summary of the settings selected by the wizard such as the 

selected model and the initial values.  

7. Click the Next button and select the spectra you want to perform the 

wizard fit on from the Spectra Selection dialog (in dialog selection 

mode). Some selected options, such as selected positions in the 

spectrum are extrapolated to the ranges of each selected spectrum. 

It may happen, that after the fits are completed you will be presented with a 

message box asking for permission to enter one or more further results into 

the metadata fields of the spectra. If such additional results were calculated 

you will also be presented with an export dialog that lets you export these 

results into the clipboard or a file. The export procedure is further described 

in section 14. 
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10.12.1 THE CONDUCTIVITY WIZARD 

The Conductivity Wizard lets you automatically extract the electrolyte 

conductivity from typical conductivity spectra. This can include spectra 

showing a high frequency bulk semicircle, a high frequency inductivity, and 

electrode polarization. The wizard will automatically check for the occurrence 

of either of these and select a model accordingly. 

The settings for this wizard are 

Setting Description 

Cell Constant The cell constant of your measuring 

cell. This can be set either directly, or 

from cell parameters, or from the 

Area and Thickness set in each 

spectrum. 

REQUIRED to automatically calculate 

the conductivity from the fit. 

Transfer Function The transfer function that is used for 

the fit. By default, the admittance is 

used. 

High freq. inductivity If inductive data points are found, 

you can choose to include these in 

the model, or ignore them in the fit. 

Search for bulk semicircle This lets you skip the search for a 

bulk semicircle, in case you run into 

problems with noise in the spectra. 

 

Once the fitting is complete, the wizard will use the cell-constant and the 

correct resistance from the fit to calculate the conductivity. The conductivity 

can be assigned to the Free Variable metadata field afterwards. 
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10.12.2 THE CONDUCTIVITY WIZARD (NON-INTERACTIVE) 

This wizard performs the same tasks as the Conductivity Wizard, but does so 

without any options. It selects default options and can be used in further 

functionality like RelaxIS Remote (section 20).  

10.12.3 THE BATTERY WIZARD 

The Battery Wizard fits typical battery spectra. These include a high frequency 

inductive part, up to two semicircles in the intermediate frequency range and 

a low frequency diffusion part. The Battery Wizard exists in two versions. The 

first only uses ideal circuit elements, meaning that an inductor is used for the 

inductive part and ideal capacitors are used for the semicircles. Only the 

diffusion part uses a constant-phase element. The Empiric Battery Wizard 

instead uses constant-phase elements also for the inductive part and the semi 

circles. 

You don’t have to enter any settings for the wizard to work. The Wizard can 

also be used in the RelaxIS Remote feature. 

10.12.4 THE SEMICIRCLE WIZARD 

This wizard is used for spectra that contain multiple semi-circles in either the 

Impedance, Admittance or Complex Capacitance. It can also fit a high 

frequency inductivity and low frequency polarization/dispersion. 

On the settings page, you need to define how many semicircles in the spectrum 

you wish to fit. For overlapping circles, as is often the case, an automatic 

detection is very prone to errors, and therefore a semi-manual method of 

selecting the circles is used. After setting the number, you are presented with 

a plot of the active spectrum containing a corresponding number of green 

markers. Please use the mouse to drag these markers to roughly the maximum 

of each semicircle you wish to fit. Afterwards click Next to finish the wizard. 

If you select to evaluate more than one spectrum, the marker positions are 

adjusted proportional to the Z’ scale, e.g. Marker 1 is interpreted as being at 

36% between 𝑍′𝑚𝑖𝑛 and 𝑍′𝑚𝑎𝑥, and the absolute Z’ value will be calculated 

accordingly for each spectrum. 
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10.13 FITTING MULTIPLE SPECTRA WITH GLOBAL PARAMETERS 

RelaxIS allows you to treat multiple spectra as a combined dataset and define 

a fitting model where some of the parameters are shared between all involved 

spectra thus produce only a single value. Other parameters can also be 

individual and thus take individual values for the spectra. An example would 

be a measurement series at the same temperature, where you expect the 

electrolyte conductivity to be constant for each measurement. You would then 

define the respective electrolyte resistor as a global parameter while other 

parameters such as capacitances or charge transfer resistors are individual for 

each spectrum. 

 

 

Using global parameter is not the same as using fixed values for the respective 

parameter. The global parameter is still an active fitting value and not a 

constant, it will just have the same value for each spectrum at any given time, 

but this value is flexible and will be adjusted for a best fit of all involved 

spectra. 

RelaxIS offers two interfaces for performing fits with global parameters. A 

simplified interface that just allows you define one or multiple parameters of 

the currently used fitting model as global parameters and perform the fit. This 

is called the Global Fit. Furthermore, RelaxIS offers an advanced Multi-

Spectrum-Fit procedure that is based on individual plugins which define the 

model. These plugins completely define the model and can not only take use 

the frequency as independent variables but also spectra metdatadata. This 
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allows, for example, to define a temperature-dependent model that calculates 

parameter values from an Arrhenius function and thus has the Arrhenius 

parameters as fit parameters for the impedance spectra. Such models are very 

specialized and currently only few examples of such a fitting approach are 

published. RelaxIS therefore currently does not contain premade Multi-Fit 

models, but relies on the user to implement the model as a plugin. 

10.13.1 GLOBAL PARAMETER FIT 

To perform a Global Parameter Fit first move the spectra to the respective 

model and perform a fit with non-global parameters. The reason is, that the 

current parameter values will be used as initial parameters for all individual 

parameters. The initial values for global parameters are chosen per default as 

the average of the respective parameter values over all spectra, but can be 

adjusted in the global fitting process. After performing the individual fits, click 

the Global Fit button in the Main→Fitting tab. Use the Select Spectra dialog to 

include the spectra you wish to combine as the global dataset.  

 

The Global Fit interface then allows you to select one or more parameters as 

global parameters. The selected parameters will receive a green background 

and you will be able to adjust the initial values and parameter limits of them. 

The option Recalculate shared parameter errors for individual spectra will 

advise RelaxIS to use the resulting value of the global fit and calculate an error 

for each individual spectrum from the covariance matrix again. This will give 
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individual error values for this parameter per spectrum. If the setting is 

disabled, the error value from the global fit will be applied to each spectrum. 

The latter is the sounder procedure, since the parameter value was indeed 

derived from the combined dataset and not from the individual spectra. 

You can furthermore select to fix the global parameters in the parameter lists 

of the individual spectra. 

Once you have set everything up, click the OK button to perform the fit. The 

fit results will be entered into the individual parameter lists of all spectra. You 

will notice that every spectrum has the same value for the global parameters. 

10.13.2 MULTI-SPECTRUM-FIT 

You don’t have to assign a model or perform fits before beginning the Multi-

Spectrum-Fit procedure, since it is usually completely independent of previous 

fits. Depending on the used model it may however use the individual fits to 

determine values for the initial parameters. Start the Multi-Spectrum fit using 

the Multi-Spectrum-Fit button on the Main→Fitting tab of the ribbon. Use the 

Select Spectra dialog to select the spectra you wish to include in the fit. 

Models can define metadata that it requires the spectra to have. If spectra don’t 

have these metadata fields filled with values they will not be usable in the fit. 

If none of the selected spectra has the required metadata the model will be 

disabled in the list of available models in the Multi-Spectrum-Fit dialog. 

In the Multi-Spectrum-Fit dialog select the model you wish to use and click the 

Next Button. On the next page, you need to define initial parameters for the 

fit. On the top left, you see the list of shared parameters and you can set up 

which parameters are free or fixed, as well as their parameter values and limits. 

Below you will find the list of individual spectra. Use the arrow buttons to cycle 

through the individual parameter values of each spectrum. This will also select 

which spectrum is displayed together with the current model curve in the 

graph on the right. You can note that individual parameters only change the 

model curve of one spectrum, which shared parameters change the curves of 

all spectra at the same time. 
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Below you can select a weighting mode and you also have a button to show the 

fit algorithm page in the settings menu. For Multi-Spectrum fits the Automatic 

Thorough fitting mode is recommended! 

Before clicking Perform fit make sure that the initial parameters describe all 

spectra reasonably well. Then click the button to perform the fit. 

The following page then shows the best fit values obtained during the fit, with 

the shared parameters at the top and the individual results on the bottom.  

You can use the Export button to export either the parameter list or the plots 

into the TSV format. You can also use the Store Result button to store the 

result in the Result Library. 

Please note: 

The individual result parameters may contain more values than the fitted ones. 

The models can use the fit results to calculate additional values that may e.g. 

be derived from the individual fit results. An example would be that 

automatically the Brug-Formula is applied to calculate a capacitance value 

from a CPE. Which values show up is entirely up to the used model plugin. So 

calculated values are marked with a star (*) in front of their name. 

The parameter values cannot be applied back to the parameter lists of the 

individual spectra, because the Multi-Spectrum-Fit-models are independent of 

any equivalent-circuit-based models. 
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11 EVALUATING THE FIT QUALITY 

After you have performed a fit, it is recommended to evaluate the quality of 

the fit results. For this purpose, RelaxIS offers several tools. 

11.1 PARAMETER ERRORS 

The fitting algorithm returns error values for the free parameters of the fit. 

These are standard errors calculated from the covariance matrix of the fit. You 

would always expect these parameters to lie in a sensible range between about 

0.1% and 30% and you should be skeptical, when you experience larger 

parameter errors than this. 

Especially when a model is unsuitable for the given data, you will find very 

abnormal error values, like in the following example. 

 

BAD errors (meaning that the variance calculated for this parameter is 

negative, which is bad, since the error is the square root of the variance) and 

very large errors, but also errors that are exactly zero indicate very serious 

problems with the results. Usually, the model contains too many free 

parameters in these cases, and you should evaluate whether you can simplify 

the model, or fix one or more parameters in order to get a reasonable fit result. 

11.2 THE FIT INFORMATION WINDOW 

You can check more detailed statistics about the fit by using the Fit 

Information dialog. You can access this dialog using the Fit Information 
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button on the Fit Results tab of the main ribbon bar. The dialog shows 

information about the data set, but also about the covariance and correlation 

matrix. 

Both matrices can point to flawed fitting results. The covariance matrix should 

be a symmetrical matrix, meaning that it should be mirrored around the 

diagonal. RelaxIS checks the matrix and marks elements that do not mirror in 

bright red. You also find that parameters with a BAD error have a negative 

value on their diagonal position. 

The correlation matrix shows how certain parameters behave in regards to 

each other. Values of +1 or -1 indicate that the parameters are perfectly 

coupled – either proportionally or anti-proportionally. That means, that if one 

parameter changes, the other parameter changes in the same way. The 

correlation matrix should be symmetric as well and is marked accordingly if it 

is not. 

Be very cautious if you see any NaN values in the matrices, or find that they 

are not symmetric. This is usually a sign for a very wrong and/or too complex 

model for the data. The following image shows an example of a very bad 

covariance and correlation matrix. You can see that the covariance matrix 

contains negative values on its diagonal and is not completely symmetric. The 

correlation matrix therefore contains NaN values and shows some very large 

correlations between parameters. It is not advisable to trust a fit that shows 

this behavior. 

A permanently visible Fit Information window can be shown by selecting 

Create New Spectrum View→Info View from the Plotting tab. This window 

can be docked in the main window and always shows the fit information of the 

currently selected spectrum. By clicking the Setup button in the menu on the 

left, you can select which statistics are calculated and displayed. 
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11.3 FIT RESIDUAL ANALYSIS 

Another good approach to check the validity of a fit is to examine the fitted 

residuals. If a model correctly describes measured data, the deviations 

between model and fit should be due to normally distributed noise. After you 

have performed the fit, open a new Residual Analysis window using the Create 

New Spectrum View→Residual View button on the Plotting tab. By default, a 

plot of residuals of the real part are show as a function of frequency. Click the 

Setting button in the menu in the left part of the view to select, what is shown. 

At the top, you can select the diagram type, as well as the transfer function 

that should be used for the calculations. If Global Selection is chosen for the 

transfer function, then the currently selected one is used. 

For the Normal diagram type, you can select a plot for the left and right axis 

individually. Select from which derived value the residual should be calculated, 

e.g. from the Real Part or the Magnitude. You can also select if the absolute or 

relative residual should be shown, as well as the chart type.  
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The Histogram and CDF Plots are only calculated for the value selected for the 

left axis. The Histogram shows a simple distribution of the residuals together 

with the curve of the normal distribution. The CDF (cumulative distribution 

function) defines the probability, that according to the given distribution, a 

randomly chosen value X is less than or equal to the function value x 

(https://en.wikipedia.org/wiki/Cumulative_distribution_function). The plot 

can be calculated for both the normal distribution and the residuals and can 

be compared well. 

For the analysis, the histogram or CDF representation is recommended in 

order to check the residuals for normal distribution.  

You would expect the histogram bars to form a bell-shaped curve around zero 

if the errors are normally distributed. You can use the shown line to visually 

inspect if the results match this expectation. If it does not you may want to 

reconsider the validity of the model for the given data. Below you can see a 

good example on the left, and a bad example on the right. 

 

The residual view, by default, automatically performs a Shapiro-Wilk test for 

normal distribution of the data (for 95% probability). The result is shown above 

the axes, where ND says, that the data is normally distribution and not ND 

says that it is not. A more detailed report of the normality tests, can be shown 

by clicking the Normal Distribution Test button in the menu on the left. 

https://en.wikipedia.org/wiki/Cumulative_distribution_function
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11.4 BOOTSTRAP ERROR ESTIMATION 

Beside the method of calculating errors from the covariance matrix it is also 

possible to employ Monte-Carlo methods to get an estimate for the errors of 

each parameter. The Bootstrapping method uses multiple random resamplings 

of the data and fitting of that data to estimate the error of each parameter 

value.  

 

The resampling process takes the original data and creates a new data set by 

randomly choosing data points with replacing from the original data set until 

the new data set is equally large as the original. That data set is then fitted 

with the initial parameters of the original data set. This procedure is repeated 

several hundred times and the results for each parameter are collected. From 

the collections both the average as well as the standard deviation can be 

calculated and taken as a measure for the accuracy of the parameter. 

In RelaxIS you can access this functionality using the Bootstrap Error 

Estimation button on the Fit Results tab of the main ribbon bar. In the dialog, 

simply enter the number of resampling steps you want to perform and click 

the Run button. The process may take several minutes depending on the speed 

of your computer and the number of resamples. 
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Once finished the table on the left shows you the average parameter values 

and errors. The graph on the right allows you to see the distribution of the 

values extracted from the resample. Use the dropdown box on top to select 

the parameter you want to display values for. The values should usually be 

normally distributed around the average value. 

You can plot the data in either a histogram or in a CDF plot, to check for a 

normal distribution. 

11.5 PARAMETER SIGNIFICANCE TEST 

The Parameter Significance Test shows for the current model with current 

parameter values, at which frequencies a parameter influences the impedance 

magnitude. The spectrum data is not taken into account! 

The test calculates the partial derivatives of the transfer functions magnitude 

with regard to the selected parameter for each frequency. The plotted value is 

scaled by the parameter value (absolute significances) or by the parameter 

value and magnitude of the model at the same frequency (relative 

significances). 

In layman’s terms, this means that the values of a model at a given frequency 

changes a lot when the parameter changes, the significance value is large and 

vice versa. 

The tester uses the currently active transfer function for the calculations. 
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11.6 CIRCLE VISUALIZER 

An often-used technique to visualize the fit results of models based on (R)(C) 

or Havriliak-Negami fits is to draw semicircles with the various parameter 

values sorted by time-constant directly into the spectrum. 

RelaxIS offers a Spectrum View to automatically create this display. 

 

 

To display the Spectrum View select Plotting→Create New Spectrum 

View→Circle View from the main menu. The View is kept always up-to-date 

for the current fit values. 

In the top-left of the plot you find a display of the current model where 

individual parts are marked with the colors corresponding to the shapes in the 

plot. 

Supported models depend on the selected transfer function. 

Elements in the Impedance are: 

• Series resistor(s) that are added up and provide a high-frequency offset 

• (R)(C) and/or (R)(P) elements which each provide a semicircle 

• Series C, P or W elements, that provide a line in the low-frequency regime 
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• (RW)(P) and (RW)(C) elements which provide both a semicircle and a line 

in the low-frequency regime 

 

 

In the Complex Capacitance: 

• Parallel (Co), (Cd), (Hv) elements provide a semicircle each 

• Parallel (C) element(s) provide a high-frequency offset 

• A parallel (Sig) element provides a low-frequency line 

The semicircles are calculated from each specific type of element and thus 

provide accurate visualization of 𝛼, 𝛽 factors. 

You can export the graph image or the illustrated model from the right-click 

context menu of the graph. 
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12 RESULT PREVIEW AND EVALUATION 

The Result Preview and Evaluation feature allows you to use the fit results 

from your spectra to relate them with the metadata of these spectra. The 

parameters can be plotted against metadata variables and afterwards be 

further described using various fit models, like the Arrhenius model, or 

parabolas. A typical workflow consists of the following steps: 

 

After you have fitted all spectra using the methods described in section 10, 

you can use the Result Preview window to plot the fit parameters against 

metadata.  

 Please note 

The Result Preview feature replaces the VFT- and Arrhenius-Module from 

RelaxIS 2.x. The models are implemented alongside other models in the 

Further Evaluation part of the Result Preview feature.  

 

The Result Preview window – by default – is located in retracted form on the 

right border of the RelaxIS window.  
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You can open it by moving your mouse onto the flag, and open the window 

permanently by clicking the needle symbol in its title bar. 

The Result Evaluation window is split into a graphing part at the top, and the 

configuration part at the bottom. In the configuration part, you can select the 

data you want to display on the graph. 
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12.1 X-AXIS-VALUE 

This defines against which metadata variable the data is plotted. If a spectrum 

does not have a corresponding value defined, it will not show up in the graph. 

12.2 Y-AXIS-VALUES 

In the tree, you will find an entry for each parameter present in each model. 

By checking the respective checkmarks to the left of each parameter you can 

activate it for being plotted. You can select multiple parameters from each 

model, and they will be plotted together in the graph.  

Alongside each parameter, you find a designation like P1, P2. These are the 

variable names that can be used in the Recalculation formulas introduced 

below. 

You furthermore find entries for the average real and imaginary parts of each 

spectrum. These are intended for use with Single Frequency Measurements. 

Here, each spectrum only contains one or multiple datapoints at the same 

frequency, which can, using the result preview, be plotted against metadata 

and evaluated further using the Result Evaluation feature (see below). 

12.3 SPLIT-BY 

The plotted data can be split into multiple series. This setting defines which 

criterion is used to sort the Y-values into the different groups. You can, for 

example, split by Model, so values for each model get their own series. The 

further evaluations using fit models also respect these splits, and are 

performed for each series individually.  

12.4 RECALCULATION 

The three entry boxes allow you to freely recalculate the values being displayed 

on the X and Y-axis, as well as the errors associated with the parameters. The 

values selected using the steps of section 12.1 and 12.2 are referred to using 

the variable X and Y and the error associated with the Y-value using the 

variable Err. These are all case-sensitive!  
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Additionally, you can access metadata of the associated spectra using the 

abbreviations listed in the help text accessible by clicking the ? button to the 

right of the input boxes. 

Additionally, you can also access certain parameters directly, using their index 

in the respective model. This is done using the variables P1, P2, … and the 

variables E1, E2, … for the respective parameter errors. This is handy for more 

complex recalculations, like employing the BRUGG-formula to calculate the 

capacitance from a CPE. For that you need access to the Q, the alpha and the 

resistance values of a circuit.  

By default, the error propagation is calculated automatically (the error box 

shows <auto>). This may be less accurate then deriving the error propagation 

formula for the Y-value-formula by hand, but should work well in most cases. 

In case you have formulas that you often need, you can save the set of three 

formulas in a library. You can access this library using the dropdown button 

to the right of the three input boxes. Here you can enter saved formulas into 

the boxes by clicking their respective entry in the list. You can also save the 

current formulas in the library under a new name. 

12.5 FURTHER SETTINGS 

There are three additional settings in the dialog. 

• Auto-Update refreshes the graph, whenever data changes, so you always 

have an up-to-date graph without the need to manually click the Update 

button. 

• Show lines connects the data points in the graph with lines, to make it 

easier to see trends in the series. 

• Show errors enables the error bars in the graph. Please note that you 

have to recalculate the errors when you recalculate the Y-values. By 

default, this is done automatically by the <auto> function. 

The setting is also very important for the further evaluation of the 

plotted data. If you have enabled the error bars, the further evaluation 

fit will be weighted by the inverse of these errors. 
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12.6 SELECTION RULES 

Clicking the Selection Rules button on the dialog brings up a dialog similar to 

the Spectra Selection dialog. Here you can enter selection rules that the spectra 

need to match in order to appear in the graph. You can also sort the spectra 

in case the wrong data points are connected by lines. You can find further 

information about selection rules and sort modes in section 6.5. 

12.7 RESULT EVALUATIONS: FITTING THE RESULTS WITH FURTHER MODELS 

Once you have plotted the parameters from the spectra in the way you like 

and possibly recalculated them, you can now use further models to fit the 

currently plotted (or visible) data to another model. Click the Send to 

Evaluator button to open the fitting dialog. 

You can limit the used data to the datapoints that are currently displayed in 

the Result Preview graph (through zooming/panning) by checking the 

respective checkbox. You can also select, if the errors of the result preview 

values should be displayed and used for the fits. 

 

 

1. First select a model on the first page. The models are sorted into 

different groups. You can find the formula the data is being fitted to 

below the model list, as well as a description of the model. Click the 
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Next button to move to the next step. You can create your own models 

with the RelaxIS SDK. Models may include a pre-transformation of the 

X and Y values, that will be applied before the model parameter 

initialization. 

 

2. Now set the initial parameters for the fit. All models have an automatic 

initialization method and should require very little initialization. 

a. If you have split the data, you can select and inspect the initial 

parameters for all series by using the combobox at the top. 

b. You can fix one or more parameters of the model to specific 

values by checking the respective box. 

c. You can test the fit by clicking the test button and observing the 

green result curves. 

3. Click the Perform fit button to execute the fit. 
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4. The last page lets you inspect the fit results for each series and the 

calculated errors. You can plot all results at once by checking the 

“Overlay” box. 

5. Some models calculate additional information. For example, the 

Arrhenius-model calculates the activation energy in eV. Further inferred 

results are listed in the textbox below the parameter table. 

6. The page allows you again to recalculate the data plotted in the graph 

to the right. This enables for example a fit of ( )T  data from a 

conductivity measurement directly to the Arrhenius- or VFT-model, and 

afterwards a plot in the common ( )10log 1000 T . By default, the error 

propagation is calculated automatically by the <auto> formula. 

7. You can export the data into a file or the Windows clipboard. The export 

process is further described in section 14. 
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 Please note 

Please check the formulas used for the models exactly. For example, you 

shouldn’t send ( )10log 1000 T  data to the VFT- or Arrhenius models, since 

these do not use the linearized but the exponential form. Plot ( )T  data in 

the Result Preview and use it directly. This applied also for the 

linearized/logarithmic versions of these models, because the transformation 

is applied automatically during the pre-transformation step. 

For all default, temperature dependent models plot the straight value, e.g. 

𝜎 versus the temperature in the Result Preview. Necessary transformations 

will be done automatically. If your temperatures are given in Celsius, select 

the models named with (Celsius), if your temperatures are given in Kelvin, 

use the models named with (Kelvin). 

 

12.8 RESULT PREVIEW PIVOT STATISTICS 

This feature allows you to calculate descriptive statistics of the currently 

plotted data rows in the Result Preview and calculate overall means and 

standard deviations. It allows you, for example, to find the minima of the 

plotted curves, which can be copied and used for other evaluations, as 

metadata or in formulas. 
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13 PREMADE ANALYSIS TOOLS 

13.1 MOTT-SCHOTTKY ANALYSIS 

Mott-Schottky analysis is primarily used in semi-conductor studies and there 

is used to determine the donor density in the semi-conductor. This is done by 

measuring dc-dependent impedance spectra and determination of the 

capacitance of the space charge region. 

This capacitance is related to the donor density via 

1

𝐶𝑆𝐶
2 =

2

𝑒𝜀𝜀0𝑁
(𝐸 − 𝐸𝐹𝐵 −

𝑘𝐵𝑇

𝑒
) 

Here 𝐶𝑆𝐶 is the capacitance of the space charge region, e is the elementary 

charge, 𝜀 is the semi-conductor’s relative permittivity, 𝜀0 is the vacuum 

permittivity, E is the potential, 𝐸𝐹𝐵 is the flatband-potential, 𝑘𝐵 is the Boltzman 

constant and T is the temperature. 

A plot of 
1

𝐶𝑆𝐶
2 versus the potential should therefore give a straight line with 

slope 
2

𝑒𝜀𝜀0𝑁
, allowing the determination of the donor density via linear fit and 

the flatband-potential can be derived from the linear function’s root. 

In RelaxIS the procedure is implemented via Fit Results → Mott Schottky 

Analysis. It can work with two types of input data: single frequency values or 

fit parameters. Typically, you would use an appropriate model to fit the data 

and get the capacitance from a suitable fit parameter. However, in some cases 

the capacitance is calculated directly from impedance value at a certain 

frequency. Here, two methods or calculating a capacitance are possible: “Cp” 

mode, where the complex capacitance is calculated via 𝐶̂ = 1
𝑖𝜔𝑍̂

⁄  and 𝐶𝑆𝐶 is 

taken as its real part, or “Cs” mode, where the capacitance is taken directly as 

𝐶𝑆𝐶 = − 1
𝜔𝑍′′⁄ . 

To perform a Mott-Schottky analysis, perform the following steps: 

1. Optional: Fit the data to an appropriate model, where one parameter 

designates the value of 𝐶𝑆𝐶. 
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2. Set metadata for all spectra: DC Voltage in Volt and sample Area in m². 

Please use the correct units! 

3. Start the Mott-Schottky analysis from Fit Results → Mott Schottky 

Analysis. 

4. On the first page, select the spectra you wish to include in the analysis. 

Select spectra from the list on the left and click the “Add” buttons to 

add them to the used dataset. You can add spectra from multiple 

models. 

5. Next, select which data should be used. You can combine parameters 

from multiple groups into single datasets. It is also possible to add 

multiple datasets. A Mott-Schottky analysis is performed for each 

dataset. You can choose between fit parameters, Brug calculation from 

a resistor and CPE or a Zarc element, and single frequencies and combine 

the latter freely into datasets. E.g. if spectra’s frequencies vary slightly 

you could combine 1000 Hz, 1001 Hz and 999 Hz into a single dataset.  

6. Set the Temperature in Kelvin (!) and the dielectric constant of the semi-

conductor. If you selected single frequencies as data, you can also select 

the capacitance calculation method at the bottom. 

On the last page the results are displayed. By default, the linear fit is done 

over all datapoints. You can drag the green bars on the graph around to 

limit the X-range over which the linear fit is performed. Click the “Update 

Results” button at the top to update the linear fits. 

On the right you get a list of the calculation results. N is the donor density, 

given in both m-3 and cm^-3, and E_fb is the flatband potential. Below you get 

the raw data used for the plots and calculation.  

 Please note 

Please check the validity of the calculated values carefully. Mistakes in e.g. 

the metadata units may lead to invalid results. When in doubt, calculating 

one or a couple of values by hand is a good way to sanity check the results! 

The “Export” button at the top allows you to export both the analysis results 

as well as the plot data, and you can store the whole analysis in the Result 

library. 
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14 EXPORTING DATA 

Besides exporting the images of the various graphs as explained in section 

8.1.4 you can export the raw data into either a file or into the Windows 

clipboard as tab-delimited text.  This makes it easy to work with it in various 

spreadsheet-based programs. 

Additionally, it is possible to create reports to quickly present data in a 

common format. These are intended to be used for presentations or meetings 

and can be customized with your own designs. 

14.1 THE EXPORT DIALOG 

Every raw data export is performed using the Export Dialog. The dialog is 

usually accessed using the Export Center button on the Main tab of the ribbon 

bar. Depending on the data in question, the Export Dialog is sometimes opened 

not from the Export Center, but from individual dialogs of the different tools. 

In that case, you can find a button labeled Export on the respective tool’s 

dialog. 

 

In the Export Center, choose the type of export you would like to use by 

selecting the respective button. Then click Next to move to the Export Dialog. 

Depending on the type of data, you may be prompted by the Spectra Selection 

dialog first, to choose which spectra to include in the export or it will use the 

currently selected spectra (direct selection mode). 
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The Export dialog shows you all contents that the export can contain. These 

are shown as nodes, where each node represents one or multiple columns.  

 

Typically, you find nodes that can alter multiple columns at once at the top of 

the list, and nodes that can alter single columns below. The multi-column 

nodes usually begin with the word “All”. 

 

 Please note 

The exporters adapt dynamically to the data present in your project. Some 

contents may not be available in some situations, for example when you have 

no model assigned to a spectrum. 

 

For each node, you can designate the Exclude option as well as specify a 

formula. A formula can only be applied, if the column contains numeric data.  

• Exclude causes that content to not show up in the exported data. Multi-

nodes take precedence over individual nodes in this case. 

• The Formula recalculates the data in the column. You can use the 

symbols found in the ? message. Usually you can use metadata of each 
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spectrum here. Individual nodes take precedence over multi-nodes in 

this case! 

The export usually contains a header of two lines of text that describes the 

type of export and the current date and time. Additionally, a title for each 

column is added in the third line of the export. 

Using the Exclude header and Exclude column titles options, you can prevent 

these lines from being included in the output. 

Once you are satisfied with the entered information, you can click the To file 

button to export the data into a text file. By clicking the To clipboard button, 

you can place the generated text in the Windows clipboard, for easy pasting 

into a spreadsheet program of your choice. 

 Please note 

All graphs allow the export of the raw data currently shown in them, as well 

as the export of the graph as an image. Please refer to sections 8.1.4 and 

8.1.5 for further details. 

 

14.2 ADDITIONAL SETTINGS FOR CERTAIN EXPORTERS 

Exporters may require additional settings. In this case, you are prompted with 

an additional dialog after you have clicked the Next button in the starting page 

of the Export Center. Enter the settings of your choice and click OK to move 

to the Export Dialog. If you want to change the settings you set, click the Back 

button on the Export Dialog and restart the procedure. 

Currently the only exporter that requires additional settings is the Spectrum 

Exporter that exports the raw data of the spectra and the fitted curves. 
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The settings are as follows: 

• The transfer functions you would like to include in the export. Multiple 

choices at once are possible. 

• For some transfer functions like the impedance the imaginary part is 

usually negative. In this case you can choose to Invert the imaginary 

part. For others like the admittance this setting will be ignored. 

• You can choose to export the active frequency range only. That way, 

inactive frequencies will not be included in the exported data. 
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15 THE RESULT LIBRARY 

The Result Library is used to save various types of evaluations in order to be 

able to display the exact results of the evaluation at a later time. The stored 

data is designed in a way to be able to display the result without any 

dependencies on plugins like transfer functions or models. Currently you can 

store the following evaluations in the library: 

1. Individual spectra with fit results and plots 

2. Result Preview plots 

3. Result Evaluation results and plots 

4. Combined Data Plots 

5. DRT Evaluations 

6. Kramers-Kronig Evaluations 

7. Model Screening Results 

8. Residual-Analysis results 

9. Multi-Spectrum-Fit results 

10.  Parameter Influence test results 

11.  Bootstrap Error Estimation results 

The results are stored on a per-project-basis in the EIS3 files. This means that 

if you use the Manage Projects feature to create multiple projects in a project 

folder, each project has an individual result library. 

15.1 STORING RESULTS IN THE LIBRARY 

After you have done one of the evaluations mentioned 

above, look for the “Store” button similar to the one 

depicted on the right. To save the results click the Store button and enter a 

title and comment about the result in the dialog. Due to the amount of data 

required to be saved the evaluations may take significant space on your hard 

drive. The dialog where you enter the title and comment also shows the 

expected disk space required to save the data. This amount can range between 

a few kilobytes to several megabytes, e.g. for DRT results with many datapoints 

and spectra. 
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After entering the title and comment click OK to save the result in the library. 

15.2 DISPLAYING SAVED RESULTS 

To open the Result Library, click the Main→Result Library button. The dialog 

shows the currently saved results separated into multiple groups. Select the 

group that contains the result you wish to display from the Dropdown Menu. 

Depending on the type of result you have one or multiple ways to display the 

data. If the data has multiple choices for display, the Display button in the 

ribbon menu of the Result Library will display a menu of choices. Click on one 

of the menu items to display the data. If only a single choice exists, the Display 

button will directly display the result. 

15.3 REUSING SAVED SETTINGS 

Depending on the type of evaluation, the settings used to obtain the result can 

be reused in order to perform the save evaluation again for current data. The 

different result types that offer this feature are: 

Result Type Reusable Setting Explanation 

Result 

Preview 

Set formulas and 

values to Result 

Preview 

The formulas, selected X, split value 

and Y values and options are set to 

the current result preview screen. 

Result 

Evaluation 

Open Result 

Evaluation with raw 

data 

The stored raw data is used as fresh 

data in a new Result Evaluation 

session. This allows fitting the stored 

data with a different model. 

 Combine raw data 

with current result 

preview 

The stored raw data is combined with 

the currently plotted result preview 

plot to produce a combined dataset 

which is then used in a new Result 

Evaluation session. Gives the choice 

if data in the stored limits is used 

only. 
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DRT Use settings in the 

DRT Dialog 

Opens the DRT dialog and changes 

all settings to the stored values 

Kramers-

Kronig-Test 

Use settings in the KK 

dialog 

Opens the Kramers-Kronig-Test for 

the currently active spectrum with 

the stored settings 

Residual 

Analysis 

Open Residual View 

with result settings 

Opens a new Residual View with the 

settings used in the stored result 

Bootstrap 

Error 

Estimation 

Use stored settings 

Bootstrap-dialog 

Opens the Bootstrap-Error-

Estimation for the currently active 

spectrum with the stored settings 

 

15.4 IMPORT AND EXPORT OF STORED RESULTS 

The results are stored in XML format in the database. The XML can be saved in 

a text file from the result library. In order to export a stored result into a 

separate file select it in the result library and then click the Export Result to 

XML File button in the ribbon menu. Select a file name to save the XML to and 

click OK. 

You can also import results into the library by clicking the Import Result from 

XML File button from the ribbon and selecting the respective file. This allows 

exchanging evaluation results between projects or with colleagues. 
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16 REPORTS 

16.1 CREATING REPORTS 

Reports are HTML-based summaries of the fit results and the data saved for 

each spectrum in the project.  

Each report is created using a template. The template is a HTML-document you 

can view in a browser. It can contain text, images, scripts, and so on. 

Additionally, the templates contain certain tags. When you create a report 

from RelaxIS, those tags are replaced by information, to fill the final report 

with life. 

By default, RelaxIS contains some templates for general tasks. They show 

graphs of the data together with metadata and values for the fit parameters. 

To create a report, please perform the following steps: 

1. Select the spectra you would like to include in the report (optional). 

2. Click the Create Report button on the Main tab. 

3. Select a template from the list and click Select template. 

4. Use the Spectra Selection dialog to select the spectra to include in the 

report (or currently selected spectra are used). 

5. Select a filename and location on your hard drive for the report. 

The report is now created and shown in your default web browser. 

The following default templates are included in RelaxIS: 
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Template Description 

RelaxIS General Creates a report with one spectrum per page 

in color. Includes a Nyquist- and Bode-Plot, 

metadata and fit results. 

RelaxIS General Monochrom Creates the same report as “RelaxIS General” 

but uses only grayscale colors to fit better to 

monochrome printers. 

RelaxIS Short Creates a shorter report with two spectra per 

page. Includes a graph, metadata and fit 

results. 

 

16.2 CREATING REPORT TEMPLATES 

Creating the actual template requires some knowledge of the HTML (Hypertext 

Markup Language) and CSS (Cascading Style Sheets) standards. A tutorial on 

these are beyond the scope of this manual. You can find multitude of tutorials 

about creating HTML documents and styling them using CSS on the internet. 

16.2.1 CREATING THE BASIC TEMPLATE 

You can design your own report template. A report template consists of 

multiple files: 

• A description in the form of an .XML document, that contains basic 

information about the template and the additional files it needs. 

• An .HTML document that is the base layout and contains tags that are 

replaced with actual content on report creation. 

• Additional files like images or stylesheets that can be included in the 

report. 

The creation of the HTML-document will be explained below. Once you have 

created the HTML-file, you need to create a template from it. 

The basic template structure can be created using the RelaxIS interface. On the 

report dialog click either the New or the Clone button. The New button creates 
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a blank template, while the Clone button uses the information and files from 

an existing template to get you started. 

 

• The Name is the unique identifier for the report template. It is used to 

refer to it in the RelaxIS Remote feature (section 20). 

• The Description is displayed alongside the name in the template 

selection dialog. 

• The HTML Template can be selected from the hard drive using the Select 

button. The location is arbitrary, since the HTML document will be 

copied to the template location. 

• Additional files are included in the TemplateFiles subfolder when the 

report is created. They can contain anything you would like to include 

in the report. 

 

 Please note 

The TemplateFiles folder will not be unique for every report. This can lead 

to additional template files being overridden by ones of the same name of 

another template! Try to make the filenames unique to the template, for 

example by including the template name in the filename, e.g. use 

“MyTemplate-Logo.png” instead of just “Logo.png”. 
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Click the Save button afterwards to create the template and save it in your 

user folder. 

16.2.2 CREATING THE HTML TEMPLATE 

To create the HTML template, you can use any HTML editor you like, or create 

the HTML code in any text editor. We recommend, for example, the free 

Microsoft Expression Web 4 editor. 

The template is a standard HTML document, that can contain any content you 

like. You can include additional content like images, with the limitation that 

they must be placed in the TemplateFiles subfolder and should be linked 

dynamically in the HTML like 

<img src="TemplateFiles/MyLogo.png" width="152" /> 

 

Content is put into the template by RelaxIS using various additional tags. The 

tags have a certain format: 

{TAG-NAME|OPTION_NAME1=OPTION_VALUE|OPTION_NAME2=OPTION_VALUE|…} 

 

• It always starts with the curved bracket: { 

• Tag-Name is a unique identifier for the specific tag. 

• It is followed by specific options, separated by the | character. 

• Options have a certain name, are followed by an = sign and the value for 

the option. 

• The tag closes with a curved bracket: } 

The options change the behavior of the tag or define what exactly you want to 

show at the location. Most options are optional! If you leave the options out 

the tag will use default or automatic values for these. 

The usable tags are: 

• Spectrum Metadata 

o DATASOURCE 

o METADATA 

o CELLCONSTANT 

• Model 

o CIRCUITSTRING 
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o CIRCUITIMAGE 

• Fit Information 

o PARAMETERTABLE 

o TRANSFERFUNCTION 

o WEIGHTMODE 

o SUMOFSQUARES 

o CHISQUARED 

o R2 

o DOF 

• Plot Images 

o NYQUISTPLOT 

o BODEPLOT 

o BODEPHASEANGLEPLOT 

• Miscellaneous 

o MATH 

o RELAXISVERSION 

You can find the detailed definitions of the tags and their options in the tables 

on the following pages. 

 

Tag Name: DATASOURCE 

Description: 
The value of the Datasource property of the source 
spectrum. 

Options:   
No options!   
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Tag Name: METADATA 

Description: 
A single value from one of the metadata variables. The 
variable to display is defined by the Variable option. 

Options:   

Variable Text 

The name of the metadata variable to 
display. As of version 3.0.1.5 this can 
be one of the following: 

• Temperature 
• DCVoltage 
• ACVoltage 

• Time 

• Harmonic 
• Thickness 
• Area 
• FreeVariable 

• FreeVariable2 

Format Text 

Formats the property value with the 
format string provided. Refer to 
https://msdn.microsoft.com/en-
us/library/dwhawy9k%28v=VS.110%29.aspx. 

Recommended: format=short 

 

Tag Name: CELLCONSTANT 

Description: 
The cell constant of the spectrum calculated as 
Thickness/Area. 

Options:   

Format Text 

Formats the property value with the 
format string provided. Refer to 
https://msdn.microsoft.com/en-
us/library/dwhawy9k%28v=VS.110%29.aspx. 

Recommended: format=short 

 

https://msdn.microsoft.com/en-us/library/dwhawy9k%28v=VS.110%29.aspx
https://msdn.microsoft.com/en-us/library/dwhawy9k%28v=VS.110%29.aspx
https://msdn.microsoft.com/en-us/library/dwhawy9k%28v=VS.110%29.aspx
https://msdn.microsoft.com/en-us/library/dwhawy9k%28v=VS.110%29.aspx
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Tag Name: CIRCUITIMAGE 

Description: 

An image of the model assigned to the spectrum. 
If you append SI to the tag name, the images are saved 
into files instead of being embedded into HTML, e.g. 
CIRCUITIMAGESI. 

Options:   

Scale Numeric 
The scaling of the circuit image, 
similar to the slider in RelaxIS. 
Default: 1 

Shownames True/False 
True shows element names in the 
image, False hides these.  
Default: True 

MaxWidth Numeric/Numeric 

The maximum width and a 
tolerance value, separated by a 
slash (/). If the image is wider 
than Width+Tolerance the image 
will be split to several rows with 
width Width.  
E.g. MaxWidth=150/30 
Default: No max. width 

BackColor Four Hex values 

The background color in the 
format AARRGGBB, designating 
the alpha, red, green and blue 
values in the form of hexadecimal 
numbers from 00-FF. 
E.g. BackColor=FF00FF00 
Default: Transparent 

CSSCLASS Text 

The name of the CSS-class 
associated. The created HTML 
object will contain a class="Text" 
option. 

 

Tag Name: CIRCUITSTRING 

Description: 
The string representation of the model assigned to the 
spectrum 

Options:   
No options!   
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Tag Name: PARAMETERTABLE 

Description: 
The values of the parameters in the form of a table that 
can be designed using a column description format. 

Options:   

CSSCLASS Text 
The name of the CSS-class assigned to 
the table. 

TRCLASS Text 
The name of the CSS-class assigned to 
each table row. 

TDCLASS Text 
The name of the CSS-class assigned to 
each table column. 

THCLASS Text 
The name of the CSS-class assigned to 
the header cells. 

MaxRows Numeric 
The maximum number of rows, after 
which the table will be continued to the 
right of the initial table. 

MaxXRep Numeric 
The maximum number of continuations 
to the right once the MaxRows rows 
were reached. May override MaxRows! 

Header Text 

Defines the text displayed in header 
cells above the table columns. You 
should create a header option for each 
defined column in the order of 
appearance in the table. 

The Column option can be repeated multiple times to define multiple 
columns in the table. 
The general format for a column designation is 
 

Column=Column-Content 

 

Column-Content is an arbitrary string that may contain additional tags in the 
form: 
 

##X[format] 

 

Where X is replaced by one of the following letters designating the value to 

insert at this position and format defines the appearance of the content. 

##F 
[TrueValue; 
FalseValue] 

Shows the Fixed state of the 
parameters. The format defines what is 
displayed when the state is true or 
false.  
E.g. ##F[X;] displays an X when the 
parameter is fixed, or nothing if not. 

##N [] 
Shows the parameter name. No format 
applies (empty brackets). 

##V 
[Format-
String] 

Shows the parameter value with the 
assigned format string. 

##A 
[Format-
String] 

Shows the absolute parameter error 
with the assigned format string. 
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##R 
[Format-
String] 

Shows the relative parameter error with 
the assigned format string 

For example the column definition: 
 

Column=##A[short] (##R[short] %) 

 

Shows the absolute error followed by the relative error followed by a 

percentage sign in brackets, e.g. 123 (0.54 %) 

A complete example of the PARAMETERTABLE tag from the default template 

would be 

 

{PARAMETERTABLE|cssclass=ptable|trclass=rowclass|tdclass=colclas

s|thclass=headerclass|MaxRows=14|MaxXRep=2|column=##F[X;]|column

=##N[]|column=##V[short]|column=##A[short] (##R[short] 

%)|header=Fix?|header=Name|header=Value|header=Error (Relative)} 

 

Tag Name: SUMOFSQUARES 

Description: 
The sum of squared residuals of the spectrum’s current 
fit.  

Options:   

variable Text 

The name of the transfer function to 
calculate the value for. If not assigned, 
the last used transfer function for a fit 
of the spectrum or the current one is 
used. If the value is “current”, the 
current transfer function is always 
used. If invalid, the current transfer 
function is used. 

Format Text 

Formats the ESS value with the format 
string provided. Refer to 
https://msdn.microsoft.com/en-
us/library/dwhawy9k%28v=VS.110%29.aspx. 

Recommended: format=short 

 

https://msdn.microsoft.com/en-us/library/dwhawy9k%28v=VS.110%29.aspx
https://msdn.microsoft.com/en-us/library/dwhawy9k%28v=VS.110%29.aspx
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Tag Name: CHISQUARED 

Description: The 
2  value of the spectrum’s current fit. 

Options:   

variable Text 

The name of the transfer function to 
calculate the value for. If not assigned, 
the last used transfer function for a fit 
of the spectrum or the current one is 
used. If the value is “current”, the 
current transfer function is always 
used. If invalid, the current transfer 
function is used. 

Format Text 

Formats the 
2  value with the format 

string provided. Refer to 
https://msdn.microsoft.com/en-
us/library/dwhawy9k%28v=VS.110%29.aspx. 

Recommended: format=short 

 

Tag Name: DOF 

Description: 

The degrees of freedom, meaning the spectrums data 
point count (times 2, due to real and imaginary parts 
counting as dependent variables individually) minus 
the number of unfixed parameters. 

Options:   
No options!   

 

Tag Name: R2 

Description: 
The nonlinear coefficient of determination (R²) of the 
spectrum’s current fit.  

Options:   

variable Text 

The name of the transfer function to 
calculate the value for. If not assigned, 
the last used transfer function for a fit 
of the spectrum or the current one is 
used. If the value is “current”, the 
current transfer function is always 
used. If invalid, the current transfer 
function is used. 

Format Text 

Formats the R² value with the format 
string provided. Refer to 
https://msdn.microsoft.com/en-
us/library/dwhawy9k%28v=VS.110%29.aspx. 

Recommended: format=short 

 

https://msdn.microsoft.com/en-us/library/dwhawy9k%28v=VS.110%29.aspx
https://msdn.microsoft.com/en-us/library/dwhawy9k%28v=VS.110%29.aspx
https://msdn.microsoft.com/en-us/library/dwhawy9k%28v=VS.110%29.aspx
https://msdn.microsoft.com/en-us/library/dwhawy9k%28v=VS.110%29.aspx
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Tag Name: TRANSFERFUNCTION 

Description: 
The transfer function used for the last fit of the 
spectrum. 

Options:   
No options!   

 

Tag Name: WEIGHTMODE 

Description: 
The weighting mode used for the last fit of the 
spectrum. 

Options:   
No options!   
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Tag Name: 
NYQUISTPLOT 
BODEPLOT 
BODEPHASEANGLEPLOT 

Description: 

Creates an image of one of the three plots. The Nyquist 
Plot plots the imaginary vs. the real part, the Bode Plot 
plots the real- and imaginary parts vs. the frequency 
and the Bode Phase Angle Plot plots the magnitude and 
the phase angle vs. the frequency. 
The options are the same for all plots. Please remember, 
that the options are optional and don’t need to be all 
set! 
If you append SI to the tag name, the images are saved 
into files instead of being embedded into HTML, e.g. 
NYQUISTPLOTSI. 

Options:   

CSSCLASS Text 
The name of the CSS-class associated. 
The created HTML object will contain 
a class="Text" option. 

Width Numeric The width of the rendered image. 

Height Numeric 

The height of the rendered image.  
Tip: Render the image in a high 
resolution and use the CSSCLASS 
together with a CSS-style to downscale 
the image in the HTML output. 

XMin, XMax, 
Y1Min, Y1Max, 
Y2Min, Y2Max 

Numeric 
Defines custom limits for the various 
axes of the graph. If undefined, the 
graph is automatically scaled. 

XTitle, Y1Title, 
Y2Title 

Text 
Defines custom titles for the various 
axes of the graph. If undefined, 
automatic titles will be used. 

XLog, Y1Log,  
Y2Log 

1 or 0 

Sets the X-, Y1- and/or Y2-axes 
logarithmic scaling to yes or no. If not 
supplied, standard values for plots are 
used. 
Allowed values are: 
1 → Logarithmic scaling 
0 → Normal scaling 

ShowGridlines True or False 
Defines if gridlines are shown on the 
rendered graph (True) or not (False) 

Colors 
grayscale or 
light 

If this option is set with the value 
grayscale the graph will be rendered 
without colors. 
If the value light is set, the graph will 
be colored, but will have a white 
background. 
DEPRECATED: It is advised to use the 
Style tag instead. 
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Style Text 

The name of a style template to be 
used for the graph. Style template 
names can be found by opening the 
Graph Style dialog (see section 8.10), 
and finding the name in the “Name” 
column. 

Variable Text 

The name of a transfer function used 
to plot the data. By default, the 
transfer function used for the last fit 
is used, or (if not available) the 
currently selected one. If the value of 
this option is current the currently 
selected transfer function is used in 
any case. Values are case-sensitive! 
Refer to the appendices for default 
values. 

 

Tag Name: RELAXISVERSION 

Description: 
The current version of RelaxIS used to create the report, 
e.g. “3.0.1.4” 

Options:   
No options!   

 

Tag Name: MATH 

Description: 
Allows performing mathematical operation by 
providing a formula. The formula can access metadata 
and fit parameter values/errors of the spectrum. 

Options:   

Format Text 

Formats the result of the calculation 
with the format string provided. Refer 
to https://msdn.microsoft.com/en-
us/library/dwhawy9k%28v=VS.110%29.aspx. 

Recommended: format=short 

Formula Formula (Text) 

The formula to be calculated. Access 
the spectrums metadata using the T, 
DC, AC, FV, A, d symbols and use P1, 
P2, … and E1, E2, … to access 
parameter values and errors. 

 

Some tips and pointers for designing the templates: 

https://msdn.microsoft.com/en-us/library/dwhawy9k%28v=VS.110%29.aspx
https://msdn.microsoft.com/en-us/library/dwhawy9k%28v=VS.110%29.aspx
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• Make extensive use of the CSSCLASS options in combination with CSS 

styles in your HTML document. That way you can set and control the 

appearance and size of the elements to your liking. 

• Render the graphs in a high resolution and scale them down using CSS. 

However, don’t make the resolution too large, or the graph elements may 

become too small once downscaled. 

• For printing the reports, it is a good idea to place all content in a single-

cell table or a <div>. With CSS, you can set the page-break-

after:always; option for this section in order to place each report on 

individual pages. 

• Embed small graphics like company logos as a Base64-String. This can 

allow the report to stay as a single file, without relying on external 

resources. This is at the cost of some disk space, because the graphic is 

stored for each report individually. 
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17 THE CIRCUIT SIMULATOR 

The RelaxIS Circuit Simulator is a tool to easily calculate impedance data for 

any model in a free frequency range. It is mainly used for educational 

purposes. You can, for example, find out how certain parameters affect the 

impedance spectrum.  

The Circuit Simulator can however also be used for evaluation purposes, for 

example to extrapolate a spectrum to non-measured frequencies. 

You can access the Circuit Simulator from RelaxIS using the Circuit Simulator 

button on the Extras tab of the ribbon bar, or you can open it from the Start 

Menu after RelaxIS was installed. 

 

 

 

17.1 BASIC OPERATION 

The Circuit Simulator will calculate data for every circuit you have added to 

the circuit list and that is marked as active. You can add circuits to the list by 

clicking the Add spectrum button and using the Build Model dialog as 

described in section 9.1. You can activate and deactivate circuits by clicking 

the checkbox next to the circuit in the circuit list. 
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The parameter values used for calculating the data for each circuit can be 

changed by selecting the circuit in the list. The parameter values of the 

selected circuit are shown in the table next to the list. You can change the 

values to any value you like. The changes are immediately shown in the Data 

display. 

17.2 SETTINGS 

Use the settings dialog to change relevant simulation parameters. 

17.2.1 FREQUENCY RANGE 

You can calculate data points in a certain range. Select Automatic Frequency 

Range and enter the minimum and maximum frequency, as well as a number 

of datapoints to simulate. You can either enter the values into the textboxes 

or click and drag the bars to quickly change the values. 

You can also enter specific frequencies. Select Specific Frequencies from the 

settings dialog. Afterwards you can enter a list of frequencies into the textbox. 

Separate frequencies with a semicolon.  

17.2.2 NOISE 

You can add normally distributed noise to the data. Enter the standard 

deviation for the distribution into the textbox. Separate noise values are 

applied to the magnitude and phase angle of the immittance after the value is 

converted into the active transfer function. The generation of noise uses a 

fixed random seed, meaning that the sequence of random deviations is always 

identical. You can reshuffle the noise values by clicking the “Shuffle Noise” 

button in the Plotting menu. 

Note: When noise is added in another transfer function than the impedance 

before sending spectra to RelaxIS the resulting amount of noise in RelaxIS may 

be different, because the data is sent as impedance values. 

17.2.3 FURTHER SIMULATION PARAMETERS 

In the further options of the settings dialog you can define which plot type to 

use (Nyquist, Bode, Bode/Phase Angle), which transfer function to calculate 
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and how to plot the data. Additionally, the Plotting ribbon tab allows you to 

freely adjust what is displayed on which axis. 

17.3 ADDING MODEL SERIES 

You can add model series that consist of the same model with varying 

parameter values. The Circuit Simulator contains two ways to create series. 

The two ways are accessed by clicking the Add model series button in the 

main menu. 

17.3.1 MODEL SERIES FROM VALUE LISTS 

Here all parameters except one have the same value in all spectra. One of the 

parameters however can be assigned from a freely defined list. 

 

First select the model to use by clicking the button at the top right. Afterwards 

click the Next button. In the next step, you need to enter the parameter values 

for all parameters. The one you want to vary is irrelevant in this case and is 

selected in the next step. Click the Next button once you set the parameter 

values.  

In the next step, you need to select the parameter to vary. First select the 

parameter from the combobox. Afterwards you can manually enter values for 
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this parameter in the list below. You can delete entered parameters by clicking 

the row’s header and using the Delete key on your keyboard. 

You can also enter a range of values by clicking the Add Range button. Enter 

an upper and lower limit as well as a number of points to calculate. You can 

calculate the values in a linear or in a logarithmic fashion. Click the OK button 

to add the values to the list. 

When you are done click the Finish button. This will add a new circuit for each 

entered parameter value in the circuit list.  

17.3.2 MODEL SERIES FROM PARAMETER RANGES 

In this mode you can define a value range for each parameter in the model and 

a specific method to select a value from the range for a spectrum. 

 

First, select the model you wish to use as described above. Next, select the 

number of spectra you wish to generate. The parameter list will then show all 

parameters of the model with default value ranges. For each parameter you 

can select the range by specifying the start and end of the range. The From 

value does not have to be smaller than the To value. 

In addition to the value you can also select the method to generate distinct 

values: 
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• Fixed: Each spectrum will get the From value. 

• Linear: The parameter value will be linearly interpolated between From 

and To for the first to last generated spectrum. 

• Logarithmic: The parameter value will be logarithmically interpolated 

between From and To for the first to last generated spectrum. 

• Random: The parameter value is selected at random in the range 

between From and To. 

• Log. Random: A random number R is generated between Log10(From) 

and Log10(To) and the parameter value is selected as 10^R. Negative and 

0 for From and To is accepted and will be handled. 

The random number generation uses the shown random seed. That means that 

for the same number of spectra and same random seed (and same number of 

random parameters!) the same spectra will be generated. Change the seed to 

another positive number to generate different random numbers. 

17.4 SPEED MODE 

Drawing the graph can take some time when many data points need to be 

drawn. By default, the speed mode is enabled. When you add more and more 

circuits to the list, at one point you will reach the number of datapoints set in 

the ribbon bar. At this point the Circuit Simulator will disable circuits from the 

bottom of the list up to keep the number of datapoints below the set limit. It 

is however possible to activate the circuits manually again.  

Furthermore, it is possible to reduce the drawing quality of the graph to speed 

up the drawing. This disables for example anti-aliasing. 

17.5 AC SIMULATION 

The Circuit Simulator simulates the AC current for the active circuits based on 

an arbitrary AC voltage. These sine waves are displayed in the AC Voltage 

Simulation dialog on the main screen for a given frequency. You can set the 

shown frequency by dragging the bar below the graph. You can also choose to 

display the AC current on the same axis as the AC voltage to visualize the 
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relative magnitude of both, or use the secondary axis to better follow the phase 

shift between voltage and current. 

Beside this dialog you can also open another simulation dialog by clicking the 

AC Simulator button on the main ribbon bar. Here you can directly enter an 

impedance value as either magnitude and phase angle or as real and imaginary 

part and simulate the current for this impedance value. 

17.6 EXPORTING DATA 

17.6.1 EXPORT 

You can export the simulated data into an easily usable, column separated text 

file. This can be placed in a file on your hard drive or into the Windows 

clipboard. The export is based on the same Export dialog as explained in 

section 14.1. You can choose to export either all spectra or only the currently 

active spectra. 

17.6.2 SEND TO RELAXIS 

If you have a RelaxIS instance with an active project running besides the Circuit 

Simulator, you can directly send the simulated spectra to RelaxIS and work 

with them in RelaxIS like any other measured spectrum. This allows you to 

train yourself in the usage of the various tools, try out functions on well-

defined spectra and so on. The sending uses the RelaxIS WCF Link (please see 

section 21). Check the RelaxIS WCF Link label in the RelaxIS status bar to find 

the currently receiving RelaxIS instance, in case you have opened RelaxIS 

multiple times. Only the one with the green label will receive the spectra. 
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18 THE RELAXIS SETUP DIALOG 

Open the RelaxIS Settings dialog by clicking the Settings dialog on the main 

RelaxIS ribbon bar. The dialog allows you to set various settings and 

investigate which plugins are currently loaded. 

18.1 GENERAL SETTINGS 

In the General Settings box on this page, you can associate RelaxIS with .EIS3 

files if you haven’t done so during the RelaxIS installation. Buttons also allow 

you to open your RelaxIS user folder, or to clear the recent file list. 

Comparison epsilon affects how comparisons between numbers are carried 

out. When floating point numbers are stored, they often contain random 

numbers at the last decimal places. Therefore, numbers are usually not 

compared 1:1 but are considered equal when their difference is smaller than 

the set epsilon value. 

The Auto Saving box offers settings if RelaxIS should automatically create 

backups of your project in regular intervals. These backups are stored in your 

user folder, or in the original project folder if “Save in source directory” is 

activated. Define the time between automatic saves using the input box. 

You can tell RelaxIS to show popup warning about unsaved changes as well as 

other common tips by activating or deactivating the settings in the Popup Tips 

box. 

The Interface box offers options regarding the RelaxIS user interface: 

• “Always use selected spectra for data-related functions”: This enables 

direct selection mode, which does not use the spectrum selection dialog 

as often. 

• Use Hotkeys exclusively…: Hotkeys, as assigned in the Hotkeys tab, are 

used only for the functions assigned there, thus overriding system-wide 

hotkeys like Ctrl-V for pasting. 
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• Enable Dielectrics functions: RelaxIS has some special options for 

working with cell independent transfer functions. Please refer to chapter 

6.9. This setting enabled these functions. 

• Ctrl-V imports data from clipboard in Spectra Explorer: Enable this 

option to override the default behavior of pasting values into the Data 

Explorer grid to importing spectra from the clipboard instead (default 

pre 3.0.15). 

• Default to Cell Selection: If enabled, the Data Explorer uses cell selection 

per default instead of row selection (row selection was default pre 

3.0.15). 

18.2 STARTUP OPTIONS 

You can choose to display the welcome screen on startup and if you want to 

check online for program updates. If you are using an online account, the 

settings “Close Trial Client if last instance” defines, if the Trial Client is 

automatically closed if the last instance of RelaxIS is closed. 

The Plugin Loading box defines settings regarding loading of plugins. You can 

enable or disable loading of XML and or DLL/Exe files and if DLL/Exe files 

should be loaded first (important for duplicate plugin names). 

18.3 DISPLAY OPTIONS 

Graph axis number format allows you to choose whether you want to display 

logarithmic scales as the logarithm of the number, or as the original number. 

Hide empty columns in Spectra Explorer defines, that columns without 

metadata in them are hidden by default. 

Automatically reset main graph zoom option causes the Data Explorer main 

graph to reset it’s zoom level if e.g. another spectrum is selected or a fit is 

performed. If deselected the manual zoom is kept. Right-click the graph and 

select “Zoom out full” if no data is visible in the area. 

Parameter Error display options define the display of parameter errors in the 

Parameter Explorer. You can choose to hide or show errors of fixed or out-of-
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date parameters. You can also define the limit value, over which errors are 

shown in deep red. 

Frequency Extrapolation describe the minimum and maximum displayed 

frequency of the extrapolation display. Please refer to section 8.8. 

Click the button Reset Spectrum View Default Settings to set these settings 

back to their factory defaults. 

Here, you can also define which metadata fields are always displayed, 

regardless of the option to hide empty columns. 

18.4 GRAPH SETTINGS 

The Graph Settings page allows you to change global graph layout settings that 

apply to all graphs in RelaxIS, such as graph titles, or legend placement. Please 

refer to chapter 8.1 for further information about the graph settings. 

18.5 FITTING OPTIONS 

Settings for the fitting algorithms are described in chapter 10. 

18.6 VALUE FORMATS 

On this page, you can define the formats for datasources and error display. 

Please refer to sections 6.2.3 and 10.2.1 for further information. 

18.7 PLUGINS 

The plugins page lists all currently loaded plugins. Plugins are written using 

the RelaxIS SDK and loaded on program start. You can refer to this page to 

find out if your plugins have been successfully loaded and the entered 

information are correct. 

Select a plugin category from the dropdown menu and a plugin from the list. 

Thus, you can find the internal name of the plugin to use for example in the 

RelaxIS Remote job descriptions. 
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18.8 HOTKEYS 

This page allows you to view and edit the hotkey assignments for various 

functions in RelaxIS. Hotkeys in the list with a yellow background are default 

hotkeys and cannot be changed. Green hotkeys are user defined and can be 

changed and deleted. 

To add a new hotkey, use the controls at the lower part of the page. Define the 

keys by using the checkboxes and a key from the dropdown menu. Select the 

action you wish this key to execute from the larger dropdown list and the click 

the Add New button to add this key to the list. 

 Please note 

Depending on the current context of RelaxIS you are navigating in the hotkey 

actions may not execute correctly. This can be due to the currently active 

window, or the location of the input cursors, which causes the key press 

events to be handled by underlying Windows functions instead. 
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19 ADDITIONAL TOOLS 

19.1 THE MODEL STYLER 

In order to create images of equivalent circuits with a more customizable style, 

RelaxIS includes the Model Styler, that can be accessed from the Extras tab of 

the main menu. 

 

First, select a model by clicking the button in the top-left. This will then 

populate the selection box with all the circuit elements in the model, as well 

as a point for general style settings. Select an element in the selection box, in 

order to show the element’s available options in the box below. For general 

settings, you can select the color of the connecting cables between the 

elements as well as their thickness.  

For elements, you can select a tint color, that will highlight the element in the 

circuit with the selected color. Further, you can enter a description of the 

element. This description will be placed below the element with the selected 

font and color. The description may contain style elements such as \-() or 

\+() for sub- or superscript. Please refer to chapter 8.1.3 for details of the 

syntax. 
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The Spread Styles button allows you to quickly assign styles to more than one 

element. The options are: 

 

• Apply this element style to all elements: All styles of the currently 

selected element are copied to all other elements. 

• Apply cable color to all element tints: The selected cable color is applied 

to the element tint color of all elements. 

• Apply element tints to description color: For each element individually 

the description color is set to the elements tint color. 

• Apply description colors to element tints: For each element individually 

the element tint color is set to the element’s description color. 

The File… button allows you to save and load a style in a file. The style of the 

first element is used for storing, so the style can be applied to arbitrary 

models. 

The image can be exported using the Export button. 

19.2 NOTEPAD 

RelaxIS contains a notepad to easily catalog and save your thoughts. You can 

access the notepad through the Notes button on the main ribbon bar in 

RelaxIS. 

Add notes to the list by clicking the Add note button or delete the selected 

note using the Remove note button. Click on a created note to change the title 

and the content of the note on the right. 

19.3 ELECTROCHEMICAL CALCULATOR 

The Electrochemical Calculator can be accessed using the respective button on 

the Extras tab of the main ribbon bar in RelaxIS. 



Additional Tools 

 

171 
 

The calculator offers various often used formulas in electrochemical research. 

The functions are: 

• Calculate the conductivity from a resistance and a cell constant 

• Calculate the capacitance from a constant phase element using the 

Brugg-Formulas 

• Transform a voltage into another reference frame (e.g. from NHE into 

Ag/AgCl-Scale). 

Simply enter the respective values into the fields and read off the results from 

the bottom of each tab. 
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19.4 FITTING BENCHMARK 

The benchmark is accessible through the Fitting Benchmark button on the 

Extras tab of the RelaxIS ribbon bar. On the dialog, you can click the various 

predefined benchmarks to perform them. The results will be shown on the 

respective bars. You can also run all benchmarks after another by clicking the 

Run all button.  

This procedure allows you to make more informed guesses about the impact 

of certain fitting options you can set in the RelaxIS setup dialog. 
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20 RELAXIS REMOTE 

20.1 GENERAL DESCRIPTION 

RelaxIS Remote is best described as running RelaxIS in a server mode. Clients 

can send data to a RelaxIS Remote Server node, let the server do the work and 

then retrieve the results. 

You can use RelaxIS Remote to automate the evaluation of your measurements. 

It is intended to allow the centralization of the evaluation and storage of the 

data on a powerful server while the measurements are executed by simpler 

machines. 

 

 

 

• RelaxIS Remote is the overall server mode inside of RelaxIS. 

• Nodes are combinations of settings. A single RelaxIS instance can host 

multiple Nodes.  
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• Nodes communicate with clients either through an intermediate FTP 

server or through a Windows Communication Foundation (WCF) service. 

• Clients do not need a running RelaxIS instance. Clients can be anything 

that can talk to either an FTP server or a WCF service. 

 Please note 

In order to use RelaxIS Remote to its full potential you will need some 

knowledge about programming. That way it is very adaptable to many 

applications. 

If you want to use RelaxIS Remote for a certain application without having 

the means to adapt it on your own, you can contact rhd instruments. 

 

20.2 JOBS 

Clients communicate with RelaxIS Remote using so called jobs. These jobs are 

objects containing the data and information about what RelaxIS should do with 

it.  

The job definitions are available in the form of the Job type in the RelaxIS SDK 

(see also section 22). The SDK is a .NET DLL that not only contains the 

definitions but also offers methods to easily serialize the job into an .XML 

document and upload it to an FTP server or send it via WCF to an active WCF 

node. 

If you want to create jobs in a different environment than the .NET Framework, 

you can create the appropriate .XML manually instead of serializing the created 

Job object and upload it to the respective FTP server.  

You can find a detailed description of all the relevant properties in the RelaxIS 

SDK help files on the RelaxIS installation medium. The general structure will 

be described in the following paragraphs. 
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Job is the base object you need to create. The options you would like the job 

to perform are stored in the Data, Evaluation, Storage, Feedback and 

Report objects. 

A job can contain multiple spectra. In the Data object, the data is stored either 

as binary data (e.g. from a supported binary data file) in the form of a Base64-

String or as a list of ImpedanceSpectrum_Metadata objects. The Type 

property of the Data object defines which type of data is present. You can 

supply metadata for the spectra or it is read automatically from the binary 

data. In the former case the metadata is supplied as a list of Metadata objects, 

composed of an identifier like Temperature, DCVoltage, etc. and a value. If the 

OverrideAttributesWithFile property of the Job object is set to true, the 

metadata from the individual spectra overwrite those of the same identifier 

defined in the Metadata property of the Job object. 

The Evaluation object defines which kind of evaluation should be performed 

on the spectra. You set the Type property to either perform no evaluation at 
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all (NoEvaluation), perform a single fit (FixedEvaluation) or Auto Fit 

(AutofitQuick or AutofitThorough) with a given model (Circuit), transfer 

function (TransferFunction) and initial parameters (InitialParameters) or 

use a certain (non-interactive) wizard to perform the evaluation 

(WizardEvaluation). ApplyWizardSecondaryParameters defines whether a 

wizard is allowed to change secondary parameters with further evaluation 

results. 

The Storage object defines if and how the spectra are stored on the server. If 

KeepFile is false, the spectra will not be stored. ProjectName is only relevant, 

if the Node is running in Dedicated-Server Mode (see below in section 20.3). In 

that case, you can set the name of the project the spectra will be stored in. If 

the field is left blank, RelaxIS will automatically choose a project in the selected 

database. 

The Report object defines if and which type of report should be created. The 

CreateReport property determines if a report is created at all. If false, all 

other options are ignored and no report is created. A value of false also 

prevents a report being sent via the Feedback object (see below). The 

TemplateName property determines which kind of report is created. It must 

match the name of a local report template. Otherwise the RelaxIS’s general 

template is used. The Outputname property defines the filename of the created 

report. If left blank, a unique, random name will be chosen automatically. If 

defined, a short random string will be appended to avoid overwriting existing 

reports. The SaveLocally property determines if the report is saved 

permanently on the server. It does not prevent the report being sent via the 

Feedback object. The Subfolders property allows you to place the report in 

a certain subfolder of the server’s report storage location. This allows you to 

organize the stored reports on the server. 

The Feedback object defines which kind of feedback should be generated and 

how that feedback is sent back to the job’s sender. The feedback can contain 

the created report as well as the spectra and fit results in the form of a .EIS3 

project folder. These can either be sent back via E-Mail or they can be uploaded 

to an FTP server in either compressed or uncompressed form. As mentioned 
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above, a report can only be sent via the feedback function if the 

Report.CreateReport property is true. The addresses to send feedback to 

are defined in the ContactInformation properties and can be different for 

the report and the results. These objects contain an EMailAddress field as 

well as an FTPServerOptions object to define how to connect to the target 

FTP Server. 

After setting up all the desired options you can send the job to the RelaxIS 

node. For this you can use the UploadToFTPServer method in case of an FTP 

node, or the UploadByWCF method in case of a WCF node. The former takes an 

FTPServerOptions object for login information. You can let RelaxIS SDK 

upload the job as a compressed archive to save traffic at the cost of 

performance. The return of the function is the FTP status code for the 

operation. If successful, the code will be 226. The latter takes an address of 

the server running the RelaxIS Remote node as well as the identifier set up for 

the WCF node (see next section). It returns Null if the job was sent 

successfully, or an exception if not. 

20.3 SETTING UP NODES IN RELAXIS REMOTE 

You can access the RelaxIS Remote feature using the RelaxIS Remote button 

on the Main tab of the ribbon. This will open the Node list that shows all 

currently created RelaxIS Remote nodes. 
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By default, an inactive WCF node is present in the list. You can add WCF or FTP 

nodes by using the respective buttons.  

Nodes can be started or stopped using the respective buttons. Each node has 

a settings dialog used to configure it, as well as a log that shows statistics and 

messages related to the work done by the node. 

 Please note 

In order to use FTP nodes, you need to setup an independent FTP server to 

work with. RelaxIS currently does not support SFTP, but SSL encrypted 

connections are possible.  

RelaxIS does not include a server software. We can recommend the free 

Filezilla Server software. 

 

Many options are shared by both types of nodes, some related to the 

connectivity however are not. 

WCF Settings 

• Server Options 

o Listening Port 

▪ WCF services are accessed using a certain network port.  

o Identifier 

▪ Multiple WCF nodes can be accessed using the same 

network port, using different identifiers. To connect the 

client needs to specify both port and identifier. 

o Find public IP 

▪ This allows you to determine the current public IP of the 

server in order to correctly setup the clients. 

FTP Settings 

• Server Options 

o Server Address 

▪ The address of the FTP server to use.  

o Username, Password 
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▪ The username and password used to log into the server. 

o Use SSL 

▪ Defines if the connection should be SSL encrypted. 

o Passive Mode 

▪ Defines if the connection should be initiated using the FTP 

Passive Mode. 

o Keep Alive 

▪ Keeps the FTP connection alive during requests. This can 

dramatically increase the performance at the cost of a 

slightly more instable connection. 

o Update Interval 

▪ RelaxIS checks on the FTP server for new jobs at regular 

intervals. This is the interval at which checks proceed. 

o Test Server Settings 

▪ Tries to log into the given FTP server and shows the results. 

Allows you to troubleshoot the connection. 

• Operational Options 

o Load already existing jobs from the server on start 

▪ When this option is set, starting the server downloads all 

existing jobs from the server, otherwise these are ignored. 

o Delete jobs from the server after downloading 

▪ When this option is set, the jobs (that are stored as files on 

the server) are deleted after they have been successfully 

downloaded. 

Shared Settings 

• Operation Mode 

o You can choose between two operational modes, that determine 

how the node interacts with RelaxIS. 

▪ Live Mode adds received spectra to the currently loaded 

project in this RelaxIS instance (if storage is defined in the 

job). IMPORTANT: A node in Live Mode can only function 

while a project is active. If you change or close a project 

while a Live Mode Node is active, that node will be stopped 
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and you need to manually restart it, once a project is 

activated. 

▪ Dedicated-Server Mode adds received spectra to a 

preselected database (if storage is defined in the job). A 

node in Dedicated-Server Mode can run regardless of the 

state of the project. 

▪ If you want to see the stored spectra live you can use Live-

Mode. If you want to have more flexibility working with 

RelaxIS while nodes are active, or want to store spectra in 

different project folders, use Dedicated-Server Mode. Please 

remember: You are not constrained in the number of 

RelaxIS instances per computer you can use! 

• Operational Options 

o Output path (Dedicated Server) defines the database (.EIS3) file 

that spectra are being stored in. Click the Select button to choose 

a file. 

o New project after n files advises the node to keep track of the 

number of spectra stored in a single project in the project folder. 

When the set number is reached a new project will be created in 

the database. This makes the projects more manageable. Please 

note that this does not apply when the ProjectName property in 

the Storage option is set to a specific project name. In that case 

the spectra are stored in the specified project instead of an 

automatically chosen one. 

• Evaluation Options 

o Suppress all evaluations advises the node to never perform any 

fits on the received spectra, regardless of what is set in the 

Evaluation object of the jobs. 

o Suppress all reports advises the node to never create any reports, 

regardless of what is set in the Report object of the jobs. 

o Output path (Reports) sets the storage folder for locally stored 

reports. The required subfolders in the chosen folder will be 
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created automatically. Please note: If you don’t set a folder, no 

reports can be stored! 

o Do not store reports locally advises the node to still create 

reports for feedback purposes, but to discard them after sending 

the feedback. No reports will be stored on the server side. 

o Do not store spectra locally advises the node to discard received 

spectra after sending the feedback and possibly creating a local 

report. The spectra will not be stored in the current project or 

dedicated database. 

• Feedback Options 

o Block Feedback: These options allow you to exclude the 

respective feedback tasks from being performed, regardless of 

what is set in the jobs. 

o E-Mail settings: Here you need to enter connection details for the 

E-Mail account you want to use for sending Feedback mails. If no 

valid details are entered, no feedback can be mailed to the clients. 

You can test your settings by sending a text mail, by entering an 

E-Mail address and clicking the respective button. 

 

You can save all settings for a node by clicking the Settings→Save these 

settings button in the toolbar of the Node’s setup dialog. To load settings for 

a node, use the Load settings button. You can delete existing settings by using 

the Delete settings button. 

 



The RelaxIS WCF Link 

 

182 
 

21 THE RELAXIS WCF LINK 

The RelaxIS WCF Link is a feature that allows you to access functions of RelaxIS 

from another program on the same computer. The communication works over 

so called named pipes through a Windows Communication Foundation (WCF). 

The accessible functions are: 

• Adding spectra to RelaxIS 

• Fitting a spectrum with specified models 

• Calculating data for plotting models 

• Querying RelaxIS for available Transfer functions and weighting modes 

• Querying RelaxIS for a list of parameter names of a given model 

• DRT Analysis and Reproduction 

This allows you to implement fitting functionality into other applications that 

support the WCF framework. However, the computer needs a running instance 

of RelaxIS at all times. 

 Please note 

At any given time, only a single instance of RelaxIS can have an active WCF 

link. The link is registered with a specific name in Windows that has to be 

unique. You can check the status of the WCF Link for a given RelaxIS instance 

in the RelaxIS status bar. A green text indicates an active link, while a red 

text indicates an inactive link. You can enable or disable the link by clicking 

on the status label. 

 

21.1 IMPLEMENTING THE WCF LINK INTO YOUR APPLICATION 

Start by referencing the RelaxIS SDK.dll in your .NET application. In it you 

find the RelaxISWCFLink namespace that contains all required classes and 

interfaces. 

To call functions through the WCF service, you need to create a 

RelaxISWCFProxy object. Use the static GetDefaultProxy method of the 

RelaxISWCFProxy class to create a proxy with the correct settings. 
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Using this proxy, you can then call the functions defined in the 

IRelaxISWCFLink interface. 

 Please note 

You can access all information about the individual functions using the SDK 

documentation you find on your installation medium. 
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22 THE RELAXIS SDK AND THE RELAXIS SDK CODE 

EDITOR 

22.1 GENERAL NOTES 

The RelaxIS SDK allows you to easily write plugins to enhance the functionality 

of RelaxIS. The types of plugins you can create are: 

• Circuit Elements 

• Transfer Functions 

• File Formats 

• Wizards 

• Result Evaluation Models 

• Weighting Modes 

• Axis Values 

• Predefined Plots 

• Data Manipulators 

You can write the plugins yourself or use plugins other authors made. 

 Important Security Concern  

Be very, very careful with plugins from sources you do not fully trust. The 

code that is executed when the plugins are loaded in RelaxIS is completely 

up to the author of the plugin and may be used for malicious activities on 

your computer! 

If you can’t be sure what code is contained in a plugin, DO NOT USE IT. 

 

All plugins have a base class that needs to be inherited by your plugin. These 

base classes are defined in the Plugins namespace of the RelaxIS SDK.dll. You 

need to override several methods and properties for each plugin. 

The type definitions can be examined in detail in the RelaxIS SDK help files 

which you can find on the installation medium. 
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We suggest you use an IDE like Microsoft Visual Studio to develop your plugins. 

RelaxIS contains a basic IDE as well, called the RelaxIS SDK Code Editor. Here 

you can write the code and compile it into DLLs that are then loaded in RelaxIS. 

You can open the code editor from RelaxIS by clicking the RelaxIS SDK Code 

Editor button on the Extras tab of the main RelaxIS ribbon bar. 

You can write the plugins either in the C# or the VB.NET language. After 

starting the editor click the New button. Select a template from the list and 

the language you want to use. Also define a name for your plugin. This name 

must be compliant with a .NET class name (e.g. no whitespace or special 

characters.  

Click the OK button to continue. 

This creates all the basic definitions needed for the respective plugin to 

compile successfully. Then you need to fill in the required implementations. 

Most properties are quite straight forward and should be clear from the 

comments in the code. 

 Please note 

You are entirely responsible for the code in the plugins. It is possible that 

unhandled exceptions thrown by the plugin crash RelaxIS. 

It is also possible that plugins cause RelaxIS to fail to start up at all. 

If you experience problems, please do the following: 

• In the Logs subfolder of your user folder you find log files. You can 

refer to these logs to find out which errors occurred. 

• Always keep the .XML files with the original code of your plugins. In 

case of problems delete the .DLL files and recompile the plugin with 

the newest version of the SDK. 

 

After writing the code you need to 

• Compile the plugin using the  

o Check code button to check for errors 
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o Compile (as) button to compile and save the plugin under a given 

name as a DLL in your user folder’s plugin subfolder. 

• Save the plugin code and information using the Save button. This is 

important to be able to recompile the code and update it to the newest 

SDK version. 

22.2 PLUGIN INSTALLATION 

Plugins are loaded from assemblies or SDK XML files in the 

%UserData%\Plugins folder when RelaxIS or the Circuit Simulator starts. 

%UserData% is typically \My Documents\RelaxIS\3.0. You can find the user 

data folder from withing RelaxIS by selection Main->Settings->General 

Options->Open user folder. 

To install a plugin: 

• Close RelaxIS and the Circuit Simulator 

• Copy the plugin file (.xml, .dll or .exe) into the %UserData%\Plugins 

folder 

• Restart RelaxIS or the Circuit Simulator 

• Enable the plugin during the Plugin Validation (see below) 

You can check if the plugin was successfully loaded from within RelaxIS: 

• In the menu, under Main->Show Log, you find messages starting with 

“(@ Plugins): Successfully loaded: …” for each plugin file 

• Under Main->Settings->Plugins you find lists of all loaded plugins. Note: 

You also find premade plugins that are built into RelaxIS here 

• After starting RelaxIS, you find a message in the bottom right of the 

main window, stating how many plugins were loaded in total: 

 

22.3 PLUGIN VALIDATION 

Whenever a plugin file is newly placed into the plugin directory, or when a 

plugin file changes you will be presented with a validation dialog before the 

plugins are loaded, e.g. when starting RelaxIS or the Circuit Simulator. 
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In this list, you have to specifically activate the plugin files that you want 

RelaxIS to load. Set the checkmark next to the plugin file names to activate the 

plugin file. These will be marked by a green checkmark instead of the red 

cross.  

If you have not changed the plugin yourself, or copied one into the folder do 

not activate it. Only activate plugins from trusted sources, as they can execute 

arbitrary code. 

 

 

To change the selection, in RelaxIS open the setup dialog by selecting Main → 

Settings. Click on Plugins, and find the buttons “Select active plugins” or 

“Reset active plugin file list”. The former will show the selection dialog again, 

while the latter completely resets the list of known plugins. This will show the 

selection list on the next program start. 

All changes to the active plugin list will apply after the next program start. 

Already loaded plugins will not be unloaded during the program runtime. 



The RelaxIS SDK and the RelaxIS SDK Code Editor 

 

188 
 

22.4 WRITING PLUGINS 

22.4.1 GENERAL NOTES 

Plugins can be implemented as .NET Framework 4.7.2 assemblies. Please use 

this specific framework. Assemblies targeting i.e. .NET 5 or .NET Core are not 

loaded. As mentioned above, plugins can either be written in the RelaxIS SDK 

Code Editor and saved as XML Files or in a standalone IDE like Visual Studio 

or Visual Studio Code, which offer more advanced development tools. 

Add a reference to the current “RelaxIS SDK.dll” to your project and inherit 

from the base plugin classes. 

All plugins have the following properties: 

Name is the internal name of the plugin that is used to refer to it. This is an 

important property, since some utilities such as RelaxIS Remote may refer to 

certain tools like transfer functions by name. 

Most other string properties are simply for description purposes. 

Description is a general description of what the plugin does. In addition, most 

plugins have additional descriptive properties, as well as the actual 

functionality. 

The AddLogMessage method allows you to add custom messages to the main 

RelaxIS log. 

After the plugin is created and initialized by RelaxIS or the CS3, the 

AfterStartupInitialization method is called once. 

Some plugin types inherit from the RelaxISOnlyPlugin class. These plugins 

have a RelaxISWCFInterface property, that is populated by RelaxIS when the 

plugin is loaded. It can be used to access a RelaxIS WCF Link instance for the 

particular RelaxIS process that the plugin is loaded in. 

There are some more complex properties that need more explanation that 

you’ll find in the following chapters. 
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22.4.2 CIRCUITELEMENT PLUGINS 

These plugins implement a fitting model that can be used as a circuit element 

with a specific Abbreviation in model strings. The model receives parameter 

values and a frequency and returns the impedance as a complex number. 

Implementation notes: 

• The length of the arrays returned for describing names, limits and 

standard values need to match. These define, which parameter input 

RelaxIS allows for the model. 

• For calculations regarding the impedance you can use the tools in the 

libMath namespace. Here you find complex number math and 

impedance conversion tools. 

• The impedance calculation is implemented in the CalculateImpedance 

function. This is the only performance-critical function and is called 

often by the fit functions. 

• Use the GetTightLimits function to calculate parameter limits for a 

particular spectrum. This function is used in the Auto Fit to limit the 

parameter ranges to smaller values for improved performance. 

• The Abbreviation property determines the element code used in model 

strings. It must start with an uppercase letter and be followed only by 

lowercase letters or numbers. 

• The Formula Field is only used for display purposes. 

22.4.3 WIZARD PLUGINS 

Wizard plugins implement fit wizards that select a model for a spectrum. 

Typically, it also determines starting parameters and performs a fit. This is 

followed by an evaluation step that can calculate additional quantities from 

the fit result. Instead of parameter determination the fit wizard can also use 

an Auto Fit. 

Implementation notes: 

• The Wizard first retrieves the options to display on the dialog from the 

GetOptions method. Here you define different kinds of options like 
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numeric inputs or radiobuttons. These are then displayed on the Wizard 

Option pages. For the wizard to be used in RelaxIS Remote without 

interaction, no options must be needed. 

• Afterwards the RetrieveFitSetup function is called. Here you can 

reference the defined options by name from the Dictionary. You return 

a fit setup with initial values and so on that is used to execute the fit. 

• Last the GetFurtherEvaluation function is called with the fit results, 

that you can use to calculate further results like a conductivity from a 

resistance. 

22.4.4 DATAMANIPULATION PLUGINS 

Data provider plugins are the most generic type of plugin. Their function is 

called by the user by clicking a button on the ribbon. The button text and image 

can be defined by the plugin. 

The plugin then receives a list of spectra and can modify each spectrum 

individually, i.e. change the metadata or fit parameters. It can also add new 

spectra to the current project. 

Implementation notes: 

• The overridable AlwaysUseSelectedSpectra property determines if 

the spectra selection dialog is shown (dialog selection mode) or if the 

currently selected spectra are used regardless. 

• The plugin is executed in two steps. First, the PerformSetup method is 

called by RelaxIS with the full list of selected spectra. Afterwards, the 

ManipulateSpectrum function is called with each spectrum 

individually. 

• Changes done on the objects in the PerformSetup method will not be 

written back to the spectra in RelaxIS. Only changes made in the 

individual ManipulateSpectrum function calls are written back. 
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22.4.5 FILEFORMAT PLUGINS 

These plugins allow you to implement additional file formats, so that the 

respective files can be loaded automatically without the need for the Unknown 

File Dialog. 

Implementation notes: 

• When a file is loaded, the IdentifyFile function is called with a Stream 

object. Read data from the stream and determine if your file format can 

handle this data. If so, return true, otherwise false.  

• RelaxIS calls all file formats in a fixed order and the first file format that 

returns true in the IdentifyFile function is tasked with loading the 

data. You can move your format up in the list by overriding the 

SortIndex propery. Set it to negative values to move in front of built-in 

formats. 

• If your IdentifyFile function returned true, the GetData function is 

called next by RelaxIS with a new data stream. Read spectrum data from 

the input and return a list of ImpedanceSpectrum_FileFormat objects. 

• You can make use of the automatic splitting function of RelaxIS by 

settings the ShouldBeAutoSplit property of the ImpedanceSpectrum 

object to true. You can add a Metadata value with name NDataPoints 

and an integer value to tell RelaxIS to split at a specific number of points. 

Otherwise the automatic splitting algorithm is used. 

• You can add metadata lists in the MetadataToSplit dictionary. These 

are split alongside the impedance data and averaged per split spectrum. 

22.4.6 MULTIFITMODEL PLUGINS 

These plugins define a model for the Multi Spectrum Fit feature. Such a model 

fits multiple impedance spectra at the same time and can take metadata values 

of the spectra into account. 

A multi fit model has two types of parameters: a) shared parameters that only 

exist once and are used equally for all spectra and b) individual parameters, 

where one set exists for each spectrum. Hence a model with 2 shared and 3 

individual sets for 10 spectra has a grand total of 2 + 10 * 3 = 32 parameters. 
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Implementation notes: 

• Return a list of metadata names that are required for your model in the 

RequiredMetadata property. The values will be sent to the fit function 

during the actual fit. 

• Set the transfer function that the fit should be performed in in the 

TransferFunction property. 

• Implement the GetIndividualParameters function and return a list of 

individual fit parameters. Only return one set here. The function will be 

called once for each user-selected spectrum, allowing you to i.e. set 

spectrum-individual starting parameters for the individual spectrum. 

• Implement the GetSharedParameters function and return a list of the 

shared fit parameters. The function receives the list of all user-selected 

spectra, allowing you to i.e. automatically setup the parameter start 

parameters. 

• The AfterInitialization function is called by RelaxIS once the user 

has finished the parameter initialization. This allows you to check user 

inputs and possibly canceling the fit if the inputs are invalid, by setting 

the Cancel parameter to true. 

• The GetAdditionalEvaluations function can be implemented to 

calculate further quantities for each fitted spectrum. The function is 

called with the list of fit results, split into shared and individual 

parameters. The individual parameters list only contains the parameters 

for the particular spectrum. Return a dictionary of names and values. 

Implementing the FitFunction method: 

The function implements the actual fitting model. 

The X parameter array contains the frequency as first element and the 

individual spectrum index as the second element and then the metadata values 

requested by the RequiredMetadata property in the same order as defined in 

the property. Cast the second element to an integer to use it as an index. 

The Parameters array contains all fit parameters. IMPORTANT: You need to 

select the correct set of individual parameters for your particular spectrum for 
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the calculation. The GetIndividualParameterIndex helper function can be 

used for this: provide it with the total number of shared and individual 

parameters, the index of the respective individual parameter and the index of 

the spectrum (from the Parameters array). 

For example, with the example above, to select the 3rd individual parameter for 

the 8th spectrum, call 

int index = GetIndividualParameterIndex(2, 3, 2, 7); 

Note that the indizes are 0-based. The formula is simply 

index = nShared + spectrumIndex * nIndividual + iIndividual 

Use the parameters, frequency and metadata to calculate the result in the 

transfer function defined by the TransferFunction property and return it as 

a tuple. 

22.4.7 PLOTPRESET PLUGIN 

This plugin defines a plot preset by returning names of value provider plugins 

for the X, Y1 and Y2 axes of a graph. It also defines, if the axes are logarithmic 

and if the plot is symmetrical. 

Implementation notes: 

• You can find the value type names from the list of plugins in the RelaxIS 

Settings dialog. Open the Settings dialog and select Plugins → Value 

Types and find the Internal Name of the plugin. 

• You can provide two value providers for each axis. If a transfer function 

plugin typically returns a negative imaginary part (like the impedance), 

the ValueName properties are used, otherwise the 

ValueNameNonNegative properties are used. 

22.4.8 TRANSFERFUNCTION PLUGIN 

This type allows you to implement a further transfer function. The plugin 

implements a function to recalculate the impedance into another complex 

value. 
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It is also possible to add a normalization function to recalculate the value into 

a geometry normalized value using an area and thickness value. 

Implementation notes: 

• Implement the ConvertValue function. It receives the frequency, Z’ and 

Z’’ values and should return the converted value as a complex number. 

• Optionally implement the NormalizeValue function to further 

normalized the value. This function receives the already converted value 

and not the impedance. You should also assume SI units, e.g. Area in m² 

and thickness in m. If implemented, override the CanBeNormalized 

property to true as well. 

• Implement the various text properties to provide symbol and units for 

display purposes, including the normalized symbol / unit if 

implemented. 

22.4.9 RESULTEVALUATOR PLUGIN 

This plugin implements a fit model used in the Result Evaluation dialog in 

RelaxIS. It receives X/Y data and implements the respective fit function.  

Implementation notes: 

• Implement the GetParameterNames function to return a list of the 

parameter names that your model uses. 

• Once selected by the user, the StartEvaluator function is called once 

to allow custom setup. 

• RelaxIS then calls the PreTransform functions. These can be overridden 

for data pretreatment (e.g. recalculate X values from °C to K). 

• Afterwards, RelaxIS calls the GetInitialValues and 

GetInitialFixedStates functions, supplying the pretransformed 

data. You can use the data to automatically calculate initial parameters 

for your model. Return value arrays/lists with the same length as the list 

of parameter names. 

• Implement the actual fit function as the XYFunction method. The 

function is called with the X value and the list of parameter values and 

should return the Y value. 
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• You can implement the GetFurtherEvaluations function to use the fit 

results to deduce further evaluations. These are returned as text fields 

in a dictionary. 

22.4.10 WEIGHTMODE PLUGINS 

These plugins implement a weighting mode used in fits. It is supplied with 

values in the transfer function used in the fit and should return an array of 

weighting factors for the real and imaginary parts. 

Implementation notes: 

• Implement the CalculateWeights method to calculate the weights for 

a data set. The function calculates all weights at the same time. The 

input data consists of an array-of-arrays, where data[0] are the 

frequencies, data[1] are the real parts and data[2] are the imaginary 

parts. 

• Calculate a weight for each real and imaginary part and return them as 

an array-of-arrays, where result[0] is the array of real-part-weights and 

result[1] is the array of imaginary-part-weights. 

 

22.5 ADDITIONAL SDK DOCUMENTATION 

All definitions in the RelaxIS SDK can be found in digital help documents that 

are installed together with RelaxIS. You can open this documentation from the 

RelaxIS Code Editor using the Help → RelaxIS SDK button on the main ribbon 

bar. 

You can navigate the help file using the menu on the left and browse all 

function definitions, descriptions or parameters. 

This documentation can also be found on the rhd instruments homepage as 

an online reference in the most up-to-date form. 
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The documentation contains 

detailed definitions and 

comments about the various 

implementable types and 

methods, as outlined in the 

example document on the 

right. 
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23 APPENDICES 

23.1 INTRODUCTION TO ELECTROCHEMICAL IMPEDANCE SPECTROSCOPY 

23.1.1 GENERAL CONCEPTS 

Impedance Spectroscopy (or Dielectric Spectroscopy) is a powerful tool to 

derive dielectric properties of a system in a large frequency range (typically 

more than ten orders of magnitude). This is typically done by applying a small 

sinusoidal AC-voltage with a specific frequency over the sample and 

measuring the current response that is generated. This current response is 

also sinusoidal but can be shifted out of phase to the excitation voltage due to 

a delayed response time. From the amplitude of the AC-voltage, the amplitude 

of the current response and the phase angle the real and imaginary parts of 

the complex impedance, admittance, capacitance, permittivity and so on can 

be calculated which present a picture of different processes happening in the 

system on different timescales. 

The impedance can be understood as the AC resistance. For pure resistive 

processes the corresponding impedance is a real number (imaginary part is 

zero, as well as the phase angle). For purely capacitive or inductive processes 

the real part of the impedance (Z’) is zero and the phase angle is either -90° or 

+90°. Typically processes like mass transport, charge transfer between 

electrode and electrolyte etc. have both frequency dependent real- and 

imaginary parts and can be identified by their behavior. 

Besides the frequency it is possible to vary other parameters. The AC voltage 

can be superimposed onto a DC voltage (or bias) to study potential dependent 

processes like electrochemical reactions or double-layer charging, or the 

amplitude of the AC voltage can be changed which for example can lead to the 

observation of higher harmonics of the AC current response. 

23.1.2 IMPEDANCE DATA 

The data that is stored by the measurement program needs to contain enough 

information to be able to calculate the frequency dependent impedance from 

it. This can be a combination of a number of physical quantities. The easiest 
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combination is frequency, real part of the impedance and imaginary part of 

the impedance. Another often used combination is frequency, magnitude of 

the impedance |Z| and phase angle. The real and imaginary parts of the 

impedance are then given by 

 
sin

cos

Z Z

Z Z





 = 

 = 
 . 

Instead of the impedance programs might use other physical quantities such 

as the complex permittivity, capacitance or admittance. Other quantities like 

the complex permittivity furthermore need geometric information about the 

system (the “cell constant”) to calculate. In order to account for all these 

possibilities RelaxIS uses an import wizard for column based text files that is 

explained in detail in the respective section of this handbook. In short, the 

wizard allows the selection of certain combinations of values from columns of 

the text file and then calculates the complex impedance from these values for 

internal storage and use in the fitting process. 

23.1.3 EQUIVALENT CIRCUITS 

In order to derive physical meaning from the measured impedance spectra the 

common method is to use so called equivalent circuits to model the spectra 

and assign physical meaning to the components of these circuits. An 

equivalent circuit is built from classically known electrical components such 

as resistors, capacitors or coils that are connected by wires in parallel or in 

series. If an AC voltage is applied to such a circuit the current response can be 

measured just like the response of the sample in EIS. By changing the 

parameters (like the capacitance of a capacitor) and connection of the 

components the response of the sample can be replicated. The impedance is 

calculated for a given circuit by simple rules. For electrical components, the 

impedance Ẑ is given by a specific formula. For example, for a resistor and for 

a capacitor the impedance is given by 

 

ˆ

1ˆ

R

C

Z R

Z
i C

=

=
. 
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Here R is the resistance of the resistor, C is the capacitance of the capacitor, 

 is the angular frequency of the AC voltage and i is the imaginary unit. R and 

C are examples of fit parameters that appear in the fits. Also, it is important 

to note that apparently the impedance of a resistor is not a function of the 

frequency – it is constant for all frequencies as can easily be found 

experimentally. In contrast, the impedance of the capacitor is frequency 

dependent. For high frequencies, the impedance is very small while it rises 

towards lower frequencies. This is called high-pass behavior and can be 

explained by the charging/discharging process of the capacitor. At high 

frequencies, the capacitor cannot be charged very much before the polarity 

reverses while at low frequencies the capacitor is charged, preventing current 

flow through the capacitor and thus presenting an impedance. 

If two impedances 1Ẑ and 2Ẑ  are connected in series then 

 1 2
ˆ ˆ ˆ

SeriesZ Z Z= + . 

If the two impedances are connected in parallel then 

 
1 2

1 2

1 2

ˆ ˆ1ˆ
ˆ ˆ1 1

ˆ ˆ

Parallel

Z Z
Z

Z Z

Z Z

= =
++

. 

With these rules and the expressions for the impedance for various electrical 

and electrochemical circuit elements the overall impedance of any given circuit 

can be calculated iteratively for a given frequency. The circuit elements 

implemented in RelaxIS are listed in the Appendices. 

23.2 INTRODUCTION TO NON-LINEAR CURVE FITTING 

23.2.1 GENERAL CONCEPTS 

Given a specific theory or model with certain parameters and a set of data one 

can try to adjust the parameters of the model so that it explains the given data 

in the best way possible. “The best way possible” is usually the case in which 

the sum of squared residuals is minimal. The residual of a data point is the 

difference between the dependent value of the data point and the calculated 
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dependent value of the model. In the practice of fitting equivalent circuits to 

measured impedance spectra the independent variable is the frequency while 

the real and imaginary parts of the impedance are the dependent variables. 

The minimization performed is 

 ( )( ) ( )( ) ( )( ) ( )( )
2 2

ˆ ˆ ˆ ˆmin Re Re Im Im
calculated measured calculated measured

Z Z Z Z


   
 

− + − 
 

 . 

Taking the absolutes of the differences is redundant from a mathematical 

standpoint but has programmatical reasons and is presented for the sake of 

accuracy. RelaxIS offers not only fitting of the impedance of the data but also 

of the complex capacitance and the admittance. While theoretically identical 

results should be obtained it can make a difference depending on what 

information are to be extracted. Reasons are given below. 

In order to perform the non-linear curve fitting several algorithms have been 

developed over the years. Two of the most widely used algorithms are used in 

RelaxIS. The first algorithm is a constrained implementation of the Levenberg-

Marquardt algorithm. This algorithm uses derivatives of the error function to 

descend along the steepest way towards the minimum of the error. It is not a 

simple Steepest Descend algorithm though but it incorporates some 

improvements that make it more robust towards certain common problems 

for fitting algorithms like adjusting the step width dynamically in order to 

force a descend on each iteration. The Levenberg-Marquardt-Algorithm (LMA) 

is very fast and robust in finding a minimum in the error function but is very 

prone to getting stuck in small local minima of the error function. 

For this reason, a second algorithm was implemented into RelaxIS – the Nelder-

Mead-Simplex algorithm (NMSA). This algorithm uses no derivatives but 

simplex transformations to iteratively find better parameters. A simplex can 

be thought of as an n-dimensional geometric form with n+1 edges, with n being 

the number of parameters. So, for a model with two parameters the geometric 

form would be a triangle. Each edge corresponds to a set of parameter values. 

In every step, the sum of squares for each edge are compared and then the 

triangle is transformed by a simple set of rules in order to find a better edge 

point with a lower sum of squares. The NMSA is very robust as well but usually 



Appendices 

 

201 
 

slower than the LMA. It also converges to local minima but it can be 

maneuvered out of these by restarting the algorithm with a fresh starting 

simplex around the local minimum. This makes it very powerful for fitting 

impedance data because, due to the complexity of the fitting models, many 

local minima make it hard to find the best solution. 

During testing it became apparent that both algorithms have strong and weak 

sides. Therefore, the Automatic Fitting method was implemented into RelaxIS. 

Here the two algorithms are used consecutively. First the LMA is used to find 

a local minimum from the given starting parameters. After this the NMSA 

refines this fit. In this mode, no options have to be changed and the fitting 

usually works even from bad starting parameters.  

23.2.2 CALCULATION OF PARAMETER ERRORS 

An important information about the fit is how error prone the fit results are. 

One measure for the quality of the prediction is the overall sum of squared 

residuals (SRR) of the model with the best fit parameters. The higher the SRR 

is, the worse is the prediction. However, this does not make any statement 

about the quality of each individual fit parameter. To find further information 

about these errors one can take the covariance matrix of the system into 

account. The covariance matrix is defined as  

 ( )
1

1T
−

−= A J J H  . 

This means the covariance matrix is approximately the inverse of the Hesse-

matrix as calculated from the Jacobi-Matrix. Since the Hesse-matrix contains 

information about the second derivatives of the error function it means that 

values on the diagonal of the covariance matrix are related to the curvature of 

the error function in regard to changes to this parameter. If the parameter 

value is located in a very steep valley the curvature is high and the parameter 

error is low, because its location is defined nicely by the minimum of the valley. 

If the curvature however is low, the value is not pinned down as strictly and is 

therefore more prone to errors. The actual errors as presented in RelaxIS 

furthermore take into account the degrees of freedom of the dataset in light 

of the used model as well as the SRR. They are therefore given by 
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 𝐸𝑛 = √
𝑆𝑅𝑅

𝑁−𝑛𝑝
∙ 𝑨𝑛,𝑛 

Here N is the number of data points, nP is the number of fit parameters and 

An,n is the nth diagonal value of the covariance matrix. 

Per definition the variance is the squared standard deviation. It therefore 

should be positive at all times. If the model does not describe the data in any 

reliable way (this can mean it is too complex for example) then the diagonal 

values of the calculated covariance matrix can happen to be negative. That 

makes the calculation of the standard error impossible since it would become 

complex due to the square root. A negative covariance furthermore has no 

understandable meaning. If this happens you can notice that RelaxIS calls the 

parameter errors ‘BAD’ in the current file information. 

In this case you should critically evaluate, if every element of the model you 

have used for fitting the data is actually necessary and has a representation in 

your data. 

23.3 PREMADE CIRCUIT ELEMENTS IN RELAXIS 

23.3.1 RESISTOR 

• Circuit abbreviation: R 

• Formula: Ẑ R=   

• Parameters 

o R: The resistance of the resistor. 

Represents a simple, ohmic resistor with a phase angle of 0°. 

23.3.2 CAPACITOR 

• Circuit abbreviation: C 

• Formula: 
1

Ẑ
i C

=   

• Parameters 

o C: The capacitance of the capacitor. 

Represents a simple capacitor with a phase angle of -90°. 
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23.3.3 INDUCTOR 

• Circuit abbreviation: I 

• Formula: Ẑ i L=   

• Parameters 

o L: The inductance of the inductor 

Represents a simple inductor with a phase angle of +90°. 

23.3.4 CONSTANT-PHASE-ELEMENT (CPE) 

• Circuit abbreviation: P 

• Formula: 
( )

1
Ẑ

Q i



=


  

• Parameters 

o Q: The CPE’s admittance value. 

o   : The CPE’s exponential factor. 

The constant phase element describes a non-ideal capacitance. If   is 1 the 

CPE is an ideal capacitor with a phase angle of -90° while for lower values of 

  the phase angle is lowered to -(90° * ). 

23.3.5 INFINITE WARBURG-IMPEDANCE 

• Circuit abbreviation: W 

• Formula: 
0.5 0.5

ˆ W WA A
Z i

 
= −   

• Parameters 

o AW: The Warburg-coefficient. 

 The Infinite Warburg element describes the linear diffusion of an electroactive 

species to an electrode. It can be recognized by a straight line with a slope of 

1 (phase angle = -45°) in the Nyquist plot. The Warburg coefficient is defined 

through the surface concentrations of the oxidized and reduced form of the 

species as well as their diffusion coefficients. 

 
2 2

1 1

2
W

ox ox red red

RT
A

n F A c D c D

 
= + 

 
 
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Here T is the temperature, R is the gas constant, n is the number of transferred 

electrons, F is the Faraday-constant, A is the electrode’s area and c and D are 

the concentrations and diffusion coefficients of the respective species. 

23.3.6 FINITE WARBURG-IMPEDANCE (OPEN) 

• Circuit abbreviation: Wo 

• Formula: 
( )

( )( )ˆ WZ
Z Coth i

i







=    

• Parameters 

o ZW: The Warburg coefficient. 

o  : The time-constant parameter. 

o  : The exponential parameter (usually 0.5) 

The difference between the simple Warburg element and the Warburg-Open 

element is that the Wo-element describes a system in which the maximum 

length of the diffusion is limited, which causes a depletion of the diffusing 

species. This can happen for example in very thin electrolyte layers or inside 

of pores of active electrode materials. The diffusion part is only visible for 

frequencies that are high enough to not allow species to reach the outer limits 

of the diffusion layer in time. For lower frequencies, the behavior changes to 

a capacitive nature.  

23.3.7 FINITE WARBURG-IMPEDANCE (SHORT) 

• Circuit abbreviation: Ws 

• Formula: 
( )

( )( )ˆ WZ
Z Tanh i

i







=    

• Parameters 

o ZW: The Warburg coefficient. 

o  : The time-constant parameter. 

o  : The exponential parameter (usually 0.5) 

This element also describes the diffusion in a limited range from the electrode. 

However, the difference is that the concentration of the diffusing species is 

replenished to a constant level at the outer limit if diffusion layer thickness. 

This is the case for actively stirred solutions or more commonly with rotating 
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disc electrodes. Here the diffusion layer thickness is defined by system 

parameters. For frequencies lower than the time span it takes the species to 

reach the outer limits of the layer the behavior changes to a parallel RC-

element, meaning that the low-frequency limit is a constant Z’ value. 

23.3.8 GERISCHER-ELEMENT 

• Circuit abbreviation: G 

• Formula: 
( )

0.5

1
Ẑ

Y k i
=

 +
  

• Parameters 

o Y: The admittance parameter. 

o k: The rate-constant parameter. 

If the electroactive species is created with a preceding chemical reaction in the 

electrolyte and is then for example reduced at the electrode this element may 

model the impedance behavior of this system. Here k is the rate constant for 

the preceding reaction. 

23.3.9 ZARC: (R)(P) WITH TIME CONSTANT 

• Circuit abbreviation: Zarc 

• Formula: 𝑍̂ =
𝑅

1+(𝑖𝜔𝜏)𝛼 

• Parameters 

o R: The resistance (width) of the semicircle 

o Tau: The time constant of the (R)(P) process 

o Alpha: The CPE alpha parameter 

The Zarc-element is equal to the (R)(P) circuit, but has the big advantage to be 

formulated in terms of the time-constant. This means, that the true 

capacitance of the process, like the double-layer or SEI capacitance can be 

immediately calculated as 𝐶 =
𝜏

𝑅
. For the usual (R)(P), the Brug-Formula must 

be used to get the true capacitance. 

23.3.10 HAVRILIAK-NEGAMI (AND DERIVED) ELEMENT 

• Circuit abbreviation: Hv/Co/Cd 
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• Formula: 

( )( )
ˆ

1

C
C

i





=

+

  

• Parameters 

o C: The capacitance of the related process. 

o  : The time constant of the process. 

o  : The alpha factor of the process. If alpha is fixed to 1 the 

element is called the Cole-Davidson-element. 

o  : The beta factor of the process. If beta is fixed to 1 the element 

is called the Cole-Cole-element. 

o If both alpha and beta are fixed to 1 the element describes the 

Debye-relaxation. 

 

Unlike the other circuit elements these elements describe capacitive relaxation 

processes in the system. The timescale of the process is described by the time 

constant while its capacitive contribution is described by C. Alpha and beta 

describe non-ideal behavior of the process. 

A Hv-element leads to a semicircle in the complex capacitance plane and can 

be used to derive information about capacitive processes on different 

timescales in systems where capacitive behavior is the prevailing 

characteristic. 

The Debye-relaxation can also be described with a series connection of a 

resistor and a capacitor with R C =  . 

For dielectric fits, consider placing a capacitor (C) element and a conductivity 

term (Sig) in parallel to the Hv/Co/Cd elements to describe further processes 

such as an 𝜀∞ contribution. 

23.3.11 DIELECTRIC CONDUCTIVITY TERM 

• Circuit abbreviation: Sig 

• Formula: 𝐶̂(𝜔) =
𝜎

(𝑖𝜔)𝛼 → 𝑍̂(𝜔) =
(𝑖𝜔)𝛼−1

𝜎
 

• Parameters 

o 𝜎: The conductivity associated with this term. 
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o  : A non-ideality factor in the conductivity term. 

The conductivity term is often used in combination with Havriliak-Negami-Fits 

of dielectric systems and is used to describe the (low) conductivity of the 

system. It typically manifests itself in the low-frequency regime of the 

spectrum as a straight line with an angle determined by the 𝛼 parameter. 

 

23.3.12 TRANSMISSION-LINE-MODELS: GENERAL DESCRIPTION 

Transmission-Line-Models are used in electrochemistry to describe porous 

electrode surfaces. The general model is depicted in the following image and 

contains impedances for the outer boundary, ZA, the inner boundary ZB, the 

electrolyte path, X1, the solid path, X2, and the interface, Zeta.  

 

The individual elements don’t have to be simple resistors but can be modeled 

with more complex subcircuits. 

The models are typically written in terms of infinitesimal contributions of the 

individual elements X1, X2 and Zeta, integrated over the length of the pore, L, 

which is important when units of the model elements are discussed. In RelaxIS, 

the L parameter per default is set to 1 and fixed. 

The impedance of this network was given by Bisquert (Phys. Chem. Chem. 

Phys., 2000, 2, 4185-4192): 
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,  

𝜆 = √𝜁/(𝜒1 + 𝜒2), 𝐶𝜆 = cosh (𝐿/𝜆), 𝑆𝜆 = sinh (𝐿/𝜆). 

Different Transmission-Line-Models now typically make assumptions about 

parts of this model in order to simplify the mathematical description. The 

most common assumption is that the electronic conductivity in the solid is 

much larger than the ionic conductivity, and hence X2 is simply assumed to 

be a short circuit.  For the interface typically either blocking or non-blocking 

conditions are assumed, resulting in the description with a simple capacitor 

(or CPE), or with a Zarc-Element, (R)(CPE), respectively. 

Another mathematical description for the TLM does not use infinitesimal 

subcircuits and instead models each distinct component by connecting a 

specified number of loops. This is analogous to creating the model in RelaxIS 

using distinct components and assuming that their parameter values are 

identical. With high number of loops the two approaches converge when 

normalized correctly. However, since the limit should be considered anyways, 

it is more practical to model real samples using the first kind of model that 

already considers 𝑛 → ∞. 
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23.3.13 TRANSMISSION-LINE-MODEL-ELEMENT (OPEN TERMINUS) 

• Circuit abbreviation: Tlmo 

• Formula (e.g. n=3):  

( ) ( )( )
( )

1
1

1
1

1
11 1 1 1

 with 3,  Z R C R C R C R C n C
Q i






−
−

−
−

−
−− − −

      = + + + + + + + = =         

 

• Parameters 

o R: The ionic resistance inside of the pore 

o Q: The admittances of the CPEs describing the double layer in the 

circuit. 

o  : The exponential factors of the CPEs in the circuit. 

o n: The number of loops in the model 

 Please note 

This model is typically not used for fitting. The continuous TLMs - see below 

- are more suitable to describe actual samples. It is implemented primarily 

for educational means. 

 

Assumptions: 

• Blocking conditions 

• Rion >> Relec. 

• Capacitive boundary at inner end of the pore 

• Capacitive behavior of inner boundary the same as for the pore 

The resulting model can be visualized analogous to the complete model above: 
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The model could also be transferred to a normal RelaxIS model: 

 

A typical model curve is shown in the next figure. It can be seen, that the model 

shows capacitive behavior at low frequencies. 

 

 

23.3.14 TRANSMISSION-LINE-MODEL-ELEMENT (SHORT TERMINUS) 

• Circuit abbreviation: Tlms 

• Formula (e.g. n=3): 

  

• Parameters 

o R: The ionic resistance inside of the pore 

o Q: The admittances of the CPEs describing the double layer in the 

circuit. 

o  : The exponential factors of the CPEs in the circuit. 

o n: The number of loops in the model 
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 Please note 

This model should usually not be used for fitting without fixing the n-

Parameter. It is not primarily implemented for fitting purposes but for 

educational means. 

 

Assumptions: 

• Blocking conditions 

• Rion >> Relec. 

• Non-reflecting (absorbing) boundary at inner end of the pore 

The resulting model can be visualized analogous to the complete model above: 

 

This model can also be created as a classical RelaxIS model, e.g. for n=3: 

 

Contrary to the Tlmo, the Tlms shows resistive behavior at low frequencies 

due to the short circuited inner boundary: 
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23.3.15 BISQUERT TRANSMISSION LINE (OPEN) 

• Circuit abbreviation: Bo 

• Formula: 

 

• Parameters 

o Rion: The ionic conductivity contribution 

o Rct: The charge transfer resistance at the interface 

o Q: The CPE Q parameter of the interfacial capacitance 

o alpha: The   parameter of the interfacial capacitance 

o L: The length of the pore (default: fixed) 

• Parameter Units 

o [Rion] = Ohm/m 

o [Rct] = Ohm*m 

o [Q] = S*s^a/m 

o [alpha] = 1 

o [L] = m 

The Bisquert TLMs describe systems with a non-blocking interface, which 

introduces an additional charge transfer resistor. This is of interest when 
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describing e.g. dye-sensitized solar cells. The “open” model assumes a 

reflecting (open) inner boundary. Hence, the model can be depicted as: 

. 

The plot of the model shows a Warburg-like behavior at high frequencies, and 

a semicircle towards a low-frequency limiting value. The function is similar, 

but not equal to the Warburg Short element discussed above. 

 

Example spectrum of the Bisquert-Open transmission line. 
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23.3.16 BISQUERT TRANSMISSION LINE (SHORT) 

• Circuit abbreviation: Bs 

• Formula: 

 

• Parameters 

o Rion: The ionic conductivity contribution 

o Rct: The charge transfer resistance at the interface 

o Q: The CPE Q parameter of the interfacial capacitance 

o alpha: The   parameter of the interfacial capacitance 

o L: The length of the pore (default: fixed) 

• Parameter Units 

o [Rion] = Ohm/m 

o [Rct] = Ohm*m 

o [Q] = S*s^a/m 

o [alpha] = 1 

o [L] = m 

The Bisquert TLMs describe systems with a non-blocking interface, which 

introduces an additional charge transfer resistor. This is of interest when 

describing e.g. dye-sensitized solar cells. The “short” model assumes an 

absorbing (short) inner boundary. Hence, the model can be depicted as: 

. 

The plot of the model shows a Warburg-like behavior at high frequencies, and 

a semicircle towards a low-frequency limiting value. Compared with the 
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Bisquert Open model it lacks the distinct “bump” at intermediate frequencies. 

The function is similar, but not equal to the Warburg Short element discussed 

above. 

 

23.3.17 SIMPLIFIED, BLOCKING TRANSMISSION LINE MODEL (OPEN) 

• Circuit abbreviation: Tlmqo 

• Formula:  

 

• Parameters:  

o Rion: The ionic conductivity contribution 

o Q: The CPE Q parameter of the interfacial capacitance 

o alpha: The   parameter of the interfacial capacitance 

o L: The length of the pore (default: fixed) 

• Parameter Units 

o [Rion] = Ohm/m 

o [Q] = S*s^a/m 

o [alpha] = 1 

o [L] = m 
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This TLM is the blocking analogue to the Bisquert (Open) model. The charge 

transfer resistance is assumed to be infinite and is thus removed from the 

model. The inner boundary is modeled as an open circuit: 

 

The plot therefore does not go to a limiting value and instead shows capacitive 

behavior at low frequencies. The plot and model are identical to the Warburg 

Open model but assumes different parameter values due to the different 

mathematical and theoretical formulation.  
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23.3.18 SIMPLIFIED, BLOCKING TRANSMISSION LINE MODEL (SHORT) 

• Circuit abbreviation: Tlmqo 

• Formula:  

 

• Parameters:  

o Rion: The ionic conductivity contribution 

o Q: The CPE Q parameter of the interfacial capacitance 

o alpha: The   parameter of the interfacial capacitance 

o L: The length of the pore (default: fixed) 

• Parameter Units 

o [Rion] = Ohm/m 

o [Q] = S*s^a/m 

o [alpha] = 1 

o [L] = m 

 

This TLMs is the blocking analogue to the Bisquert (Short) model. The charge 

transfer resistance is assumed to be infinite and is thus removed from the 

model. The inner boundary is modeled as absorbing (short): 

 

Due to the inner boundary, the plot tends towards a limiting value. The plot 

and model are identical to the Warburg Short model but assumes different 

parameter values due to the different mathematical and theoretical 

formulation.   
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23.3.19 EXTENDED, BLOCKING TRANSMISSION LINE MODEL (OPEN) 

• Circuit abbreviation: Tlmeb 

• Formula:  

 

𝜁 is the impedance of the CPE. This is a derivative of Bisquerts general 

expression shown above, optimized for numeric calculation. 

• Parameters:  

o Rion: The ionic conductivity contribution 

o Relec.: The electronic conductivity contribution 

o Q: The CPE Q parameter of the interfacial capacitance 

o alpha: The   parameter of the interfacial capacitance 

o L: The length of the pore (default: fixed) 

• Parameter Units 

o [Rion] = Ohm/m 

o [Q] = S*s^a/m 

o [alpha] = 1 

o [Relec] = Ohm/m 

o [L] = m 

This TLM is analogous to the simplified blocking TLM but includes the 

contribution from a limited conductivity in the solid by introducing additional 

resistance in the second path.  
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The plot is equally similar but does not start at the origin point and instead 

goes toward 𝑅∞ =
1

𝑅𝑖𝑜𝑛
−1 +𝑅𝑒𝑙𝑒𝑐.

−1 . 

 

23.3.20 EXTENDED, NON-BLOCKING TRANSMISSION LINE MODEL (OPEN) 

• Circuit abbreviation: Tlmenb 

• Formula:  

 

𝜁 is the impedance of a Zarc element, (R)(P). This is a derivative of 

Bisquerts general expression shown above, optimized for numeric 

calculation. 

• Parameters:  

o Rion: The ionic conductivity contribution 

o Relec.: The electronic conductivity contribution 

o Rct: The charge-transfer resistance of the interface 

o Q: The CPE Q parameter of the interfacial capacitance 

o alpha: The   parameter of the interfacial capacitance 

o L: The length of the pore (default: fixed) 

• Parameter Units 

o [Rion] = Ohm/m 

o [Rct] = Ohm*m 

o [Q] = S*s^a/m 
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o [alpha] = 1 

o [Relec] = Ohm/m 

o [L] = m 

This TLM is analogous to the simplified non-blocking TLM but includes the 

contribution from a limited conductivity in the solid by introducing additional 

resistance in the second path.  

 

The plot is equally similar but does not start at the origin point and instead 

goes toward 𝑅∞ =
1

𝑅𝑖𝑜𝑛
−1 +𝑅𝑒𝑙𝑒𝑐.

−1 . 
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23.3.21 USER-DEFINED-TRANSMISSION-LINE-MODEL 

• Circuit abbreviation: Tlmx[ZA,X1,Zeta,X2,ZB] 

• Formula: see Bisquerts full formula above 

• Parameters: 

o Variable, depending on defined subcircuits 

• Parameter Units: 

o Need to be inferred on an individual basis 

The Tlmx allows you to freely define a TLM by defining the subcircuits of the 

model. The subcircuits are placed in a specific order inside of the squared 

brackets. The impedances are then calculated and combined to the full TLM 

description by RelaxIS. 

With the exception of Tlmo and Tlms, the piecewise TLMs, all other pre-defined 

TLMs can be replicated by the Tlmx. 

For more information regarding the usage of the Tlmx, please refer to 9.1.2. 

23.4 NAMES OF THE IMPLEMENTED PLUGINS 

The internal names of the plugins are the ones you need when you refer to 

them in the RelaxIS Remote or RelaxIS WCF features. Please use the names in 

the Name columns in the following tables. 

Please note that the names sometimes contain single spaces! 

23.4.1 TRANSFER FUNCTIONS 

Plugin Definition Name Normalizes to 

Impedance  Impedance 
Specific 

impedance 

Admittance 
1ˆ
ˆ

Y
Z

=   Admittance 
Complex 

Conductivity 

Complex 

Capacitance 

1ˆ
ˆ

C
i Z

=   
Complex 

Capacitance 

Complex 

Permittivity 

Elastance 
1ˆ
ˆ

E
C

=   Elastance Modulus 
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23.4.2 WEIGHTING MODES 

Plugin Name 

No weighting No Weighting 

Proportional weighting Proportional Weighting 

Log102(Frequency) Logarithmic Weighting 

Favor low frequencies Low Frequency Weighting 

Favor high frequencies High Frequency Weighting 

Low freq. modulus Low Frequency Modulus Weighting 

High freq. modulus High Frequency Modulus Weighting 

23.4.3 AXIS VALUES 

Plugin Name 

Frequency Frequency 

Angular Frequency Angular frequency 

Real Part Real part 

Imaginary Part Imaginary part 

Negative Imag. Part Negative imaginary part 

Magnitude Magnitude 

Phase Angle Phase angle 

Phase Angle (of Impedance) Phase angle Impedance 

Tan(Delta) Tan(Delta) 

Tan(Delta) dielectric Tan(Delta) dielectric 

No Value Empty  

(It is recommended to use the  

RelaxISPlugin_AxisValue.EmptyValueName 

constant) 

23.4.4 WIZARDS 

Plugin Name 

Battery Wizard Battery Non-Interactive 

Battery Wizard (empiric) Battery, Empiric Non-Interactive 

Conductivity Wizard Conductivity Interactive 
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Conductivity Wizard 

(non-interactive) 

Conductivity Non-Interactive 

23.5 FORMULA SYMBOLS OF THE BUILT-IN METADATA FIELDS 

In most formulas the metadata of effected spectra can be accessed using 

certain symbols. Please use the symbols given in the table below. 

Please note, that all symbols are case-sensitive! 

Field  Symbol Report Tag Name 

Temperature T Temperature 

Time TM DCVoltage 

DC Voltage DC ACVoltage 

AC Voltage AC Time 

Current J Current 

Concentration C Concentration 

Harmonic H Harmonic 

Area A Thickness 

Thickness d Area 

Free Variable FV FreeVariable 

Free Variable 2 FV2 FreeVariable2 

23.6 AVAILABLE MATHEMATICAL FUNCTIONS 

You can use various functions whenever you are entering formulas, for 

example for recalculating the values of the Result Preview dialog. 

The functions always have the format: Keyword(Value), and are NOT case-

sensitive. Some functions can have multiple keywords. If you miss a function, 

please contact rhd instruments. 

Function  Keyword 

Exponential exp() 

Sinus sin() 

Kosinus cos() 
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Tangens tan() 

Base-10 Logarithm log() lg() log10() 

Natural Logarithm ln() logn() 

Square-Root sqrt() 

Absolute value abs() 

 

23.7 HOTKEYS 

 

Further hotkeys can be added in the Setup dialog. The hotkeys above cannot 

be changed, but you can add new hotkeys for various functions to your liking. 
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24 CONTACT AND TECHNICAL SUPPORT 

 

For any questions with regard to our products, orders, or request for repairs 

please contact rhd instruments: 

 

info@rhd-instruments.de 

Phone: +49 6151 8707187 

Fax:  +49 6151 8707189 

Web:  http://www.rhd-instruments.com 

 

rhd instruments GmbH & Co. KG 

Otto-Hesse-Straße 19 / T3 

64293 Darmstadt 

Germany 

 

Sitz der Gesellschaft: Darmstadt 

Amtsgericht Darmstadt HRA 85824 

WEEE-Reg.-Nr. DE 54715752 

 

Haftende Gesellschafterin: rhd instruments Verwaltungs GmbH 

(Sitz: Darmstadt, Amtsgericht Darmstadt HRB 96374) 

 

Geschäftsführer: Dr. Benedikt Huber und Dr. Marcel Drüschler 

 

http://www.rhd-instruments.com/

